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How to Use this Book 1
How to Use this Book

1) This book is split up into eight main sections
covering all the Functional Skills criteria for ICT.

2) Each section contains the main content with
screen shots and examples to explain how
to use the features of certain programs.

3) There will also be Practice Tasks to complete
— these allow you to practise using the
features explained in the main content.

4) You can just dip in and out of this book. But it is
more sensible to work through each section
in order — this will help you build up your skills. e

5) At the end of the book there is also a Test-style Tasks section.

6) This provides separate, exam-like practice for Entry Level 3, Level 1 and Level 2.

1) For most of the Practice Tasks, and for the Test-style Tasks section, you’ll need access
to task files and answer files.

2) These task files and answer files can be downloaded from our website:
www.cgpbooks.co.uk/fsict

3) When you click on a link to a file you'll be asked what you want to do with it
— you need to save it on your computer where you will be able to find it again.
For example, choose ‘Save as’, select where you'd like to save it, then press ‘Save’.

4) The file will be saved as a compressed (zipped) file — explained more on page 20.

5) Tutors can download this material for their students and store it in a suitable place.

1) This book was written using Microsoft® Windows®7 and Office® 2010.

2) If you are using a different version of Windows® or Office® then you can still use this
book, but the features may look different.

3) Also, the task files and answer files may look or behave slightly differently.

4) The features and files will be quite different if you are using non-Microsoft software.

How to Use this Book



Levels and Exam Boards

1) This book is for anyone studying Entry Level 3, Level 1 or Level 2 Functional |
Skills ICT with any exam board. |

2) If you are unsure which level or exam board you are studying, ask your tutor.

3) Blue level markers have been used to show what level the
main content and Practice Tasks are suitable for (see below).

4) These level markers are for guidance only — you should check with your tutor
which parts of this book are suitable for your level and exam board.

1) You can tell which level each box is for by looking at the blue level markers to the
right of the green header boxes:

ey When all three markers are there, that box is
for Entry Level 3, Level 1 and Level 2.

11 When just the L1 and L2 markers are there,
i e B that box is for Level 1 and Level 2 only.

When just the L2 box is there, that box is for Level 2 only.

For example, the box below is for Entry level 3, Level 1 and Level 2:

(SR FOETES TRl

1) Anyone can put anything on the internet.

2) So you need to use websites you can trust.

3 3) Here are some things to look for:

2) The same three blue markers are used to show the levels for each Practice Task toc
But here they’re found just above each task.
For example, the task below is for Entry Level 3, Level 1 and Level 2 students:

1) Open the file called ‘Gino’.

a) Write your name in cell A1.

b) Go to cell C5 and change £2.75 to £2.00.

How to Use this Book
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Section One — The Basics

Getting Started

Basic Computer Parts

P S e |

1) Computers don’t always look the same.

2) But most desktop personal computers (PCs) will look similar to this:

Computer unit
or case — F
contains all the pieces
that make the computer
work. You put disks
in here and also plug
other things in here.

Meonitor (screen) —
what you're working
on is displayed on it.

Printer — used to make
= paper copies of files on
your computer (like

Keyboard — has keys letters or spreadsheets).

with letters, numbers
and symbols, which
you press to enter

information (see p. 5).

Mouse — used to
move a pointer around
“=sthe screen and click on

things (see p. 5).

3) Don’t worry about breaking a computer just by using it — that’s pretty difficult to do.

1) Laptops (or notebooks) — , : _
These are small computers that can be folded up. This means they are
easy to carry around and take up less space than desktop computers.

2) Netbooks —
These are like laptops but smaller and a bit less powerful.

3) Tablets —
These are hand-held computers that come in different sizes but are smaller
than laptops. They often have touchscreens instead of a keyboard. Some are
specially made to read electronic versions of books, these are called e-readers.

4) Smartphones —
These are mobile phones that work like computers. You can install programs on
them called apps which can do all sorts of things. They often have a touchscreen.

5) Other machines —
Lots of other things you use everyday have computers inside them too.
For example, microwaves, washing machines, cars, cash machines...

Section One — The Basics



| Computers are Made of Hardware and Software

1) Hardware is all the physical parts of a computer — not just the obvious parts like
the monitor, keyboard and printer, but also all the bits inside that make it work.

2) Software is all the programs in a com'puter that make it do different things —
they contain instructions that tell the computer what to do. Computers use two kind
of software — an operating system and application software (see p. 9 for more).

Startmg Up and Shuttmg Down T

1) To start, push the power button on the computer unit. Power buttons will
often have this (b

symbol on them:

2) You need to press the power button on the monitor too.

3) Sometimes you'll need to log on before you can
use the computer (see below).

4) To shut down a computer, find the ‘Start’ button first.
It's often in the bottom left of the screen. If you're el
using Microsoft® Windows® 7 it will look like this. ==

5) Press the ‘Start’ button, then click ‘Shut down’. ==

NN LTI R e T TR TR

6) Always switch off a computer properly.
Just switching off using the power button or
the plug might mean that you lose or damage data.

|
g
i
i
5
i
§

1) Some computers are used by lots of different people.

2) Each user will need to log on when they want to use it.

3) When you start up the computer, instructions will appear telling you how to log on.
4) You'll usually need to press ‘Ctrl’, ‘Alt’ and ‘Delete’ at the same time.

5) This will bring up a window where you can enter your username and
password, then press ‘Return’ or the arrow button on the log on window.

6) Usernames and passwords need to be spelt correctly and include any capitals,
so type them in carefully. (See p. 7 for more on passwords.)

7) To log off, click the ‘Start’ button and click the
arrow button next to the ‘Shut down’ button.
Then select ‘Log off’ from the menu that pops up.

8) Log off leaves the computer on, but someone else
can log on. Use ‘'Shut down’ to switch off the computer properly (see above)

Section One — The Basics




1) Use the keyboard to enter text into a computer:

Backspace («)  Delete Print screen (PrtScn)

The number
== pad has
Caps Lock numbers
and maths
Shift symbols,
(4)) like a
calculator.
Control =5
(Ctrl)
Space bar Return or Enter The arrow keys let you
(«) move the cursor around.

2) Press ‘Enter’ or ‘Return’ to move to a new line. !
3) Use the ‘Space bar’ to make spaces between words and after commas and full stops.

4) Hold down ‘Shift’ whilst typing to get capital letters.
5) Press ‘Caps Lock’ once to write everything in capitals. Press it again to turn it off.
6) If a key has two symbols on it, hold ‘Shift’ and press the key to get the top symbol.

7) Press ‘Delete’ or ‘Backspace’ to remove characters. ‘Backspace’ deletes the
character to the left of the cursor, ‘Delete’ removes the one to the right of the cursor. |

8) Press ‘Print Screen’ to capture an image of what's on the screen.

1) The pointer or cursor is the symbol which you use to control a computer.
2) The pointer is seen on the screen, often as an arrow or a line like this:]:
3) As you move the mouse, the pointer will move too. ;

4) The mouse has buttons which you can click to do things on the screen.

Left button =

5) You will mostly use the left mouse button. In this book, if it says to ‘click’ something
it means move your pointer onto it and click the left mouse button once.

6) If you need to use your right mouse button it will say ‘right-click’.

7) A‘double-click’ means pressing the left button twice very quickly.

Section One — The Basics
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1) An input device is any hardware used to enter data into a computer. For ex:
* Akeyboard and mouse.
* Scanners, digital cameras and web cameras.
 Microphones, remote controls and interactive whiteboards.
* Achip and pin device used at a till. )

2) An output device is any hardware that uses the data flrom a computer. Forexa
* Printers, monitors, speakers or headphones.
* Projectors for presentations.

3) Some devices are for input and output. For example:

« Atouchscreen on a mobile phone or self-service checkout.

* Aheadset which includes a microphone and a speaker.

L1
1) a) Start up your computer. Log on if required.

b) Shut down your computer properly.

3) Which button would you press on the keyboard if you wanted
to capture an image of what was on the computer screen?

Section One — The Basics
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_Security — Passwords and Viruses |

1) Passwords stop other people from logging on to your computer (see page 4).

2) Passwords can also be used to stop people from reading your
private information or messing around with your work.

3) For example, documents (files) and USB memory sticks can be
password-protected, you can use a password to lock your mobile phone,
and even your bank card PIN is a type of password.

4) Passwords are only good if you choose them carefully though.

5) Don’t have a password that's easy for other people to guess. This means you
should avoid things like your name, date of birth, pet's name, favourite team...

6) A good password contains a mixture of letters and numbers, maybe some capital
letters, and even symbols if allowed (for example, ! or *).

7) If you need to write down your password to remember it, keep it in a safe place.

8) Remember to type passwords in carefully when they're needed.

When you try to open a password-protected document (or file) a window
or box will usually appear and ask you to enter the password. For example:

Enter the password here. g i

=== Press 'OK' or 'Enter’
when you've typed in
the password.

Enter password to open file

Remember, if your 3, CPassword.docx

password contains

i....l..l.l.

capitals you need to use [ o
them here too. 9]
How to protect files
The characters will show as dots or stars when you with a password is

type them so that nobody can see what you type. covered on page 18.

1) A computer virus is a harmful program made to infect computers.

2) They can make things stop working, make the computer
run slower or steal information from the computer.

3) Viruses can enter a computer through files, emails and the internet.

Section One — The Bas



1) The best way to reduce the risk of viruses is to use antivirus software.
2) This can stop viruses entering and get rid of viruses that are on a computer.

3) It's important to use up-to-date antivirus software and run a
scan frequently to make sure your computer is kept safe.
Email attachments are
files that are sent with
emails see page 35.

4) You should also be careful not to open any files or
email attachments, or download anything from
the internet unless you know that they're safe.

5) You can alsoruna virus scan on files before you open them.
Then you can remove them from your computer if they're infected.

1) Jane works at CGP Books. She's an Aries and her date of birth is 18th April 1980.
Her pet dog is called Snuffles and she drives a red Mini.
Which of the passwords shown below would be a good password? Tick one box.

[] JaneEllingham
[] Enaj2675Boo

] CGPBooks123
L]

JaneApril

See page 14 for
on opening file:

2) Open the password protected file called ‘Fruit’. Use the password tasty.
Write the word that's written in the document below.

3) Describe one way you can protect your computer from viruses.

Section One — The Basics



1) Software means the programs that a computer runs.

2) They are sets of instructions that make all the bits of hardware work together.

3) Computers use two different kinds of software

— an operating system (OS) and application software. In this book. u
. When

4) An OS is the software that controls the whole computer system. ::isay software of
Some examples are Windows®, UNIX®, Mac DS XK. appﬁf:t!m we mean
The OS runs the application software... 'on software,

5) The application software are the programs like word processors,
spreadsheet programs, email programs, database programs, internet browsers...

ool

Ther

e are lots of different types of software. Here are some important ones:

Internet Explorer®,
Mogzilla Firefox®,
Google™ Chrome™.

Lets you look at web pages and

Internet Browser download material from the internet.

Allows you to send electronic Microsoft® Outlook®,
Email messages and files from one Gmail™,
computer to another or lots of others. Mozilla® Thunderbird®.

Lets you create documents (files) with
Word Processor text and graphics, like letters, leaflets,
posters and flyers.

Microsoft® Word®,
Corel™ WordPerfect®.

Allows you to store and organise a
lot of data (usually numbers). ltcan Microsoft® Excel®,
be used to carry out calculations and | LibreOffice™ Calc.

create charts using the data.

Spreadsheet

Lets you store and organise a large
Database amount of data. You can search the
data quickly and produce reports.

Microsoft® Access®,
LibreOffice™ Base.

______ Lets you create slide shows or Microsoft®
' Presentation handouts for using in talks and PowerPoint®,
presentations. OpenOffice™ Impress.

Section One — The Basics
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1) It's important to be able to pick the right software for the task you need to compl

2) In the test, you might have to decide yourself which type of software to use.
3) Make sure you know what each type of software can do.

4) This table lists some tasks and the best type of software to use:

_ Task  Softwaretouse
Searching for information or images on the internet. Internet Browser
Sending email messages and attachments. Email

Producing files with text and graphics, like letters, leaflets,

posters, newsletters, and flyers, etc. Yilere Progessor

S

Organising number data and carrying out calculations. Spreadsheet
Producing a chart or graph from number data. Spreadsheet
: Organising data, running queries and producing reports. Database
r Producing slides or handouts for a talk. Presentation

i
;‘;
s
i
b
|
%
.

1) You are given some number data and asked to carry out some calculations with it.
Which type of software should you use?

2) Name one task which presentation software would be useful for.

3) Jane has been asked to produce a document advertising the local bird watching club.
contain text and photos all about birds. Suggest which type of software Jane should u

Section One — The Basics




Windows, Icons and Buttons

he User Interface
1) A user interface is the technical term for the way
the user (you) communicates with the computer.

2) Different types of software will have interfaces that look and work differently.
3) They usually always have windows, icons, buttons, menus and a pointer though:

is | i This is a toolbar. This minimises _ o |
e 5 2 window for Do) iy rowm This maximises the |

In this one you can see It has useful buttons the window. 4 Al
what's inside a folder. on it. o, (e !
: the whole screen). |

AT e/l « OsDik ?
i OIzla - ok : = Lo %, | his X' button will
4 —l_I’HS iS the Organize ¥ | (W] Openi~|  Print * E-mail . Bum. . Newfolder E= v 3 G j ’ ClOSE tl"le wmdow
. . - e C} Microsoft Word Date modified Typa - K . :
| 8 pointer seE e if you click it. |
S B AR 165 Wierosot WerdDoc 3 i
{See p 5} l H Libraties ] Chnnsedafaultpragurn it SLcraseft Word Ds . |
I Docmen e PPy _This is a menu. :
aJﬁ Music &) Introduction letter 28/01/2004 1452 Microsoft Werd Docy ;
' = & Picturss (& Manager pressntation 14/02/3014 14:55 Wicrosoft PowerPoint | H: has leFE rent
| - & | B v &) Report 2014 OIS Whsresoh Word Docud | opt'io ns which
13 !  @pepenan BAOUMAUSES  Wierasoh Word Docu| | :
| = Computer &) Report 2013 28/01/2014 14:83 Wicrasaft Word Dn:u| & can be CliCkEd on.
| ) Sales data 2013 041720041142 Micresoft Excel Werk:
€@ Network @hppllm 0/0172014 1042 Wicrasoft Exced Work: ™ i
L 3 I | 2 E
| = Title: Add 2 title
‘ These are scroll bars.

Click and drag them .
These are icons. They are small pictures that open a file or to move up and down, ;
program when you double-click on them. You can click on the left and right.
words next to them to make them open too. l

s S AT

; The desktop is usually what you'll see after you've logged onto your computer.

! These small ,_

: pictures are icons, _

Diouble<click: an = |cons that have a little arrow next

icon to open the to them (Outlook® and Word®
e orogram (or file) shown here) are called shortcuts. |

that it shows.

This is the 'Recycle o == Files saved on the desktop
Bin' Files that you will show as icons.
‘ delete end up here Double-click to open them. v
i (see p. 20). l
i |
i ; ; Open programs have a box '
i The ‘Start’ button s around them like this.

(see next page). This is the taskbar. Click on an
icon here to open a program.

b

m&:;:L“’”
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Use the Start Menu to Fmd Softwarev

1) Click on the ‘Start’ button to open the Start Menu.

2) The Start Menu lets you get to the different parts of your computer.

;r The software (programs)

i you use most often will

| show in this list, &

’ Click on a program
here to open it.

== You can click on
these words to open
different folders.

== Click 'Computer' to see the diffe

i - ; | Computer

E Click here to bring up a : files and folders on your compu
i d 7 Control Panel

3 list of all the programs ) corel pHOTOpRINT k8 :

i E,.] t & 3 @ Devices and Printers

i on the computer. L Y (78" Google Chrome : -

| p < Default Programs Click 'Control Panel' to chan,

Help 2nd Support

! % | P8 cdcberesden . .
,. different computer settings. S

If you can't see the program page 21 for more about this

or file that you want you can
search for it here. Click in =
this box and type in its name,
then press Return'.

an ngmms

Click on 'Shut down' to close -

computer or the arrow next to
If you're unsure of a file name you can use the wildcard marker (¥). to see other options (see page

For example, | saved a file about lions but can't remember the name
or where it's saved. | did use my initials and lion in the title though.
So | Type lion*JE" and hit 'Return’.

1) You can get to different folders by opening ‘Computer’ (see above)
and clicking to open the different folders.

2) The window below shows the files inside a folder in Windows® 7:

Click this back _ o[ 7 =
button to go to%@

A BRI

pi @==== o search insid
the !ast Fo|der Organize ¥ Sharewith *  Bumn  Naw foider - &=~ 0686 FOEdEI’ tl’la‘f’. _YC
that you were in. AR E Rf;‘jﬂ,‘ﬂffc'r'b’aw Arange by in, click in t
& Livais I3 Precentation for Gabam -y box and type
- 1 " Documents | : ".‘ i :::l‘:l’nw?nm Preseniztion @g :‘:‘:zmi:ft Werd Docurnent th y{p
1 : J’_MyDucumzm; 3 g == (B z57 e ==]11KB e name oT v
Cth these b Public Documents !5- S5 Report2 Wi Report3 . _
buttons to open & Music E | Miesora Wers Document G_Ef [ youre looking
= Pictures 14 141 =1 ux 2
i = | | &3 % Spreadsheet version1 T t version 2 a file or fold
different menus H v | dppmen g (
H : ) 13 475KB esi s
with opilons. 15 Computer [ -, & Sprezdshest version3 Staff Hofidays Click on *
- M:m;a-tE!:e!WcrLshet‘ 5 Comiviona (gl Foldes
% Newerk 7 s el e e arrow to sels
L different wa
showing the
Click on these folders Double-click a inthe Fald

or links to move to file to open it.
other folders,
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_Software (Program) Windows

This is an example of a typical Microsoft® Office® window. Other software windows
(from Microsoft® and other companies) will look different, but will have some similarities.

wWd9-0 = Documentl - MicrosoftWord

Page Layout References Mailings Review View [ 9

| This top block .

— This is a toolbar.
1 —_— SREE = == = : :

| of buttons and = L S = & % ‘i # It gives you qumk
] / |

words is called

- {
| Quick Change  Editing
ibbon LBHI T ses- Sese - access to loads of useful
ar . Paragraph m|  Styles E-[ 27 buttons.

AR BT

Click on these
words, called
tabs to change |
which toolbar

If you ever forget how
: to do something, have
2= || alook in the different
' || tabs and toolbars to see

(and buttons) ‘j | pd if you can spot useful
is showing. 2 of| buttons.
CLICk e a;rgwﬂ;zxtnto bl;tzons Use the scroll bars to Click on the *+ and.'—’
" o open drop-dow ;.l,e sJ.C. move left and right, or up buttons., or dfag this
s Jial T el T Sl and down in the window. arrow-like pointer to

you want and click to select it. woom iy apil sk

1) Using the Start Menu, find and open the program called ‘Calculator’.
Use the buttons to work out 324 / 24. Write your answer below.

2) Which button would you click to close a window? Tick one box.

3) Using the Start Menu, find ‘Computer’ and click on it.
You might not be

a) Go to ‘Libraries’ and click on ‘Pictures’. ab’_e to answer this
question — | depend
b) Open the folder called ‘Sample Pictures’. on which Operating

- System you haye,
c) Write down the names of any animal photos in the folder.

Section One — The Basics
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__ Office® Features and Shortcuts

1) In this book we will be using Microsoft® Office® 2010.
This set of programs includes Outlook®, Word®, Excel®, PowerPoint® and Access®.

2) The windows in all of these programs look alike (see page 13)
and they all have common features and shortcuts explained here.

3) Other versions of Microsoft® Office® will be similar. Software made by other
companies will have many of the same features but will look different.

1) To make a new document (file) in a program, click the ‘File’ tab, then click ‘New'.
2) Double-click on the option you want — usually ‘Blank document'.

3) To open an existing file in a program, click the ‘File’ tab, then click ‘Open’.

4) A box will pop-up — use the buttons
and links to find the file you want.

5) Click on the file, then on ‘Open’. ==
Or double-click on the file.

6) Open files when you're not in a program by
finding them in a folder and double-clicking them.

7) To save files, click the ‘File’ tab, then click on ‘Save’.
8) Give the file a name and click ‘Save’. You need to use a suitable name (see p. 18

9) You can also save files using ‘Save As’. Use this when you want to save a

1) You can use the ‘Find’ tool to search for text or numbers.

2) Click on the ‘Find’ button on the ‘Home' tab to open the ‘Find’ box.

3) Type what you want to search for, then press ‘Enter’. %

4) Where the text appears in the file will be highlighted. 33 Find ~

If the text can’t be found a message will tell you this.

Section One — The Basics
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1) These buttons in the ‘Home' tab can be used to ‘Cut’, ‘Copy’ and ‘Paste’.
They are found in all Office® programs.

Home Inst

2) Select what you want to copy, then click ‘Copy’.

; = & Cut
For example, select some text or a picture.

=4 Copy
Paste ,
Select where you want the copied thing to go and click ‘Paste’. L

‘Cut’ works in the same way as copy, but removes the original item at the same time.

)
)

5) You can use drag and drop to move things like files, text and pictures too.
) Select what you want to move, then click and drag it with the mouse to a new place.
)

When you use drag and drop to move files it will often
make a copy rather than move the original file.

1) To print off documents, click the ‘File’ tab, then click on ‘Print’.

2) A menu will open with different settings to choose from — these will be slightly
different in each program but most of the ones shown below will be there:

@l Decumentl - Microsoft Word [
. . . Home  Inzet  Pagelaysut  References Llaflings  Review  View - @
Click this to print E“‘ - = Choose how many
‘ S Print T == times you want
when you're happy == o 1 - e b

with the settings. the document

to be printed

Infe Printer N A
= gt BH-SAL0T e on BH-ALED.. b_Y ClleJ ﬂg on
Click this to choose LR S the arrows.
your printer. Sittina
+ Pant Al Pages .
Save & Send _] Fnni ths sntee decument
Pages:
: ) Help _] Bt One Sided .
Click th|5 to Change 1 Gptions | Crb prnz en one e ef

the page (portrait or
landscape).

) . -y Collated - 2z S i o Is 1 i
the orientation of s e, ) s e Th:s. Isthe gt
Y bt Oremation. i preview. It shows

you what your
< document will look

This lets you = . like when it has
change the size B ) ... been printed with

of the page. — the current settings.

1) The ‘Undo’ button is above the ‘File’ tab. ===

2) In operating system windows (see page 12),
click ‘Organize’ to find the ‘Undo’ button.

3) You can only undo a certain number of changes though, so don't rely on this.
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1) You can use shortcuts to quickly do things on your computer.

2) There are keyboard shortcuts (shown in the table). To use them, hold down
the first key(s), then press the final key(s), so they're all held down together.

Keyboard Shortcut What it Does

Ctrl + C Copy

Ctrl +V Paste

_ Ctrl + X Cut
'Ctrl' is the

‘Control' key Ctrl + S Save
(see p. 5).

F12 Save As

Ctrl + F Find

Ctrl + P Print

Ctrl+ Z Undo

3) Right-clicking in a program window is a really useful shortcut too — it brings up a
menu with lots of buttons.

4) These buttons differ slightly in each Office® program but there’s usually ‘Cut’, ‘Cop
‘Paste’ and ‘Delete’, and the ‘Font’ buttons (p. 47).

1) Use the Start Menu to find and open ‘Microsoft® Word®'.
If you don’t have Word®, open your word processor program.

a) Create a new document, then type ‘Section One Practice Task’ into it.
b) Save the document with the name ‘Section_One’, then close the document.

c) Open the document ‘Section_One’ again and type ‘mistake’ into the document.
Then undo it.

d) Save the file again and close the program.

2) Open the file called ‘Office_Task’ and the file called ‘Icon’.
a) Copy the picture from ‘lcon’ and paste it into the file called ‘Office_Task'.

b) Save the file ‘Office_Task' to your desktop using a new sensible file name.
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Using Storage Devices Safely

Files are Stored on the Hard Drive.

To see what files (documents) are stored open ‘Computer’ from the Start Menu:

Click on these Q==+ Compure

Organize v Properties  System proparties - Uninstall or change 2 program - %

to move to

_— “ 4 Hard Disk Drives (1)
other folders. 5 Libaries e .
= ()] 1
@ Documents ﬂ [ e — |
o Music | P mGreeE |
[ Pictures
E% videoe

You can search for
files and folders here.
Just type the name

i-

This contains the B - Y you're looking for.
| =

files saved onto s e

i b ter' = a H Removable Disk. (E:) {5 Rernsvabile

i the computers | G ek | S e — :

F= p 3 _'%/ QD’JIMBlreeni'QSﬁMS A Storage desiings

Devices with Removable Storage (2) - —

hard drive o e ammes | will show up here
' Use Removable Storage Devices to Share Files
‘ 1) You can save files to removable storage devices and then move them between
computers — just connect the devices to other computers to access them.
2) Examples of the devices include CDs, DVD-Rs, Blu-rays™, memory cards (from
— i cameras and mobile phones) and USB memory sticks (also called pen drives).
i 3) These devices all connect to a computer differently. For example, memory sticks

plug into USB ports on the computer unit that have this symbol next to them: i3

4) When connected, these devices show up in ‘Computer’ under
‘Devices with Removable Storage’. Double-click to see the files on these devices.

5) You can move files to and from memory sticks and cards by o g gr y ;
. Click this 'Safely Remove..
using drag and drop or copy and paste (see page 15). icon to open the ‘eject’ menu.
6) Memory sticks or cards shquld always be ejected safely e
to make sure that no data is lost or damaged. : B Ol & :

If the icon

7) To eject safely, click the ‘Safely Remove doesn't appear Custoron;

Hardware and Eject Media’ icon on the task bar, dick this arr 4l

then click ‘Eject’ for the device you want to remove.

ti

1) Describe how to safely remove a memory stick from your computer.
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1) When files or folders are deleted they are sent to the Recycle Bin on the deskto

_ Deleting Files and Folders

2) If you accidentally delete something you can get it back.

3) Double-click on the Recycle Bin, then click on the file or folder
you want to get back out of the Recycle Bin.

4) Click the ‘Restore this item’ button and the file will move back to its original loce

_ You can Zip Files or Folders to Reduce their Size _

1) Zipped files are smaller in size so they're better to add to a
removable device (like a memory stick) or send in an email.

2) To zip a file or folder, right-click on its icon.
Then click ‘Send to’, and then ‘Compressed (zipped) folder’:

Send to LSIE Cnmpress—;ﬁ!};;;;é’&)folderi
3 G Y " 7 |EE Desktop (create shortcut)

3) A new zipped folder will appear in the same place as the original one.
Name it sensibly (see p. 18).

4) Double-click on a zipped folder to open it and see thé files inside.
5) But you need to unzip and extract the files from it before you can change them.
6) To unzip a folder, right-click on it, then click ‘Extract All’.

7) Choose where you want the unzipped files to go by clicking ‘Browse'.
Click OK, then ‘Extract’ when you've finished.

1) Open the file ‘File_1'.

a) Create a folder on your desktop named ‘Reading’.

b) Use ‘Save As’ to name ‘File_1’ more sensibly and save it in your ‘Reading’ folde|
2) For this question you’ll need the files called ‘Bread_photos’ and ‘Bread list'.

a) In ‘Documents’ create a new, sensibly-named folder and put the files in it.

b) Password-protect the file ‘Bread_photos’ and take a screen shot to show this.

c) Make the file ‘Bread_list’' read-only and take a screen shot to show this.
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Changing Settings

| You can Change Lots of Settings on Your Computer

1) You can use the ‘Control Panel’ to change different computer settings.
For example you can change the size of text and icons.

2) In Windows® 7, open the Start Menu, then click ‘Control Panel’ (see page 12).

3) Click on a green category to see more options,

or click on one of the blue options to go straight to the chosen setting:

Click here

to check the

network settings
and internet

connection. &=

Click here to
change settings for
hardware attached
to your computer.

This includes volume

settings for speakers,

and settings for your
mouse and printer.

Click here to
change how this

screen looks.

BB conorr

Adjust your computer's settings

System and Security

Back up your cemputer
Find and fix problems

__ Network and Internet
@ View network status and tasks
options

Hardware and Sound
View devices and printers
Add & device

Programs
Uninstall a program

kg

Get programs

Jy Review your computer's status

Choose homegroup and sharing

View by: Category ¥

User Accounts
"a & Change account type

- Appearar:nce .a nd
= Personalization
~ ™" Change the theme

Change desktop background
Adjust screen resolution

Clock, Language, and Region
£ 2 Change keyboards or cther input
3 " methods

Let Windows suggest settings
Optimize visual display

== Click here to
change how your
desktop looks. This
includes the screen
resolution (how
clear and sharp
information on
your screen looks).

Changzdisplaylangw Click here to make
@ Ease of Access i Changes for PEOP'E

with impairments
| (like eye-sight issues).

4) To help people with eye-sight problems, use the blue ‘Optimise visual display’ link
to increase the size of text and icons, and to turn on the magnifier tool.

5) To help people with hearing problems you can change things in ‘Ease of Access’
too — like make any spoken information show on the screen as text.

6) You can also do things like make the speed you need to double-click slower.

7) You can also change some settings using the right-hand side of the task bar.
For example, click on the speaker icon ([Q}) and drag the slider to change volume.

21

ATttt - iy sy

p. 24f
screen
10ts.

et

mm

1) a)

State one way that you can adjust the settings on your computer to make it easier
for a visually-impaired person to use.

b) State one setting that could be changed to make the mouse easier to use.
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Using a computer for a long time can be uncomfortable. So make sure
you set up your work area properly:

The top of the monitor should be at
eye level or just below and about an
arm’s length away from you.

Adjust your chair so
you're sitting with a
straight back.

Your keyboard should

be just below elbow
level so there is minimal 4,
bend at your wrists. | 4

You should keep your elbov
.~ close to your body and at :
angle around 90-120°.

== Your backrest should be
adjusted so it supports
your lower back.

The front of your seat
- shouldn't be pressing into
the back of your knees,

Your feet should be flat
on the floor or resting
on a footrest if they
don't reach the floor.

Wy s YOUr chair should be an

' adjustable swivel chair —
it should spin round, be

height adjustable and have

an adjustable backrest.

1) Make sure you can reach everything you need without having to stretch or stra

2) Take regular breaks and frequently look away from your monitor, walk around ai
exercise your fingers to reduce the health risks of working with computers.

3) Make sure there’s plenty of light where you are working but no glare on your mor

4) Change your monitor’s contrast and brightness settings to help stop eye strain

1) a) Setup your computer work area properly.

b) Suggest one change you can make to your monitor to help prevent eye strain.
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1) In the test you'll be asked to give evidence to show that you did the tasks.

2) You can be asked for different types of evidence, such as:

» Asaved or printed file (document).
« Asaved or printed screen shot.
« Information or a screen shot added into an evidence document.

3) Make sure that the evidence you give fully answers the test question.

4) Save your evidence with a sensible name and in a suitable place.
The name you choose should describe what the file is (see p. 18 for more).

5) Make sure any text, handwriting or images are clear and big enough to read easily.

1) In the test you could be asked to print off evidence.

2) Make sure that all the information you need is on the printout.
For example, you might be asked to add your name as a footer on every page.

3) Make sure you follow any printing instructions.
For example, A4 landscape or 2 pages per sheet.

4) Check your printouts to make sure they are correct and you can read everything.
For example, if you're printing a spreadsheet make sure the columns
are wide enough so that you can see the data inside them (see page 65).

If a file isn’t printing, make sure that:

|
J

The printer is turned on.

* Allthe printer cables are connected properly
or the printer is connected to your wireless network.

* The printer hasn't run out of ink, toner or paper.
* Paper hasn't jammed in the printer.

* The file has been sent to the correct printer.

—
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1) You might be asked to produce screen shots of your work.
(They can also be called screen prints, screen dumps or screen captures.)

2) A screen shot is where you take an image of what is showing on your screen.
3) So make sure you have the right file or window open when you take one.

4) To take a screen shot, press the print screen key ‘PrtScn’, then use See page
‘Paste’ to add it into a document. For example, a word processing file. See_Wh‘”e

print scr
5) Microsoft® Word®also has a screen shot tool. key is on
keyboal
6) Click the ‘Insert’ tab, then click ‘Screenshot’. s |
Then click to choose which window you want to screen shot i+
Screenshot

7) You might need to ‘Crop’ and increase the size of a screen shot 5
to make it large enough for the right information to be read.

8) Look at pages 55-56 to see how to do this for any graphic.

9) You should only have two screen shots per page, and increase their size so they
take up as much space as they can — this should mean they can be read easily.

. 5
- Sl . This is screen
: . " shot of a Word®
s e e ! i file with a screen
L P o shot of an email
. | pasted into it.
G e LA s

1) Open the file called ‘Evidence’.

a) Insert a screen shot of the first page of the file into the
correct place on the second page.

b) Answer the question on the second page.
Type your answer into the correct place on the second page.

c) Print the document in landscape orientation.
d) Save the document with a sensible name.

e) Close the program.
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1) The internet is a worldwide network of computers all linked together.

' 2) Any computer can connect to the internet (some gadgets like mobile phones can too).

A website is lots of
web pages linked
together.

3) If you're on the internet, you can do lots of things — look at websites
and web pages, send emails, download images, movies and music...

1) To look at web pages, you need to use a browser.
2) Browser icons are usually found on the desktop or in the task bar. 5 @_‘
— i fafeadacs
3) A common browser is Microsoft® Internet Explorer®. = lgj’jﬁi
4) When you click on a browser it will open a window a bit like this:
Use the back or ETrels wi this wahis te You can set a certain_we'o page
forward buttons to open more pages, to open When you click on the
flick between pages. browser — this is called your home page.
g . Address bar. - This button takes you back to it.
& K}ET‘J‘V-:\_'.':.‘-u.,_’_r_ S
— ﬁ P - 6 % [E Gougle ([EHomePage - CGPBocks | W Wikipedia the fres ancydopeia] | B 7""":% !
To stop a page opening, © When you're on a page, r
click the stop button (X). click here to 'bookmark' it or save &
To refresh a page, click ¢ . it as a favourite’. You might need
6 O SEQ to click 'Add to favourites' too.
The web page = Click here, then 'File' and N
will show here. gk g Save as.. to save the page.

Use the extension .htm or html.

1) Web pages have addresses, called URLs. For example, the URL or ﬁsti&iﬁ:ﬂg i

web address for the CGP books website is https://www.cgpbooks.co.uk. o Feipsf* bk
2) Type a URL into the address bar, press ‘Return’ and the page opens. oY C;:‘ just start
Wi WWW .

3) Another way to get to a web page is to click on a link (or hyperlink).

4) Alink is an image or piece of text which takes you to a web page when you click on it.
Link text is often coloured and underlined, like this.

5) To save URLs, you can ‘Copy’ and ‘Paste’ them into documents.
Or make the web page a ‘favourite’.
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“Search Engines

1) You can use a search engine to find a web page or some information.
For example, to find the CGP Books website or some train times.

2) Popular search engines are Google™, Yahoo! and Bing.

3) Type words into the search bar of a search engine.
It will then list web pages where those words appear.

4) The pages that match the words best come up first.

To find the CGP Books website:

i 1) Open a browser window, type - Search bar
‘www.google.co.uk’ into the ; Google
address bar and press ‘Return’. ;

)

2) Type ‘cgp books’ into the search bar.

3) Press ‘Return’ or click =
on the search button. s

4) Alist of web pages
called the results

page will show up m—}

5) Click on a link
to visit the website
that suits you best.

: _ T The pointer will chai
is:nm;ywmenm{mhuw:—zhpm[ tO a hand Wheﬂ _YC

hover aver a link.

Sometimes the first couple of ‘results’
on the results page will be adverts.

_How to Search Effectively Using Keywords _

1) The words you type into the search bar are called keywords. <& If you're as

evidence of y
criteria, use t

2) The better your choice of keywords, the better the search will be.

3) Search engines often ignore words like ‘the’, ‘a’ page Wi::oth_ﬁ
‘he’, ‘'she’, and they don’t understand questlons. vl

4) You need to think about what words might appear on the page you're looking f
5) A good way to practise searching is:

* Think of a question you’d like to ask.

* Use only the most important words of the question as keywords.

+ See what results come up. If they aren’t good,
try adding, changing or deleting keywords.
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Eamet

To find out what Michael Jackson’s date of birth is:
1) Pick the most important words as the keywords — Michael Jackson.
2) Type these into a search engine.

3) This gives some good results but the search could be better.
Try adding a third keyword — birth.

How do you convert from miles to kilometres? [
2) Use the keywords ‘convert miles kilometres'. |

Click on the most useful link.

w
~—

T N

6) The URL for a web page is different to the URL for the search for the web page.

!'f 7) Make sure you give the right one in the test. For example, ‘https://www.cgpbooks.

co.uk/” is the CGP URL, ‘https://www.google.co.uk/#g=cgp+books’ is the search URL.
‘I) Liz has a new car and wants to find a comparison website for car insurance quotes.
- What keywords should Liz use to search for one?

%

)

%
- 2) Use the internet to find out the following:
for £

searchi
esults

a) The postal address of The National Archives.

d
WO rds_’; e T TP P TR E LT PP P E TR PP

.~ b) The phone number of West Midlands Safari Park.

3) Alan uses the website www.wesellthings.com a lot.
He wants to bookmark it. Describe how Alan can do this.
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1) You might need to find information within a website.

2) Websites can have lots of web pages, so you'll need to go to the right page firs

3) Websites are all different but here are some things to look out for:

Lots of websites have their own _ .
Use the back and forward search bar. Enter keywords to Click on text, picture or box

button; to flick between pages. get results within that website. |mks to i to different pages.

Y.

8=

amazon

i

o amaencem

< GetReadyfor
the Big Game -

AL

7 iy
Your Account ~  Prime - s Car-

Shap by P
Department ~ Shdrol]

1P}

kindle

The perfect gift
From 769 1srop now

Kindle Paperwhize. from 19 - Skopnow

Most websites will have lots of menus that drop-down if you click on them.
Click on parts of the menu to move to different pages.

4) To find specific information on a web page, also look out for keywords:

* Press ‘Ctrl’ and ‘F’ to bring up a search box to find words on that page.
* Make sure you look at the whole page — scroll up and down if needed.

5) People don’t usually read a web page evenly from top to bottom. They often I
more at certain areas. For example, areas near logos at the top or areas that
stand out more than others.

Images you
click on wh
link to oth
places can als

7) Companies often design their websites with these hotspots in mind. ' cjied hotsp

6) These areas are sometimes called hotspots.

1) You can use some search engines to find images and maps.

2) In Google™, click on the ‘Images’ or ‘Maps’ button, Or you ;Dt‘:d tse 'mZF
just below the search bar on the results page. SRR L IR SRR
§

Go gl(’_ united kin_gdorj/ ,

Web  lizps lmages

3) Click on the image you like and click again to go to the web page the image is 0
4) To save the image, right click and select ‘Save picture as...".

5) To copy the image, right click and select ‘Copy’. Then ‘Paste’ it wherever you li
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Search engines have advanced search options for doing more specific searches.

1

)
2) You usually click an icon on the search engine to open the advanced search page.
3) In Google™, click this icon in the top right of the search results screen: o
)

4) You can also use these marks (operators) with
your keywords to carry out a better search:

o To search for an exact word or phrase.
M You can use these

in combination
- To search for things but excluding the word after this.  with each other
too.

OR To search for one word OR another.

* To search for an unknown term.

Examples

1) To search for opening times at Alton Towers, try using quote marks:
type Alton Towers “opening times” into the search bar.

2) For information on Olympic games held in London or Berlin try using OR:
Olympic games London OR Berlin.

3) For a restaurant in Leeds that’s not an Italian: Restaurant Leeds -italian.

4) To find the middle name of someone famous: Jamie * Curtis.

1) You've been asked to produce a leaflet about the Lake District National Park.
Find the following to include in the leaflet:

a) A picture of the mountain called Old Man of Coniston.
Save it to your desktop using a suitable file name.

b) A map of Lake Windermere. Print out a screen shot of your search for the map.

c) The opening times of The Pencil Museum in Keswick. Write the answer below.

3 23

2) Billy wants a new car, either a Vauxhall Corsa or Astra. He'd like to read some information
about them both first. Carry out an internet search to find suitable websites for Billy. Paste a
screen shot of your results into a word processing file and save it with a suitable file name.
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1) Anyone can put anything on the internet.

2) So you need to use websites you can trust.

3) Here are some things to look for:

Reliability: Have you heard of the website? s it an official one? For example, you
probably trust a news story on the BBC website more than one on a blog

> 4

Currency: When was the website created or last updated? A blog s a website

This will tell you how up-to-date the information is. people can write th
opinions for others

Relevance: Make sure the website is relevant to you. For example, if
you want information on Birmingham, England, make sure
you're not on a website for Birmingham, Alabama, USA.

Bias: Who wrote the page? People can write things in a biased way to make a p
For example, a company website might only post positive reviews of its prc

1) Text, audio, video, music, song lyrics and images are protected by copyright law:
2) This means it's illegal to use them without asking the copyright holder’s permiss
3) You also might have to pay to use it and you always have to acknowledge the h

4) Look out for these copyright notices:

* The © symbol. For example, BBC © 2014 on
a page means the BBC owns the copyright.

+  Watermarks or names on images. o
These tell you someone owns it.

+ Copyright-free or public domain notes.

Work that says it's copyright-free or in the public [ts OK to use basic
domain can used without permission. You should still like dates, addresse
acknowledge the owner though. Look out for license terms. opening times wit
For example, Creative Commons licenses. permission.
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A troll is someone who
uses the internet to

1) You should behave on the internet as you would in real life. upset or harass others
)

]

This means being polite and respectful of other people and their views. ;

w

) Don’t make threatening, abusive or racist comments — don’t become a troll.

4) Don’t argue with people or use capitals — that means you're shouting.

1) Criminals can get information from emails and the internet.

2) So do not give out personal information unless it's to a trusted source.
For example, your bank’s secure website should be okay, but a forum probably isn't.

3) You should be very careful when giving out dates of birth, addresses,
email addresses, telephone numbers or bank details.

4) The Data Protection Act sets rules for how companies deal with
personal information.

ol

Viruses can enter your computer from the internet.
6
7

So installing and running antivirus software on your computer is important.

Be careful downloading or opening files, especially if you don’t know where they're from.

8

Don’t click on links in pop-ups (web pages which ‘pop-up’ without you going to them).

Because of the internet we can now communicate easily with people all over the world.
1) Email — can be used to send information quickly and easily.

2) Websites that allow file sharing — multiple people can work on something
at the same time, or pick up files from
a shared place. For example, Dropbox™.

3) Instant messaging — allows people to talk instantly. For example, a company can
answer a customer’s question on a website straight away.

4) Blogs and online forums — people can easily share their views and read others’ too.

5) Social media — allows people to stay in touch with lots of
other people. For example, Facebook® and Twitter.
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1) In which of these cases is it safe to give out your personal information? Tick one |
A clothes website for a shop you’ve never heard of based in another cc

Your secure banking website.

On a blog.

L O O O

On a forum.

2) Sunita is setting up a new business and is looking for advice on the internet.

She finds two websites: a UK government one and a blog of someone who work:
Which website will be more reliable? Give a reason for your answer.

3) Maria is making flyers advertising walking holidays in Yorkshire. She finds these i
the internet. Which image can she use without permission? Give a reason for yo!

A B C

Fred Tetley © 2014. This work is in
the public domain.
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Section Three — Email 83

Sending and Receiving Emails

1) You can use email to send a message to one person or a group of people.

Emails are Electronic Messages

2) Sending an email is a bit like sending a letter but instead of printing it out and

ing i aper, you send it electronically using a computer.
sending it on paper, y y g p S —

3) To send or receive an email you need to have an email address. from phones, tablets
and other gadgets too,

chris@cgpbooks.co.uk < Email addresses always have
an @ symbol in them. They

matt287 @cgpbooks.com == | or have spaces in them.

a ban

ges of
Inswel.

i

1) To read your email you need to use software (such as Microsoft® Outlook®).

2) In this section the screenshots show what using email in Outlook® looks like.
Other software and websites might look different but will work in a similar way.

3) When emails are sent to your email address they go into your inbox.
You can open and read them there.

_Example

This is what an inbox looks like in Outlook®.

The inbox is highlighted here. To open an emall, click on
This shows that you are it and it will appear on
seeing what's in your inbox. the right of the screen.

:’.;*n ‘_T}; {_'-4 Ereeung 1

Delete | Reply Reet Forward B pgore- | -
J - =

Ty o T lnbox-PhlipSeopbociscouk- Micosof sutiook - G4
end /Feg Folder  View
ate gy - b oS
n ane = i
s Uned orize
= a1 ua

L This is the subject
of the emall.

|- HiPhi

= This shows who
the email is from.
Often the name
of the person is
shown instead of
| their email address.

© tjustreadagreat re

o one of the books we worked on last year. Have |
alook at it here. Though! |

ight be intarasted to read it.

Tam

B T T

WA e

ooty s

sman |

soonod | f

ETILE T

somlzem - |

AL

¥ This shows who

the email was
You can also open an email by double-clicking on it. dent b

This will open it in a separate window.

Rilfsiden e up e i Bms S
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1) Click on the ‘New E-mail’ =

¢ 3 sy Tl Send * Receiv Folder View
button on the ‘Home’ tab. =L " IE” st e _
A window will open \%_‘H 5w ciean p - X o=
With a blank message‘ & Er:‘rer:il It!::.'vsvv &glunkv Delete  Reply Rililly Forward

Mew Dzlete Respond

Type the email address of the

person yOU,re Sending the email to. v # !5 Internet connection issues - Message (HTML) l_c'__i_@_h
TO do thiS yOU type an i Ies lnse.rt .Options Format Text Review B
email address next to where =, s TH VR gy SRR o

[t Says T ,. S te EB E : Mames Jiﬁaclz Hem:” T

% Signature ~

You can send an email to several o
people by typing in all their email

Include z

To
addresses here. = T —
Ir\temet (nnnemon Issues e T

Add a subject to the email —
this is a few words to descrlbe
what the email is about. ===

I've been having problems accessing the internet this morning.
Can you look into the problem for me?

Thanks
Type your message =

(or paste text into here
from somewhere else).

Phil

5) Send your email by clicking on ‘Send’.

¥

1) Open the email you want to reply to.

Home Send / Receive Falder

« lanore

2) Click ‘Reply’ or ‘Reply AIl’. =

Mew  HNew
E-mail Items -
Mew

%Junk

Delete

3) This will bring up a new message
with space to write your reply.

Clicking Reply All' means your reply
goes to the person that sent the email
and everyone else it was sent to.

Send

4) Type your reply and then click ‘Send'.

i . . é?d.l & [
You can send someone a copy of an email using forwarding. S et comncion
HiJane

1) Open the email you want to forward.

Hera's the reply | got irom Tom,

I e N L

PN g

2) Click ‘Forward’. === —

Forward

3) Type the email address of the person (or people)

you want to forward the email to.

4) You can add your own message above the forwardr;d email
or just leave it blank. When you're finished, click ‘Send'.
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From: Tom

Sent: 31 January 2014 09:47

To: Phillip

Subject: RE: Internet connection issues

/J

Hi Phil

Yes that's no troubie.
I'm fooking at the problem now

Tom



You can attach files to emails.
They're then sent with the message.

To attach a file to an email:

1) Click the button marked ‘Attach File’
on the ‘Message’ tab of the email window.

2) Find the file that you want to attach
and click ‘Insert’.

3) This will attach the file
to the email. It will be shown
below the subject line. =

Repeat these steps to attach
more than one file to an email.

(=5 |l
o8

slw Untitled - Message (HTML)

Inzert Qptians Raview

Farmat Ted
i B il 2ttach File

_ attach ltem - .
& Signature *

Includs Zoom

b4

Mames

Z - =
Hi Patrice -
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3 Insert File =

@ij! « FSICT » FEICT summary

Crganize = Mew folder

~ lams
T Favorites
e ) Project summary
47, Libraries.

_= Documents

o Music

= Pictures =

H videos

& Computer

i Netwark v G

.
~ | AllFiles -

|

EfpanL |
send =
Subject: Fu

3 :@P(D ect summary.decx BT KBl )

I've attached the summary of the Functional Skills ICT project.
Ill let you know when it goes on sale.

It'll appear on the website here:
hitps://www.cepbooks.co.uk/Student/new

Thanks

Phillip

You can attach a webpage to an email.
You can also put a link to a webpage in an email.=

Press the ‘Return’ key or ‘Space bar’ after a URL

to make it into a link. It should turn blue and be underlined.

A link is the URL of a webpage that you
can click on to bring up the webpage.
Only click on links in emails from people

you trust (see page 25).

1) Attaching files to an email makes it bigger. This means it takes longer to send.

2) To help reduce this problem you can attach files in compressed (zip) folders

— see page 20 for more about these folders.

3) Compressed folders also make it easier to attach more than one file to an email
— you only need to attach one compressed folder instead of lots of separate files.

4) Attach compressed folders to an email in the same way as you'd attach normal files.
When they are attached they will be shown in the same way too.

Subject:

Attached:

Staff Holidays 2013

L Staff Holidays.zip (549 KB\ 4
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To save files that are attached [0 o o i ] ] sy Repors - esmge vy (=2 (@) e
to an email you've been sent:

1) Click on the attachment P g T ttsments stacmment AL Hietage
you want to save. 4

2) C“Ck on the {Save As; buttonij Z57| Last changed: 20 December 2012

| hizssage ttachments & 3

el X fgeg N

~ctions Sslection tlessage

3) A new window will appear.

Use it to find the location on your computer If you double-click on an attachment
where you'd like to save the file. Make sure it will open the file. You can then sav:
the file has a sensible name and then click ‘Save’.  the file to your computer from inside

the program (for example, Word®).

[_w—ﬁ__' i ,:_L-.-.:-:;srx::-.?!?,’g

a)

b)

c)

d)

1) Open a new blank email. You are going to write an email to Jane Askill.

Address the email to j.askill@cgpbooks.co.uk.

Make the subject of the email ‘Life in the UK’.

Open the file called ‘Jane_Email’. Copy the text in the file and paste it into your el
Add your name to the end of the email.

Take a screen shot of your completed email.

Find the email address of the Head of IT in the file called ‘Staff_Email_List'.
Address your email to this person.

Make the subject of the email ‘New PCs’.
Open the file called ‘IT_Email’. Copy the text in the file and paste it into your emai
Add your name to the end of the email.

Take a screen shot of your completed email.

a)

(@) O

{o}

)
)
)

e
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3) Open a new blank email. You are going to write an email to Susan.

Address the email to susan@cgpbooks.co.uk.

Make the subject of the email ‘Hallway painting’.

Open the file called ‘Susan_Email’. Copy the text in the file and paste it into your ¢
Attach the file ‘wet_paint_sign’ to the email.

ake a screen shot of your completed email.




Using your Gontacts List _

Contacts Lists

{ 1) Your contacts list is where you store the details of people that you send email to.
2) It's basically a list of people’s names and their email addresses, but you can also
store other details about people such as their phone numbers and address.
3) You can get to your contacts list by clicking on the ‘Contacts’ button.
(It's at the bottom left of the Outlook® window.) T Caenda
. . . . Ecantads
4) In Outlook® your contacts list will look like this. G
E . N — | Notes
£ = = Contacts - Tom@cgpbooks.co.t i
I; e Send / Receive Folder  View EEJ;'!‘EE‘._‘E_".F.‘HL-
I a= = Ty G, W -
|8 8 %lx % ] &3 %
) | New MNew Contact “New | Delete | E-mail Meeting Mare | -a,_','sine“ c. Card Phone List =l
onta Grou ems ™~ | |
; o Newp Deiete ‘ Communicate | Current View N YOU can change the
4 Wy Contacts $ way your contacts list
%i”“f:::“""‘m‘_ - looks by clicking on the
,; o e e different views shown in
"" jane@cgpbooks.co.uk phillip@cgpbooks.co.uk th& Current VIEW bOX.
l In this screen shot the
L ! ‘Business Card' view is
E selected.
Here are two different contacts.
Adding New Contact Details )
_ ome [—
= 1) Click ‘New Contact’ which is on the ‘Home’ tab == ezt
f New New Contact
k. A new contact window will appear. oot e
( - . N SEHY 8 e 1= 7 Mism- Cost s
 2) Fillin the details that you want to add, FEE o | et ramaren et
i such as name and email address. H X S (:*_-“é;,”;"n, @3?‘1 B%;g’
In this example, details have been filled i L AR Tl I
ln for a new Contact Ca”ed Miriam_ SR S R e Full Hame... (tinam !:NYI___,_ i
Company: {cop R
Click on the 'Full Name..." button /:::“ Lm_m H r L
- to get more name options to fill in. ‘M‘Ee;@" = - :
3) When you've added all the details you wantto, || wemee o !
click the ‘Save & Close’ button to save the Bl il '
contact details into your contacts list. | i
Business Fax.. E:j ] ]
There are lots of other details Dovee. [ -] |
that you can fill in for a contact. S
For example, different phone numbers. O o™
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1) Open a new blank email and click the To...

Co..

Send

2) This will bring up a list of your contacts. N Sublect

Select Names: Contacts &J

Search: © N ly < More col Add Book
kil ot Ml i g s S _ To see the contacts from your

A= = contacts list, make sure 'Contac
(followed by your email addres:
is selected in this drop-down be

Display Name

Ry e T R ey
e anE OIS £0.)

hﬂilp{nhiﬂ:;;&gpbook& Luk)
Susan (susan@capbooks.co.uk) susan@cgpbooks.co.uk

" You can search for contacts using

this box. Type the name you want Address Book - _
to Search ‘FOI’ and C“Ck .GO' | Global Address List - Tom@cgpbooks.co.uk =

: | X

G

You might see 'Global Address |

<+

mn

To> | ne fene@carhooks.co.uk)

' (followed by your email addres:
(o> | when you open your list of conta

o< | [coneel | This normally shows all the peopl

a business or organisation that F

Double-clicking the name of a contact an email account. For e>_<amp[e,
puts their email address into the To ->" box. the students .and tutors might ap
Here 'Jane' has been double-clicked on. on this list at a college.

3) Once you've selected all the contacts you want to send the email to, click ‘OK".
This will take you back to the blank email message that is now addressed
to the contacts you've selected.

=1
Send

4) Write your email and click ‘Send’ =====

You can use Cc and Bec to let other people see emails that you are sending.

Example

In this example, an email to Jane is
being Cc'd to Phillip and Bec'd to Tom. =

] Overtime this €

Insert Qptions Format Text

Calibri (Boch - 11~ A A Z-iE. o o#

Cc: This sends a copy to an email address =P g WA~
— in this case, to Phillip’s email address. === b

Here, Jane will be able to see that the email : _
has been Cc’d to Phillip. g BB

[I{ % Tom;

To.. pELH

2 Subject: .Ovénirv;ethi: evening -

Bcc: This sends a copy of the email to someone
privately. Jane and Phillip won't be able to tell
that the email has also been sent to Tom. ==

1 Message Insart Cptizne

:‘} B cotors -

Themes e e 134 From
- [Sletfects -

Themas Shaw Figlds

If you can’t see an option to ‘Bec’ you can make
it visible by clicking ‘Bec’ in the ‘Options’ tab. s
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A group distribution list (called a ‘Contact Group’ in Outlook®) is a list of email
addresses saved under one name. They can be useful when you want to send an
email to a particular group of people — for example, people who work in your building or
are on your course.

1) Open your contacts list.

2) Click on ‘New Contact Group’ ==
on the ‘Home' tab.

Mew Mew Contact Mew
Contact Group Items ~

Hawr

This will open a blank Contact Group window. Click on the ‘Add Members’ button
and then ‘From Outlook Cpntacts’ in the drop-down list.

i Untitlef.:l‘-;,_-:;ﬁnntact Group | =16 %1
1 Hie Contact Gloup Insert Format Text Toiew o &

P . (em 157 [ & | & g W Categorizer == You can click on
WX 2y | &85 & | & Spy fay F g [
5 | st | 1 ¥ Follow Up * e From Address Book
Save & Delete Forward |Members) Motes I Add [Fen E-mail hesting e

| e
Group Group~ | ‘ '&e_@bers'_“rzr‘;-;i. 4

shaw & From Outlook Contacts Mg
T gd From Address Book

instead. This lets you
see contacts that are
listed in the Global
Address List.

Clase

| Hame-: i 23.;, Mew E-mail Contact

There are no items to show in this view.

3) Add contacts to the group by e Gty =
. " Search: © Mameonly . More columns Address Book
double-clicking on them. 2 st kit
T e e ]
Tane @cgpbocks.co.0h) SR

{philip Ecgpbooks.co.uk)

L

Contacts that you've
added to the group
will appear here, s

S :

Members -> i

); Susan {susan@copbooks co.ukd

r“ o T Cancel

Jans (1ane Ecgobooks.co.

4) After clicking ‘OK’, you'll see a
window that shows the members
in the group. Type a name for the

f
i
1
1l

Untitled - Contact Group

3

A= Contsd Sroup Insert Format Text Review
roup and then click ‘Save & Close’ Ll @Y (e |57 2. & =5 ¥ &
Save & Delete Forward El\-lemhers MNotes tdd pemove Update E-mail Meeting
Closs  Group Group~ '____“7{ Klembers ¥ Membar  How
Zziont Shaw fizmbers :?ﬂ\_m!:a'i&d_

Type a name for the group here. == —

TopFloorOffice

NHame : - . _Eomail
9] Jane (jane@capbooks.co.uk] jane@cgpbooks.co.uk

4| Phillip {phillip@cgpbooks.co.uk) philhp@cgp‘nonks‘ce.uk
8] Susan (susan@capbooks.co.uk) susani@cgpbooks.co.uk

Members of the group
are listed here, ===

5) The group Wl” then appear ln your Search: © Nameonly - More columns Address Book

contacts list. To send an email . Contacts - Tom@cgnbooks.co.uk Y advanced Find
to the group, follow the method S ST T W
h . i & Jane Jane ﬁene@cgnbaulrs.co.uk) jane @cgobooks.ca.uk 7‘
S own on the prev‘ous page_ | g Philip Phillip (phillip @cgpbocks.co.uk) phillip @cgpbaoks.co.uk
& Susan usan_!? k) susan@cgpbooks.co.uk l

= SFop o0 OIHo
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1) Open a new blank email.
a) Address the email to three people in your contacts list or address book.
b) Make the subject of the email ‘Plumber needed’. You need to have som
contacts saved to answer

question, or search for so

on the Global Address |

c) Open the file called ‘Plumber_Email'.
Copy the text in the file and paste it into your email.

d) Take a screen shot of your completed email.

2) Open a new blank email.
a) Address the email to one of your contacts.

b) Cc the email to another contact and Becc the email to another contact.

@]
— =

Make the subject of the email ‘New staff'.

d) Open the file called ‘Staff_ Email’. Copy the text in the file and paste it into you

Take a screen shot of your completed email.

3) Open the file called ‘Contact_Details’.

a) Open a new contact window. Create a new contact for Daniel including all the ¢
you've been given. Take a screen shot of the window and then save the contac

b) Open a new contact window. Create a new contact for Nadine including all the
you've been given. Take a screen shot of the window and then save the contac

c) Create a new group distribution list and add the two contacts you’ve made
(Daniel and Nadine). Name the list ‘Team A'.

Take a screen shot of the completed distribution list and save it.

4) Open the file called ‘Joshua_Temple’.

a) Open a new contact window. Create a new contact for Joshua including all the
you've been given. Take a screen shot of the window and then save the contac

b) Open a new blank email. Address the email to the ‘Team A’ distribution list that"
up in Task 3. Cc the email to Joshua.

c) Give the email the subject ‘Team meeting’ and paste in the email message text {
the file ‘Joshua_Temple'.

d) Take a screen shot of the completed email.
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1) You can search the emails in

’Q'J[.

| Home [ Send/Receive  Folder  View

i your inbox using the search bar.

2) Just type in the word (or words)
you want to search for.

@ &4 Ignore X = I—;:\g [_2 B Mesting é Archive 1 & To Mana
¥ CleanUp ~ | ¢ » c‘EiTearnE -mail + Done

New  New Delete | Reply Reply Fornward B - s

E-mail Items ~ | &Junk ¥ | pY A';H g ore _&?__'EE_'!_B‘_[B'E“ *F Create N
Hewy | Delete Respond Quick Steps

__‘ Philllp@cg i = search Inbox [Ctrl<E) o

T B Inbo: 5= =

e %-D"m ~ | Amange By: Date | Newest on top =

ral

@ Sent ltems S ! i
{5} Deleted Items r A
: EETE— s
(Gg Junk E-Mail Salesforecastupdate e |
[} outbox S D i1

In Phillip’s inbox a search for ‘'maintenance’ gives 1 result
— an email which contains this word.

 maintenance

| &mange By: Date | Hewest on top

1%} Mai e work
lai
= Tom

| 4 TwoWeeks Ago

lls

The results of the search are listed here.

Sent Fii3LOL/2014 1731
Yo Susany Jane; Phlp

Hello all,
The server is having some work done on it over the weekend
so the network won't be avallable externally. 1t'llbe back up
and running by 3am on Monday.

Let me know I this Is a problem for you

Cheers

| Tom

The word that
was searched for
is highlighted in

the result.

For this search, there's only 1 email in the results.

aI[S

Sorting Emails -

i
|

In Outlook®, you can change the order that emails are listed in.
You can sort emails by their date (this is the most common way),
who sent them (the sender) and in lots of other ways.

‘Szarch Inbox (Ctrl-E)

The emails in this inbox

Arrange By: Date

are arranged by the
date they were received. ®

% Sakslore-mstupdna SRS

[ | Newest on top h

The newest email is at

! - Yemcday

I
1
|
|
i

Set?: thﬁ top O'F the ||St lgz:gﬂenum Mnnl.s:lé
By C“Ckiﬂg in the heading i,sﬁ.chlr:bux(ctrt-a = p[i

emails in a different way.

below the search bar, gt v R e
) rom i mmE
you can choose to sort the lr:_IESE’___ ;
;asunn = Ie

You can reverse the
order of the emails
by clicking here.

If the emails are
arranged by date this
will show the oldest
at the top.

== Clicking 'From' sorts

the emails by who
sent them.
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You can add new folders to help you organise your emails.

Example
To create a new folder for pension emails: SR one sosiniain o e
. . , - ;_, Q_-'_“i.ﬂp) folaer o ;l‘_-’
1) In the ‘Folder’ tab click ‘New Folder'. a@f v L ,ﬁ]u”
2) Type the name of the new folder. == '
Crezie New Felder %
3) Select where you want the B i ]
new folder to go. Peosen
Folder contains:
[Hai\ and Post [tems -
In this example the inbox has been Select uhere o plce the folcer
selected, so this new folder will be o g

inside the inbox. s=== (2] Drefte ‘z!

5 Sent Items
3] Deleted tems

4) C“Ck ‘OK,. 4 Susan@cgpbooks.co.uk  © ! Z Calendar Ll
e 84 Contacts
The f0|del' [S #'eginbox ‘ @Jnumal i
. s 3 Pension | @ Junk E-Iail i
now visible Jz ortts L S -
i . o U5 Sent Items I—_ %
in the inbox. = ‘S Deleted Items i
If a folder has a little white triangle next to it,__ .. otnmne
this means it has more folders inside it. M és =i g—'
Click on the triangle to show all the folders.  bowtcazem
5) To put emails into the pension folder [ <. 7y Bma " Finds ¢
) Topu nto the p : LBLS ) By e e
select the email or emails you want e | Rl e Ctegorae e
to move and click the ‘Move’ button = - eension. T
on the ‘Home’ tab, then click on ‘Pension’. i

(You can also click and drag emails you want to move into the folder.)

Sort the emails in your inbox by sender (who the email is from).

b) Arrange the emails in your inbox in reverse alphabetical order (Z on top).

3) a) Create a new folder in your inbox and name it ‘Archive 1.
b) Move three emails into the folder ‘Archive 1°.

c) Create a new folder inside ‘Archive 1’ for storing emails received in 2012.
Give the folder a sensible name.

d) Take a screen shot to show the ‘Archive 1’ folder and its contents.
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3) Neveropenan attachment or click on a link sent from an email address
that you don’t recognise.

4) It's a good idea to have up to date antivirus software on your computer.

5) Some security software and email services also have spam filters
— any emails that look like spam get put into a ‘Junk’ or ‘Spam’ folder.

Spam emails are emails that you haven't asked for or sy, [-a Junk E-Mail
'signed up' to receive. A lot of them are adverts.

1) It's not a good idea fo send important personal information
i (like your address and bank account details) by email.

3) If you get an email asking for lots of personal information, be suspicious.
The email might be from someone trying to steal your personal information.

4) It's worth remembering that whatever information you send in an email could be

1) You should write emails so they are polite and respectful of other people.
2) You should write emails in the same way you’'d write a letter.

3) In formal emails (see next page) make sure you use proper language
— don’t use ‘text speak’ or less formal language just because it's an email.

1) It's important to use email safely. If you're not careful you could download viruses
or put your personal information at risk.

2) Emails can contain viruses. To reduce the chance of Trustworthy sources include
downloading a virus, you should only open attachments people that you know like
or click on links in emails sent from a trustworthy source. friends and family.

6) Always keep the password you use to access It's not a good idea to write your
your emails a secret. This stops someone else password down on paper — if someone

logging in to your email account and using it. finds it they could access your emails.

2) The reason for this is that email isn’t 100% secure. The information you send could
be intercepted — someone other than the person you sent it to might be able to read it.

forwarded on to someone else. Have a think before you send private information.

43
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You can use formal or informal writing in emails.

 Formal writing sounds serious and professional. A example of when you'd use
this is when you're filling in a job application, or when you're at work.

* Informal writing sounds chatty. It's used when you're emailing friends and famil

Example

Here's an example of an email written in a formal way.

AT s e wls Ticket reference GBOD2346/1 - Message (HTML) e
% EE R N EEEPR Insert Options Farmat Text Review @ @
= Calibri (Body) 11 v A w 0l Attach File ¥ Follow Up v {)
— - B I U _Wattachtem ~ ¥ High Importance A
Paste " Hames Taom
® F 87 v ;\. M = §
Clipbosrd Put the email address of |,
hilllis <= . .
e ~| who you're writing to. |-
Ta m.reynolds @workmail.com
s Ton ian e e VViite whvat the emall t dbout |
Greetin N T ) here in the subject !me :
Dear Mr Reynolds, i
— % y
I bought two tickets from your website three weeks ago. They haven't arrived in the post yet, but
your website said they should have arrived within two weeks. The ticket reference is GB002346/1.
Please could you check that my tickets have been posted to me, and if not send them out as soon
Ending as possible.
o

;2= Yours sincerely

| Main part of your email. This should

| explain clearly what the email is about.

Your name D ~

Subject line: This should give the person receiving the email an idea of what
it's about before they read it.

Charles Bogarde

i j m.reynolds@workmail.com

Greeting: In a formal email this should start with ‘Dear’, followed by a title
(for example Mr or Mrs) and the surname of the person. If you don’t know the
person’s name you can use ‘Dear Sir/Madam' instead. For an informal email
you might use ‘Hi’ or ‘Hello’ and just the first name of a person.

Ending: You should end with “Yours sincerely’ if you know the name of the
person you've emailed. Use ‘Yours faithfully’ if you don’t know their name.
In an informal email you might use ‘See you soon’ or ‘Best wishes’.

Always end an email with your name. Give your full name in formal emails
and just your first name in informal ones.

You can format the text in an email in lots
of different ways using the buttons -..
at the top of the window.

See page 47 for
information ab
Formattfng te:

It's a good idea to do a spellcheck before you send an email.
Click the ‘Review’ tab and then ‘Spelling & Grammar’ to do this.

i

There's more about
spellchecking on page 48.

Spelling &
Grammar
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ez
1) Open a new blank email.
a) Address the email to jane@cgpbooks.co.uk.
b) Make the subject of the email ‘Email security’.
c) Write an email to Jane that contains the answers to these questions:
1. Why is it important to keep your email password a secret?
2. Give one way that you can reduce the risk of getting computer viruses.
d) Take a screen shot of your completed email.

2) Open a new blank email. In this task you're going to write an email to a friend.

a) Address the email to one of your contacts.
If you don't have any contacts stored use susan@cgpbooks.co.uk.

b) Write an email to a friend asking them if they would like to come to a meeting about
setting up a new sports club.
Tell them that the meeting will be held next Wednesday at the cricket club. Don't forget
to put a sensible subject line and to use a greeting and an ending on the email.

c) Take a screen shot of your completed email.

- 3) Open a new blank email. In this task you're going to write an email to a hotel manager.

a) Address the email to the hotel manager, Mrs Helen Wood.
Her email address is helenwood@qualityservice.com.

b) Write an email to the manager asking to change a booking you've made. The booking
was made for the 12th of December but you'd like to change it to the 18th of December.
Ask her if this would be possible. Put the dates in bold in the email.

¢) Run a spellcheck and take a screen shot of your completed email.

' 4) Open a new blank email. In this task you're going to email a washing machine company.

|

a) Address the email to the company. The email address is applianceparts@gmx.co.uk.

b)  Write an email to the company asking how much it would cost to buy a washing
machine part from them and have it delivered to you. The code for the part is

B62370-2. Put the code in bold in the email.

€) Run a spellcheck and take a screen shot of your completed email.

Section Three — Email
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Formattmg Text

1) Word processors let you change how your text looks. This is called formattin:
2) They can do fancy things like adding pictures or checking spelling and gramn
3) Word processors can be used to make things like letters, leaflets, posters, flyel

4) One of the most common word processors is Microsoft® Word®, which is used h

Example
=?fél-‘j ] 1= 5 o]
These tabs™ | - e mwoss roune
bring up [ oo i ol ey 7 et sasmcan AabbC, Lx s Tool bar —
different tool || * """ 77 ) o | lots of useful
bars when || 2| buttons are
clicked. | | found here.
Itwas & Thursday afternconinJanuary and the Sun was shining brightly. .
Thjs Is the i Dave shoutad out loud, “IT'S SUMMER "
cursor — - l !
a flashing %ﬂl
black bar. LIRS, - - LEES :
1) To enter text, click anywhere on the page and start typing.
2) Use the mouse or arrow keys to move the cursor to a new place.
3) Press ‘Enter’ or ‘Return’ to move to a new line.
See page 5
4) Use the ‘Space Bar' to make spaces. <@mmm====== for more on

keyboard keys.
5) Use ‘Shift’ or ‘Caps Lock' to get capital letters.

8) To get the top symbol on a key, hold ‘Shift’ and press the key.

7) Press ‘Delete’ or ‘Backspace’ to remove letters, numbers or symbols.

8) To select text, click and hold, then drag from the start to the end of the text you W
9) To move text, select it, then click on it and drag it to a new place.

10)You can also add text using a text box.

11) Click on the ‘Text Box’ button on the ‘Insert’ tab tool bar, then choose from the lis

Section Four — Word Processing
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Home [nse

1) Use these buttons on the ‘Home’ tool bar -
to cut, copy and paste.

pre-

& Cut
2) Select the text you want to copy, then click ‘Copy’. F:.aste = g
- J Farmat Fainter
3) Move the cursor to where you want to put the text, Etiplmard
then click ‘Paste’.

4) ‘Cut’ works the same way as ‘Copy’, but it deletes the original selected text too.

To do this, select the text then use these font buttons on the ‘Home’ toolbar:

Click this, then choose from the list Click st change the -
to change the font (style of the text). F
: : _ of the text. The larger the
E.g. Arial or Times New Roman. & :
& £~ number, the larger the size.
Arial 12 v A A Aav Gl

This makes the . . o
textbold. =3 B £ U ~abs X, X v B A

A ) ‘ A

]
This makes the text italic — This underlines Click and choose from the list to
slanted a bit to the right. the text. change the colour of the text. The line
underneath shows what colour is chosen.

If you change these before typing, everything typed afterwards will look that way.

EET
= . ey A:  AFna- |
i i Arial 14 A AT As AN AaBbCcDc | AaBbCeDe i AaBbCi AaBbte ‘fi"‘_*_ 3 P—:I::ce
Faie g B U e x % b =, THommal T Mo Spaci. Hesdingl  Heading 2 ;“;;‘59* -_': T
This is left-aligned text.
This is centre-aligned text.
This is right-aligned text. o
L This is justified text. The text is aligned to both the ieft and right margins. #
Pageilofl  words 2o ZTT : . A Hadss sm o L -'_—]'_"‘
2) Use these buttons on the Left-align ss== == = = s Justify text
'3 ] 3 . ——— = —_— T
J _ Home’ toolbar to align text
aft : s .
€r you've selected it: Centre-align © " Right-align

§ ——
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1) Select the text you want to change, _ =
then click this button in the ‘Home’ toolbar. — P
2) Click on a spacing from the drop-down menu. 5

3) Line spacing is usually set at 1.15. Line spacingis 1.15
Line spacing is 1.15

3.0

Line Spaang Options...

Line spacing is 2.0

-

Femove Spacs 2fter Paragraph

Line spacing is 2.0

1) Click one of these buttons in the ‘Home’ tool bar: = i= Click to add
2) Click on the arrow next to the buttons Click 6 i § “m e
to change} the bullet or numbering style. bullets. ShonnleLisk
=M. . N Shopping List
giﬁ‘iis};w Shopping List 1. Beans
Mene g O = + ! 0:0 ;:;:zz@o} Beans e Beans 2, Eggs
o2 Eggs e [ggs 3. Milk
- v o Milk ¢ Milk

1) Some word processors automatically underline spelling and grammar mistakes.
2) Spelling errors are often underlined in red and grammar errors in green or blue.

3) Right click on the underlined word to choose the correction.

4) You can also check for mistakes by clicking on the
‘Review’ tab, then on the ‘Spelling & Grammar’ button. =

5) If everything is correct, a box will appear Soalling end Gramemar: English (LK) —
saying the check is complete. 1ot ]
I'm not very good at speeling. - |_towreonce

= J Ignare Al

6) If there are mistakes, a box like this ===y
will show where they are. =

i | Acd to Dictona

Changs
Koot

,
=

7) Click on the word you want = S
to replace it with, then click ‘Change’. i : :

AuteCorrect

8) If you look at your document now, you'll see | @ -
that 'speeling’ will have become ‘spelling’. o | e
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1) Open a new word processing document.

a)

b)

EL3

Enter the text as shown in the example Word® document on page 46.

Save the file using a suitable name.

2) Open the file called ‘Amazon’.

Change the line spacing of all the text to 1.5.

Right-align the date, and change its font to Times New Roman.

Centre-align ‘News of the Week’ and change its size to 26.

Add bullet points to: ‘A purple passionflower with spaghetti-like petals,
A monkey that purrs,
A fingernail sized frog.’

Make ‘Article by Doris Smith’ bold and italic.

Correct the three spelling mistakes.

Save the file using a suitable name.

3) Open the file called ‘Invitation1’.

a)

Format the text to make
it look as similar as you
can to this invitation.

Save the file using a
suitable name and close
the program.

Dave and Tania are getting hitched!

Dear friend
\We're getting married on Saturday 14th July and we'd love you to come and celsbrate with
us,
Love is in the air
Where: St John's in the Valley. Cumbria
When: One o'clock

We want our wedding to be a really fun and relaxed day. The wedding reception is going to
be in the church hall and we're going to have a bouncy castle and games to play ouiside.
There'll be & barbacue and plenty of booze to go around. We'd like gveryone to stay for the
evening and dance their socks off.

Dress Code: Please come in whatever you feel most comfortable wearing. If you want to
wear jeans. feel free.

Presents: We're going to Mauritius on our honeymoon. We'd be really gratefulif you could
coniribute to our honeymoon fund. If you'd prefer not to, our favourite things are:

1. Ornaments
2. Gifivouchers
3. Chocolates

Please let us know if you can come by emailing daveandtania@email.com

|

Section Four — Word Processing
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_Formatting Documents

1) Margins are gaps without text at the top, bottom and sides of the page.

2) To change their size, click the ‘Page Layout’ tab, then ‘Margins’.

3) Choose a different margin size by clicking on it. s, _ ”E{m 4 LJ = i1
4) Change the orientation by clicking the _%__f ‘1 s g s

'Page Layout’ tab, then this button. e3> oirion —

“‘ Landzcape

5) Change the size of your T _J Sen Roht
- = ] 1. | © 2amx 237 em Py arrow
page using the ‘Size L e i Choose the one J Lo Soon 1
button also on the i — you want by -
‘Page Layout’ tool bar. J Yook Extra clicking on it.

3048 cm x 4572 em

Ab
W05 am« 148 cm

1) Use headers and footers to add information to every page. For example, your n:

2) Headers appear at the top of the page and footers appear at the bottom.

3) To add them to the page, click these buttons on the ‘Insert’ tool bar:

_I.al 1o =

V= = ot
pzling « J{ Equatien , ;
42 Symbet -

4) Choose a style from the drop-down menu, then start typing. ..

5) When using styles with more than one text box, g
just click in the box you want to use and type.

1) To add page numbers to every page 12 4 A
click the ‘Page Number’ button on the P e | I cw o
‘Insert’ tool bar. 8 Topoipage i

=] Beitom of Page :
2) Choose where the number will appear ' ) Bsgetaigine ‘
. = . . = Zunent Pasition
and its style by clicking on an option.

7 Fommst Pags Humbeis.., Penn Nilikel 2

5 Remove Pags Humbsrs
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Click the ‘Page Borders’ button on the ‘Page Layout' tool bar and this box will appear:

| poden mgcsede ghimp

T Click these buttons to

TSR add or remove the sides of

: borders. For example, this
one changes the border

at the right-hand side.

Choose a border style by
clicking on an option. ==

Change the border g

colour here.

Chaﬂge the bOI’der’ s i s e cotumen 5-‘:;;;% ‘ Elrdke O wilkien you're
width here. T <Nl happy with the settings.

Click the ‘File’ tab, then click ‘Print’ (on the left hand side).

ClIC]( this once youfre W] Documentl - Micresoft Vord | = & ek

latings

happy with the Choose how many

choices below.

B

. Print =255 times the document
P = o will be printed.
- Print
Click this to choose —

~ Click this to
= change which
pages are printed.

your printer.

s BH-54L01cps on BH-FILE-0...

ntsr Fropenies

Settings
Click this to change ,
the orientation. . || Se&send

5 Prnt £l Pagas
T

You can also type

Print One Sided . i
¥ E - o | -Collsted o R o Wthh, pa.ges you Want |
This lets you L S EE to print into this box.
chaﬂge the size ) i j Porirait Onentation -
of the margins. - v

Click this to choose
. T s T :'" the size of your
Tb!s lets you s rashen . "~ || paper For example,
print multiple == —_ ‘ A4, A3, AS.
pages per sheet. : ]

a) Set the orientation to Portrait and the margins to Normal.

b) Add a border like this to the pages, with a thickness of 3 pt.

¢) Add a footer saying ‘14/07/14 - Be there or be square!’.

d) Print the document so that there are 2 pages per sheet of paper.

§ -5 SavsiEs s a:snitans e Smd doss i progrem.
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~__ Tables

2) Choose the size of your table by moving your mouse
and clicking when the right number of boxes are red.

= Page Bresk

Documentl - Micraseft Werd -

#ncsz  Hsihing:

Pigelofl ;@ Wadsd | D APl == % -

L=

3) To enter text, click in a box and start typing.

4) Change the size of the boxes by hovering over the lines until

Imzzrt Page La

i
£ el &
. j | oJ: 3

Table Fidture Clip
¥ At

In tables, rows g
across the page ar
columns go dowr

the <p symbol appears, then click and drag the lines left or right, up or down.

5) You can change how the text looks using the font buttons in ‘Home’ (see page 47).

6) You can also use the ‘Table Tools’ tab to make other changes.

It appears when you click on the table: B,

Click here i

to choose a
preset table | %
style. 1 S

1) Open the file called ‘Gym’.

Click this
change tF
box colou

Click this 1
change th
border outli

a) Insert a table under the ‘Current fees’ section. It should have column headings

‘Age Range’, ‘Cost per Month’ and ‘Contract Length’.

b) Fillin your table using the information from the ‘Current fees’ section.

c) Make the text in the heading boxes bold. Colour in the heading boxes.

d) Save the file using a suitable name.
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Mail Merge

1) Mail merge allows you automatically add data or information from somewhere else
into a word processing document.

2) It's used to create multiple documents where only a few details change each time.

3) For example, a company might want to send out the same letter to all its customers,
so just the names and addresses will need changing each time.

Strongman Gym has asked you to send a letter out to all its customers under
30 years old. You can use mail merge to change the names and addresses
document):

ostcode” Age
LA19 4KR

13 Griffin Lane Ambleside

35 River Road Bowness LA32 2HU
3 Stricklands Lane  |Ambleside  [LA32 4RD
Bean 14 Cooper Road Kendal LA303BL
Atkinson 2 Nixon Lane Kendal LA30 3BH
Grainger 14 Park Drive Bowness LA32 2HY
1) First write the le’_[ter, Ieaymg se n,3|ble () Gure) These-are called
markers for the information you'll merge. (o > Sratlars’
(Postcode) markers.
2) On the ‘Mailings’ tab, click the Rt
‘Select Recipients’ button, then click e e
& are writing to inform you that some of the terms
'U se Existi ng List’ - and conditions of your membership have changed.

Please read the enclosed leaflet explaining these
changes. If you require further information about these

3) Flnd and Se[ect the document Contalnlng changes please contact us on 0215 695 777.
the data you want and click ‘Open’. Bob Hollywood

Customer Service Manager

4) If using a spreadsheet, select the correct sheet and click 'OK".

5) Use the ‘Edit Recipient List’ button e lEE= Tt el
to choose which data to include in the [ =i & Swieie 25 Sy o
mail merge. You'll need to make sure  [ZFFF o G BN i e Y s

everyone over 30 years old is unticked. * i
6) Select each marker

and click ‘Insert
Merge Field’. Choose
the field you want to

«Title» «Surname»

«Address» . .
o «Town» 5 . == replace it with. Do
erge «Postcoden oo i . P
Felds lock @ 150 Sontember2013 _ this for each piece of
like this, Dear «Title» «Surname» _ data For examp[e’
| We are writing to inform you that some of the terms Tltle; Surﬂame, TOWn-

and conditions of your membership have changed.
Please read the enclosed leaflet explaining these 3 =
changes. If you require further information about these : 7) If YOU prlnt nOW, the
changes please contact us on 0215 695 777. 3 . .

printout will show the
Bob Hollywood

Customer Service Manager . merge fi EIdS s

;
<
sich | w2

Example continues...
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Example continued...

8) Check the right data from the spreadsheet

S | v Find Recipiznt
has been used by clicking ‘Preview Results’, ssa==9 o

9) When you're happy, click ‘Finish & Merge’ and your choice:

This lets you edit or save

oy
; s Finich &
each version of the letter. Merge

~ ] Edit Indlividusl Do

=% Print Documents.

2 . 2y Send E-mail Messages,..
This lets you send emails. el =

Here are the finished documents:

10)You can also use the Mail Merge 4 e

Wizard to help you do it step by step:

a)
b)

c) Print the merged letters.

2) Open the file called ‘Invoice’.

a) Use data from the file called ‘Data’ and mail merge to
produce invoices for only the customers who have paid.

b)  Print off these invoices.

cuments...

Dear

Bab Hollywood
Customar Sorvied
e

2 E-mail Lsssages
Start Mail, —
IMerge ~

Results| = Auto Checkfo

=

This lets you print all
= the different versions
of the letter.

Mr._ Atiinson
2 Nixon Lane
Kendal

LA30 38H

7" Seplember 2014

M, Alkinson

Vi are wriling to infg| V&
and conditions of yo
B

juons of ¥§ Please read the e/ |12
d the € changes 1f you req) Tges, jr
changes please ¢

51
] 2lion aboy,
- [
goﬂ duﬁmnm 215 695 7ir. e
us|
FDI"II Ssrvfca Mimagef

—  Enyzaiop
) Labels...
| Directory

@ Hormsl Waord Dacument

Al step by Step Mail Mergz Wizard...

1) Open the file called ‘Internet’. Use mail merge to personalise the letters.
Use "Sheet1’ of the file called ‘Accounts’ as your recipient list.

Replace the bracketed marker words with the appropriate merge fields.
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Inserting Graphics _

1) Graphics make documents look nicer. . neet | Pag“iy%?g Graphics can be

Sl pictures, images,

picture  Clip photos, maps,
| Art diagrams, logos..

2) Toadd a graphic to a word processor document ;‘
click the ‘Insert’ tab and then the ‘Picture’ button. « |

3) Abox will appear. Use this to find the graphic file you want to add:

‘maa-o I " Documentl - Microsolt Wiord =iErE T

o1 Fagelyom  Refmenga  Msiings

2 [Fp Bsmaa @ T
3 L
= Z ) () Insert Dicture %
: n, 2o :’:C e ¥ Loraries » p.w;, v I e AE & When yOU.IVE Found
) =- T e 2 the picture, select it
Use these : i <4 e by clicking on it.
a 5 9% Frvestes
links to go s
to different __ | ; n
areas of the : : E 2 Click here when you've
| — Saraple Pictures B RA Diew B 3
computer. 3 G chosen and the picture will
41 6 Herwerk
| appear by your cursor.
[Fageren  wedsd | |

4) You can also add graphics using the ‘Copy’ and ‘Paste’ buttons on the ‘Home'’ tool bar.

5) To get rid of a graphic, click on it and press ‘Delete’ or ‘Backspace’.

55

e ediciimiss

1) To resize a graphic, click on the light blue points around the sides and drag.
2) Use the corner circles to keep the graphic in proportion.
3) Using the squares on the edge will stretch and distort the graphic.

?k'm Click and drag to rotate.

Dragging the corners
is the best way to
resize images. '

&= Dragging the edges

can distort your graphics.
|V S

4) Graphics can be rotated by dragging the green handle above the image.
5) You can also use the :

: = , Click 'Rotate’,
‘Rotate’ button in the = = =

then click on

A ghauuesapdenv E‘ Ej e P LR - th t
‘Pi ) ] - < P - A Byt e option
Picture Tools’ tab. ‘ﬂ’ e AR T AT 2 ol 3 P V\F:ant
Click on the graphic ‘ P dll

to open this tab. we=s

L= Flip Vertical

Fiip Horisntsl:

| The picture has
7 been flipped
horizontally.

B) You can rotate and
flip graphics here too. -~
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1) Graphics can also be cropped — this means cutting the edges off them.

2) Click on the graphic to bring up the ‘Picture Tools’ tab, then click Cropr’fzm}_ﬁ

Zrap

3) Drag the black handles around to select an area.

4) Press the ‘Crop’ button again to cut the graphic down.

Example

Crop the graphic so that the image is mainly of the cow.

Deocumentl - Microsoft Word I'.—‘-

PFags Lazout Fa

Click and
drag these
handles.

L
Background -

» A

The dark
area will be
cut off.

1) If the graphic is added into some text, you can change how the text wraps arounc
2) Click the 'Wrap Text’ button in the ‘Picture Tools’ tool bar.

3) Choose a wrapping style from the drop down menu:

W o = Covw:

Use this button —
to change where

e - Micreseft Ward

= & jreiiben]

These four opt
change how the
wraps around

the graphic is ‘ graphic.
on the page. Cows Fall through Roof of Artisi
An artist narrowly avoided injury when a pair of cows| %
TO move the - The cows fell through the skyligh
h- t = Cornwall after breaking through |
grapnic to a overlooking the building. Both co

different position,
use this button
again, or use

'Cut' and 'Paste!,

or click and drag.

= unharmed,

| The cows had to be herded out of building by the artist and
a neighbour,

Fortunately. most of the artist's work was sold a few days before the accident. so
none of it was damaged.

Article by Jim Crosby

Section Four — Word Processing
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put the grap
in front of ¢

behind the te
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4y On the ‘Insert’ tab, click ‘Text Box’. "™

)
Text
2) Choose a style, or draw your own by clicking ‘Draw Text Box’. ox~
)
)

3) Click on the page and drag to the correct size.

4) Start typing to enter text.

Change how the An artist narrowly avoided injury when a pair of cows fell through her roof.
text looks by using
the font buttons on
the 'Home' tool bar

(see page 47).

s The cows fell through the skylight of the workshop in
Cornwall after breaking through the fence of a field
overlooking the building. Both cows were said to be
unharmed.

s —ws 2 The cows had to be herded out of building by the artist and
The culprit ighbour.
You can change =59 L L
how the text wraps Fortunately, most of the artist's work was sold a few days before the accident, so

araund this boxton none of it was damaged.

(see previous page). Article by Jim Crosby

5) To remove the outline of the box, click on it, then click ‘Drawing Tools’,
then ‘Shape Outline’ and ‘No Outline’.

1) Some word processors have built-in image galleries, often called clip art galleries.

)

2) You can also buy image galleries or use ones on the internet.

3) In Microsoft® Word?®, click the ‘Insert’ tab, then the ‘Clip Art’ button.
)

4) A panel will open at the right hand side of the screen:

new T Documentl - Microzct Word 1= & B

Type the keywords you want to
search for in here, then click go.

This lets you choose the
=== type of image you want.
For example, illustrations

When you find a
graphic you like,
double-click on it. »
Or click and drag it | . | ==z SCroll up and
on to the page. 1 "" down to see the
|

w. different images.

(cartoons) or photographs.
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1) In the test you could be asked to make something with both text and graphics.
For example, posters, leaflets, invitations, receipts, newsletters, flyers or lette,

2) You can use a word Processor program to make these things.

3) Use the skills you've learned from this section to edit and format the document so |
contains the right information and looks nice.

* Read the questions carefully and follow the instructions given.
* Check your spelling before printing or saving any documents.

* Think about the documents purpose. For example, a poster is
used to advertise something, but a leaflet gives more information.
Both need to be attractive but the poster should be easier and
quicker to read.

*Think about the document’s audience. For example, a letter to
a customer should be formal and professional looking.
A poster for children should be informal, bright and cheerful.

1) Use different fonts to make things stand out.
2) But don’t use more than three fonts in one document — it will look messy.

3) Use fonts that are easy to read and suitable for the document.

Times New Roman and Arial are good for formal documents.
Comic Sans and Berlin Sans are nice, friendly fonts.

4) Use different font sizes to make things stand out. For example, titles.
5) Make sure you use a font size that’s big enough to read easily.

6) Bold, italics and underlining can also be used to make things stand out,
Don't use them too much or it will look untidy.

7) Graphics make things look more interesting.
8) Maps or tables can make information easier to understand.
9) Colour will make a document look nicer, but don’t use too much.

10)Try using borders, different text alignments or bullets and numbered lists too. _J
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Formal documents:

l 1) Use fewer and more plain colours.

2) Use fewer font styles and more serious-looking fonts.
I 3) Use some formatting, but it is usually kept neat and simple.
.

Informal documents:

Often use photos instead of clip art or cartoons.

1) Use more and brighter colours.

2) Use more interesting font styles.

3) Might include clip art or cartoon graphics, as well as photos.

1) Don’t add too much detail to posters — the main points should be easy to find.
2) They need to be attractive, so use colours and graphics.

3) The text needs to be easy to read from a distance.

Important information Make the important

e \Whizzbang Fireworks

; ___information stand
= ear e oy SPECIAL OFFER <oz o loured
as people naturally '
read here first. Egp For one week only, we are reducing the price of our bold or ’arge text.
example, titles and fireworks by 50%. &g
company names. .
& Type Was - ;
y ;’f Skyrocket £9.99 USQ {Orﬁt Styles that dont
Use a font size © Da Bomb £11.99 clash with each other.
Lion's Roar £19.99
between 18 and 24. 2309 Fonts don't need to be
the same all the way
Make the most of your Bonfire Night. 'tff}rough. JOur POSter’ but
Graphics should —— it helps if they look good
fit the purpose of o together.

the poster.

R

Arrange the information
so there are evenly

Posters often have o sized white gaps at the

contact information % Whizzbang Fireworks, 5 Lord Street,

Bt bofkem: Enicsiater, FIOSUR sides ~and between the
different parts.

Qartinn CAnw VATt Py s o




Leaflets and newsletters usually have more detail and information than posters.

Example

Choose suitable font sizes for text and Make =ke qry graphics
headings. Try 18-24 for headings and are 5.u5tab|e for ’.che
12-14 for text. R section tbey re in.

Break text up into
clear, useful sections.

Why Visit Mifton Movie Museum?

About the museum

= Discover the history of cinema with our hands-on exhibit. Based on the site of an old film
Visit our "Way Out West’ display which features props studio, the Mifton Film Museum
and costumes from lots of famous westerns. has been welcoming visitors for
Pose with lifelike waxworks of some of the most famous over 25 years. There’s plenty to see
actors and actresses of all time on our very own red carpet. and do, so come and join us for a
Watch a classic movie in our cinema every day at 2 pm, great day out for the whole family!
Facilities Opening times: Mon-Sun 9am - 5pm

The Director’s Cut Café sells a range of food between 10 am
and 4 pm every day. If you'd prefer to bring your own lunch,
there are picnic tables both inside and outside for you to use.
The museum is fully wheelchair accessible. Visit our website
www MiftonFilmMuyseum co uk and get 20% off your booking.

Admission: Adults £6
Students  £4
Children £3

Where to find us

Movie Showings 1. From Mifton Town Hall, drive

North down Victoria Road.
2. Turnright onto Bodden Lane,

___ThePhantomofthe D

Monday pera then i i !
e e UL L T ght at the roundabout. 12
Tuesday Casablanca temvar %
“Wednesday  Singin’intheRain 3. Follow Church Street faf 300 e iﬂ.‘:.
Thursday ContwiththeVhing + yards — the museum will be g
Friday \  TheGreatEscape é P Seurce: wwimmoviem. 20.uk
E & é
Lay out information Make sure the information Make sure sources are
clearly — use tables or is evenly spaced without shown when needed.
bullet points. too much white space.

Letters are usually formal, so they use fonts like Arial and Times New Roman.
Use simple formatting and few colours (most things should be in black).

Example

Letters often have the Phones ‘R’ Us

Blackwood Road,
address of the person preston, <,

; ; ' PR2 3BR ~ The sender's
they're being sent to here. dd
. ; Mr Wilson addaress can
But sometimes the sender's 3 Vhorrow Larie alst 48 b
: Stalmine ’
ress ut here,
add Bp FY7 38T
7" September 2014
g \ . s
They can have = 7 _ Dearmr. wiison, Use "Yours sincerely' if
the date on them. | Please read the enclosed leaflet explaining your new you are Sending it to
phone tariff. If you require more information please someone in particufar
£ contact us on 0325 695 616. :

Start with Dear ‘name), Use "Yours faithfully’ if it's

just '‘Dear Sir or Madam'

Yours sincerely, <&
James Dune
Customer Services
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? 1) Create a poster to advertise the opening event for a new shop called ‘Green Home'.

a) Use the text from the file called ‘Poster’.

b) Choose one graphic to include from the file called ‘Poster’.
Insert it into a suitable place on your poster.

c) Format the layout of the poster so that it looks nice and is suitable for purpose.
Think about: font size, font style, colour, bullet points, borders, text alignment
or any other type of formatting.

d) Save the file with a suitable name.

2) Create a landscape A4 poster to advertise swimming lessons for children at
Mifton Leisure Centre. Use the plan below:

[ Title |

Use the text from

Use a suitable graphic
from the Internet here.

| For ages 6-10 |

& % Image ]

| Every Saturday at 4pm l the file called
Add a border E L Other text 'Swimming'.
to the poster. l Only £10 a session |
Use the map

| Address

= from the file called
Map |& ‘Swimming'.

“l 6 Bodden Lane,
Mifton,

Cumbria,

LAS 7TMFE

ontact Details

To book a place, call 077601931126 or fill in
the form online at www.MiftonLeisure.com/swim

Format the poster so that it is attractive, accurate and suitable for the audience.
Print out the poster when you've finished.

3) Create a leaflet advertising the Ram and Goat's Sunday Lunch.
Your leaflet must contain:

a) The text from page one of the file called ‘Pub’.

B)  Graphics and text from page two of the file called ‘Pub’.
(Follow the instructions on page two.)

C) Format your leaflet so that it is attractive, accurate and suitable for the audience.

d) Save the file using a suitable name.

Section Four — Word Processing




64 Section Five — Spreadsheets

1) Spreadsheets hold lots of data and are useful for doing calculations.

2) Microsoft® Excel®is a common (3 iESach Bl 00
spreadsheet program and the one used here. L—‘

3) Each of the little boxes on a spreadsheet is called a cell.

4) Cells make up rows (lines across the page) and columns (lines down the page).

Example

Tool bar — lots of
useful buttons are
F found here.

:rhese tabs bring up different
" toolbars when clicked.

[[ﬂ HY~=-is Example - Microsoft Excel

The selected cell y fg:_Formu(a bar.

. Calibri 11 s . i
is A2 — you = w A3
can see this here. B o IXI ) ‘A Alignment Mumber Styles  Cells E_‘ # To select a
v b-oA- - - v LA .2 whole row or
Fon _ 7+ Editing Oi | k
- = e = _, column, clic on
il T, _ f Year I g
[ a | B = E gz~ the grey cell in
The selected e S T : the header b
2 S.E ECLe A 1 Total revenues, costs and profits by year [ < Neager bar.
cell is also == Year Total Revenue Total Costs Profit :
h by i [ > ez Columns
snown y Its 3 2004 44,230 40,650 3,580 1 B
thick border. a 2005 46,360 38,540 7,820 are |abelled
5 2006 43,510 45,540 -2,030 with letters.
Rows are 6 2007 50,180 35,200 14,980
labelled with === Row,

numbers, s

Ay ST [ s s o e s
M (r M Sheetl Shest2 Sheet3 ©J3 14| il | ]
Ready | g (EE D e O — B

—

& g
Click to open different worksheets. Column,

To enter data, click on a cell and start typing.

)

2) To edit a cell's contents, click in the formula bar and make your change in the box.
)
)

3) Spreadsheets should have a title in the first row to explain what the data shows.
4) Each column should also be labelled in the second row. Some exam boards
. . _ .. ask you to put your
5) Extra information can go in a header (at the top of the sheet) E ame.as atonter o
or footer (at the bottom). These only appear when you print. every printout.

Click the ‘Insert’ tab and the ‘Header & Footer’ button to add them.

6) To select more than one cell, click on one cell and

drag the cursor over all the cells you want to select. _H:adfr
o Footer

Section Five — Spreadsheets
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| &1

1) Sometimes you might need to import data into a spreadsheet from another file.

importing Data

2) This might be from a text file with the file extension “.txt’.

3) The data that goes into each cell will be separated somehow, often by commas.

Import the revenue data from the ‘Revenue’ text file into a spreadsheet.

1) Open a new spreadsheet and click the ‘From Text’ button on the ‘Data’ tab.

2) Use the window that pops up to find the text file you want to import.
When you find it, select it and click ‘Import’.

3) The data is separated by commas, (Drevere Noteped (=18 X )
so in the box that pops up File Edit_Format View Help
s 2 Year, Total Revenue, Total Costs P
(Text Import Wizard window step 1) make |2004] 24 230, 40 650 .

2005, 46 360, 38 540

sure ‘Delimited’ is selected and click ‘Next’. |[235¢: 43 210. 43 540

4) In step 2, select ‘Comma’ and click ‘Next’. T e

< P

5) In step 3, select ‘General’ and click ‘Finish’.

6) Finally, click on the cell in the spreadsheet where you want the
top left cell of the imported data to go and click ‘OK’.

: ] S
4} A ' B i € ! A comma in the text file indicates a
1 [Year Total Revenue 'Total Costs ﬁ : :
B i 1595 40650 | new cell in the row in the spreadsheet.
3 2005 46360 138540 ; :

":1_“5065}-_3’55_677 "7”7:33757470' «m Different rows in the text file mean

5 2007 50180 35200 different rows in the spreadsheet.

1) You can adjust the row height or column v
width so your data fits neatly in the cells. g teme e B

1 b artal

. . = B3 Copy - .

2) Hover over the leldmg !_lne on the grey column 5 g romatrante | B 7
or row header bar until this symbol appears., cipboars s

3) Double-click and the cell size will
automatically change to fit your data.

4) Or click and drag left or right, or up or down until the cell is the right size.

5) You need to make sure all the data fits neatly into the cells before you print.

[ il
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1) To add a column, select the entire column to
the right of where you want to add the new one.

2) Click the ‘Insert’ button on the ‘Home’ tab.

3) Toadd a row, select the entire row below e
where you want the new row and click ‘Insert’.

4) To delete a column or row, select the
entire one and click the ‘Delete’ button. -

5) You can also add or delete them by right-clicking
on a cell and selecting ‘Insert...’ or ‘Delete...".

1) Use these buttons on the ‘Home’ O, Home Inse

tab to cut, copy and paste. — v..u cut
2) Select the text, cell or entire row or ‘_*j =3 Copy ~
column you want to copy, then click ‘Copy’. Fagt J Format Painter
3) Move the cursor to where you e kliBBONT S

want to put it, then press ‘Paste’.

4) ‘Cut’ works the Same way as ‘Copy’, but it also deletes the original selection.

5) Use these buttons to Copy and paste in data from other documents too.

Example - Microsoft Excel

Page Layaut Farmulas Dats

Label your
columns so that
it's clear what
the data showi.

B,

Fmber Styles Cells 5
- - - i

Angle Counterclochwise . fEditing

. et SO Angle Clociwise
B c 1§ Vertical Text

. T.Otal revenueé, cbsts ar &l Rotste Text Up
L ear Total Reveny 15 Rotate Test Dow
g 2004 18 B cAAGni<N) Ny
T 2005 46,360 38,540
This text g 2006 43,510 45,540
. o=
has been = = 2@07 50,180 35,200
rotated up. || Ty sheets il 2T W | U e e B
Ready | 5 Er=

Rows éan have labels too.

Section Five — Spreadsheets

Click the

<% ‘orientation’
button (397)
to rotate text.

Choose which
way you want
L to rotate the
text by clicking
on one of these
options.
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1) Make sure you are sitting correctly at your desk and |
turn on your computer. Open the file called ‘Gino’. | it

a) Write your name in cell A1. Adjust the width so it displays correctly.

b)  Goto cell C5 and change 2.75 to 2.00.

d

c) In row 6, change ‘Orange juice’ to ‘Apple juice’ in the ‘Drink’ column.
)

Save the file using a suitable name.

2) Open the file called ‘Luxury’.

a) Insert a new column to the left of the column for ‘Hotel Costs (£)'.
Name this new column ‘Restaurant Costs (£)' and make it display correctly.

b)  Rotate the text ‘Costs per year’ up.

c) Add a footer and write your name in it.
d) Delete the row that contains the cell named ‘Gas’.

e) Insert the following information in the ‘Restaurant Costs’ column:

Electricity 2739.45
Water 1695.12
Council Tax | 2075
Wages 58625.21
f) Save the file using a suitable name and close the program.

3) Open a new spreadsheet file.

a) Import the data from the text file ‘Letting’ into your spreadsheet.

b)  Delete column D and insert a new column with the following data in it.

12 Beville Street

c) Make sure all the data is clear and easy to read.

d)  Save the file using a suitable na

Sme

me and close the program.




= [T

To do this, select the cell then use these font buttons on the ‘Home’ tab:
Click this then choose from the list

to change the font (style of the text).
E.g. Arial or Times New Roman

g
N

Arial -

Click this to change the Size
of the text. The larger the
" number, the larger the size.

10~ A A7

_= Click this to change
B A Y -

This makes the the colour of the text.

- v

text bold. ‘”@
ﬁ % ant & &z\ Click this to change the

This makes the text Jtahc
(slanted a bit to the right).

I f II' back d.
This underllnes colour of the cell backgroun

Border button.
the text.

To give a cell a border, select a cell then click the ‘Border’ button on the ‘Home' tab.

Click on the arrow to choose what type of border you want.

3) You can change the border of several cells at a time by f‘j“’;; - ;
selecting them all and choosing the border you want. - ':"’*“Z"‘ :””’“ |
i1 TopBorder i
4) Gridlines are the grey outlines around the cells. [ LeftBorder '
“i| Right Border
5) To turn them on and off, go to the ‘Page Layout’ tab and tick

or untick the ‘Print’ and ‘View' boxes in the ‘Gridlines’ section.

1) Merging cells means joining a number of cells into a single cell.
2) Select all the cells you want to merge and then click the ‘Merge & Center’ button.
3) To unmerge the cells, select the merged cell and click the button again.
Example
P Then click on the Merge &Center button (E).
+ = Bookl - Microsoft EX. EI L= | B |etlm
& H;:wmé Insert Page Layout FOTUI?,S, §t§ Review Via}u &@m = 23
l‘?elect the . Arial - = ' w A E E° ’grv |
CElS you ‘war B £ ’g N AA A ) jumber styles  cells These six
to merge. = A - T i R, T - = buttons
% Font z Signment = - B thf
o £ | Sandwiches sold in one week ] e il C_hange f
5 I C ) E : alignment 0
Sandwiches soldinoneweek 4 the text.
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1) You can change the way numbers appear in a cell.

2) For example, you can change numbers into currency format
so they have a ‘€’ sign and two decimal places.

3) Select the cell or cells you want to format and
use these buttons on the ‘Home’ tab:

Shows you what Click the arrow to change the format.
the formatting is for =

%Generai » &= Choose the type of formatting from the
the cell selected.

drop-down menu. For example, currency.

T . -0 .0
AN B

)
!ﬁu mber \ \

Changes the Fo.rmat Click T’were to add decimal p!lacdes.l Ea}chlcﬁck
to a percentage. removes | decimal place.

Click on this to remove

decimal places. Each click
adds 1 decimal place.

4) If you're asked in an exam to format the spreadsheet and
make information clear and easy to read it usually means:

+ Format the cells so currency, number or other formats are used.
* Adjust the column and row size so everything can be read easily (see p. 65).

* Make important information stand out (see p. 68).

These are the most common types of formatting you will need:

1) Number — For normal numerical data. For example, the number
of cars sold. You can change the number of decimal places in this format.
For example, if you choose 1 decimal place and type 5 it will turn into 5.0.

2) Currency — For when the data is money or prices. |t adds a £ and
two decimal places. For example, if you type 3.5 it will turn into £3.50.

3) Date — Lets you choose a format for a date.
For example, you can choose 14/03/2014 or 14 March 2014.

Percentage — Multiplies the cell value by 100 and adds a % symbol.
For example, if you type 0.1 it will become 10%.

Section Five — Spreadsheets




To print your spreadsheet click on the ‘File’ tab and click ‘Print’ (on the left-hand side).

Click on this to choose what
from the spreadsheet to print. s,
'Print Active Sheets' will print
the whole spreadsheet.
Print Selection’ will only print
the cells you've got selected.

Click on this to choose
between 'Portrait’ and
‘Landscape’ orientation. .-
Spreadsheets with lots of
columns will often look nicer
printed in landscape.

e Click this to print.

This 'Print Preview' shows

[ e What will actually come

out the printer,

= If not all of your
" spreadsheet is showing,
click here and choose 'Fit
Sheet on One Page'

1) Open the file called ‘Bridgeshire’.

a) Write your name in cell C10.

b) Merge cells B1 and C1 so the title is in a single cell.

c) Colour the merged cell yellow and bold the text to make it stand out.

d) Colour the cells B3 to B6 pale blue.

e)  Add a border around all the whole spreadsheet,

f) Format cells C3 to C6 so that they are 'currency’ cells and have two decimal places.

Q) Print the spreadsheet out, with all the data showing clearly, in Landscape orientation.

2) Open the file called ‘Leekton’.

a Merge cells B1-F1 and format them so that the title stands out.

o

Format the price data on the spreadsheet correctly

Q

) Make sure the spreadsheet is clear and easy to read.
)

d Save the file using a suitable name.
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Formulas

_Formulas are Used to do Calculations

1) You can make a spreadsheet do maths by adding in formulas.

2) Click the cell where the answer will go and type the formula into the formula bar.

3) All formulas start with an = sign.

4) Use cell letter and number references to tell the
spreadsheet which cells to use. For example, B4 or C9.

5) Use these signs to complete the formulas:

+ to add together numbers ra— If you type =B4+B5, then the spreadsheet will
9 add the number in B4 to the number in B5.

- to subtract numbers
/ to divide numbers .

If you type =B4*B5, then the spreadsheet will
* to multiply numbers /mulﬂpb’ the number in B4 by the number in BS5,

6) When you've typed in the formula, press return
and the answer will appear in the cell.

. r%'l—he formula bar
[ b2 ~ (= £ =B2°C2
D

shows you what

calt SRR RE e e formula is i ell
1 Item  NumberSold Price Money Made mula is in a cell.
[2 [Coffee | 40, £140 £56.00%
3 [Tea 32 £1.40] <
A ;bﬁgﬁgm@* T ) A— = Money Made is Number Sold
e Cake ‘:Tf::??f‘_lf%f@gif:—ff, multiplied by Price, so the
iscui 1 0.80 ;
oBealt |7 %080 ] formula for D2 is =B2*C2.

7) Remember to put the answer cell in a sensible place.
Just to the right or underneath the cells used is often the best place.

1) Select the cell with the formula in, then copy and paste it into another cell.

Copying Formulas

2) Or click on the cell and hover over the bottom right corner until
you see this appear + Then click and drag over the other cells.

3) The spreadsheet will automatically change the cell references in the formula.

D2 > (- £ =B2'C2 L13 ¢ A

[ ] B ErcaE o ' A ] B EcE Do
1 Item . Number Sold Price Money Made. ; 1. ltem  NumberSold Price Money Made
; ) Ll Click and drag. 1. | e nOneynaae,
L2 Coffee ‘ 40 £1.40]  £56.00] .2 [Coffee 40, £1.40 £66.00
3 Tea i 32 a0 % fﬁ“‘?ﬁ"“““"‘,—'“ 32 E£140  £44 50
4 Orangeuice 2  £200 _4 Orange Juice £52.00
.25 f100 .5 Cake | 25 g 25.0C

% %080 S Biscut 17 £080  £1360

Cell D2 was =B2*C2 and now

cell D3 is =B3*C3 and so on.

Section Five — Spreadsheets



72

1) Afunction is a formula which comes already set up in a spreadsheet program.
(Sum is a function. AutoSum is a group of functions grouped together.)

2) To quickly add together lots of cells, use the ‘AutoSum’ button. _ AutoSum button.

y TE g z .E-LrénSum =

4) Press the ‘AutoSum’ button e osere Famat S
on the ‘Home' toolbar. - B

Cells Edit

3) Select the cell you want the answer in.

5) The cells being added together e T T 0 T % The selected cells
will be automatically selected. Price  pacney Made are shown by blue
- - oSS . 7 hf_
6) If you need to change the cells selected, ;;32 highlighting
hover over the corner of the blue highlighting 5;33
and when / appears, click and drag. o |=sum-%' ¥l
7) If they're the cells you want to add, *
press ‘Return’ and the answer will appear. The answer cell.
8) You can also type the AutoSum
formula directly into a cell yourself: =SUM(U2:U6)
Cell to start on. & “ Cell to finish on.

1) You'll need to use brackets when a calculation has more than one step.

2) The brackets tell the program which step comes first.

Example

Add a formula to work out the average number of jobs per month.
The average is the total number of jobs divided by the number of months.

1) This calculation has two steps so we need brackets.
2) The first step is finding the total number of jobs. This is (B2+C2+D2+E2).

3) The second step is dividing by the number of months, which is 4.
So the formula we need is =(B2+C2+D2+E2)/4.

You can also use the . F2 v~ J | =(B2+C2+D2+E2)/4 )
Average function — ! A B c D E | F
see page 74 % January  February March April Average
_2 Mumber of Jobs 10 14 8 17 12.25)
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1) In the exam you might be asked to print a spreadsheet with the formulas showing.

2) Select the ‘Formulas’ tab and then click ‘Show Formulas'.

Adjust the column

" widths to make sure

the formulas show

properly (see p 65).

Fa ™ B Rl i Formula_Example - Microsoft Excgl
i Fi S5 Home Tnsert Page Layout Formulas Data Revigw Visw
g s ] @ & = sl = Z3l O Define Hame - e Trace Precedents 'S Show Formulas |
ALV EIE R Srincnccoms Frmram
JL z i &2 _‘j [g lh= L:.J = LTI =1fTiace Dependents %1 Error Checkang -
Insert AutoSum Recently Finanoal Logical Tedt Date & lookup & Math Kiore Meme ¥
Function - Used - - - - Time- Reference - &Tng - Fundlions~ IManager B Create from Selection 7, Remove Arrows - & Evaluate Farmula
Fu-\d:in Library e Defned Ha{qi_ . _F_gmu:a Auditing _—
| R SR, - B
T ST : c . - D o
1 Item Number Sold Price Money Made
2 Cofiee 40 14 =B2C2
3 Tea 32 14 =B3'C3
4 Orange Juice 26 2 =B4"C4
5 Cake 25 1 =B5"C5
6 Biscuit 17 08 =B6"C6
7 =SUM(D2:D6)
"

3) Instead of the data you calculated, the formulas show in the cells.

4) If you print the spreadsheet now, these formulas will print out.

5) To get the data to show (and print) again, click on ‘Show Formulas’ again.

) Open the file called ‘Wash’.

a) Find the total number of cars washed over the week
by entering the formula =SUM(B2:B8) into cell B9.
b) Enter a suitable formula into cell D2 to find the money made by the car
wash on Monday. [Money made = number of cars washed x price].
c) Copy the formula from cell D2 into all the cells down to and including D8.
d) Enter a suitable formula into cell D9 to calculate
the total money made by the car wash over the week.
e) Save the file using a suitable name.

Open the file called ‘Loan’.

a Use a formula to work out the amount still owed by each customer.

b) Use a formula to work out the totals for each column.

c) Make the name of the customer who owes the most stand out.

d) Produce a printout of the finished spreadsheet with the formulas showing.
f) Save the file using a suitable name.
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Use the Min and Max functions to find the lowest or highest numbers in a group.

Use a formula to find out the minimum and
maximum money made by the sales team.

1) Select the cell where you want the minimum or maximum
number to appear. Here cells D9 and D10 are sensible.

2) Click the arrow next to ‘AutoSum’ and pick ‘Min’ or ‘Max' from the list.
3) Make sure all the cells you're interested in are selected. Here it's D3 to D8.

4) Press ‘Return’ and the answer should appear.

“Tow_ - A cWA008
Si7 T S D S e T |

1 g ~ Sales Team Performance

2 FirstMame LastMame  Humber of Cars Sold Honey Made
3 Jimmy Kowalski 10 £39,000

4 [Ea ey T Eel Cell D9 now shows the
5 Deepak Gupta 5 £49.000

6 Honika Kowalski 12 £2.500 . lowest number from cells
7 Ewan Souter 9 £44 900 &

8 Jessie Goldman n £53.600 D3 to D8 and cell D10
9 Rinimum £36.200 shows the highest number.
105 Maximum I ESBEGQ_I

5) You can also type the formulas directly into a cell.
For example ‘=MAX(D3:D8)’ or ‘=MIN(D3:D8)'.

1) There is a function to calculate the average from a set of numbers.
2) Click the arrow next to the ‘AutoSum’ button and choose ‘Average’.
3) Make sure all the cells you're interested in are selected. (Below it's D3 to D8.)

4) Press ‘Return’ and the answer should appear.

D9 v - CAVERAGEDIDY)

~% 1. B 1 ___€E___ 1 0. |
1 Sales Team Performance
2 FirstName Last Hame Humber of Cars Sold Money Made
3 JEimmy Kowalski 10 £39,000 Cell D9 now shows the
4 Eliza Henry 7 £36.200
5 Deepak Gupta g 45 000 average of cells D3 to 8.
6 Wonika Kowalski 12 £52.500 &
7 Ewan Souter g £44.900
8§ Jessie Goldman 14 £53.600
9] Average [ £45,667_|

5) You can also type the formula directly into a cell. For example ‘=AVERAGE(D3:D8)’.
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T

1) The median is the middle number when a
group of numbers are put in order of size.

_ Median and Mode

Insert Function

Search for a function:
[ Type & brief description of what you want to do and then cick o g
L ! G

Or select 2 catagory: | Statistical
| Selecta function:
|| [vEDIAN <[
oM i

2) The mode is the most common number in a group.

| |mopemnr __ —

3) Click the arrow next to the ‘AutoSum’
button and choose ‘More Functions'.

NEGBINDM DEI‘

|
i Moni.sum.(nmnbers,numberz-) ;
| Retumns the most frequently ocourring, o repetitive, value in an aray or range of |- } {
data.
|
i

4) This box will appear: mmm———

5) Select the category ‘Statistical’ and choose Hmmmm -E

‘MEDIAN’ or ‘MODE.SNGL’ from the menu.

6) Another box will appear asking you to enter the cells you want to use.
Select the cells you want to use and press ‘OK’.

7) You can also type the formulas directly into a cell.
For example =MEDIAN(B3:J3)’ or ‘=MODE.SNGL(B3:J3)'.

_ Absolute or Relative Cell References 2]

Gl S T bl BT s e

1) Spreadsheets will automatically change cell references when formulas are copied.
2) This is called relative cell referencing. You can make just a column or
row absolute. Only put the dollar
sign in front of that part. For
example, $AT would keep column

3) Sometimes you don’t want this to happen though,
so you need to use absolute cell referencing.

4) Put a dollar sign before the letter and number of the A absolute but the row relative.
cell reference you don't want to change. For example, $A$1.

The manager offered a special discount of £25.00 off each bill. 1
Add a formula to cells C3 to C8 to show the new bill. i i

: : w'{‘he discount is the same for every
C3 v (,.,_. £ —aa«sass

room number. So use an absolute
cell reference — B9 would be
typed in as $B$9 in the formula.

Bill __ NewBill

_i_l,,f~ 3 ._..Eﬂ_@-m!

4 £ 80.00'£ 55.00
08 2LE 165 00 £ 14000

g - gg E — 133 gg f: —— :;143 gg When you copy the formula into the
8 g4 £ 200.00 £ 175.00 other cells the B9 reference will stay put.
9 Discount £ 2800 For example, C4 will be =B4-$B$9.
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Some functions use relational operators:

Examples

= means equal to.

< means less than. 1) 3<7 means 3 is less than 7.

> means greater than. 2) 10>5 means 10 is greater than 5.

3) z<=23 means z is less than or

<=
means less than or equal to. equal to 23.

>= means greater than or equal to.

1) The IF function is used to show if a statement is true or false.

2) If the statement is true, you can make one thing appear in a cell.

) If it's false, you can make something else appear.

4) What you make appear could be words, numbers or another calculation.
)

5) An IF formula is laid out like this:
=|F (‘statement’,'what happens if true’,what happens if false’).

6) If what appears is words then they have to
have quotation marks around them, like “YES”.

7) There should be commas between the statement, what
happens if true and what happens if false, but no spaces.

Example

Sophie has been testing new coffee beans in her shop. If a type of
bean got 50 or more votes, she'd like ‘YES'’ to appear in Column D.

1) Select cell D3 to type the formula in. s |f the statement is

false, ‘NO" should
2) The formula should be =lF(BS>=50,"YES”,"NO”). appear in the cell

The statement is 'The value of cell £ y |f the statement is true, "YES'
B3 is greater than or equal to 50" " should appear in the cell.

3) Copy the formula into every cell in Column D.

D3 v =IF(B3>=50YES"'NO") When there are 49 or less
A B C D 1 E __# votes in Column B, the

word No will appear.

4 Ethiopian Sidamo

5 French Mission 32 === \When there are 50 or
6 Hawaiian Kona 50 :

7 Hundo Nova 29 mare votes in Column B,
8 Sumatran &3 the word YES will appear.

Section Five — Spreadsheets




77

1) You can use AND, OR and NOT as part of an IF function too.

AND — If the statement has two parts that both need to be trye.
OR — If the statement has two parts but only one needs to be true.

NOT — When you need to show if something isn’t true.

Example

Sophie now wants ‘YES’ to appear in Column D only if the type of bean
got 50 or more votes and the price is less than or equal to £0.18.

1) The formula should be =IF(AND(B3>=50,C3<=0.18),"YES",'NO").

2) 'AND(B3>=50,C3<=0.18)' means ‘B3 is greater than 4
or equal to 50 and C3 is less than or equal to 0.18’,

_ D8 -k -IFANDB3=50.C3<0.10)VES' WO
A B € T D T E ¥
Brew Ha Ha Coffe hop New Beans Test

i)
_2  Coffee Brand Votes | Price (£) TR

_3 Blue Mountain 17 0.12JNO 1
4 Ethiopian Sidamo 56 0.09 YES
5 French Mission 32 0.13 NO
B Hawaiian Kona 50 0.16 YES
7 Mundo Nova 29 0.05 NO
& Sumatran 63 02 NO

2) You'd use the OR or NOT function in a similar way.

3) For example, using =IF(OR(B3>=50,C3<=O.12),”YES”,"NO”) would give ‘'YES' if B3
was greater than or equal to 50 or if C3 was less than or equal to 0.12.

) Open the file called ‘Phones’.

a) Find the minimum, maximum and average of the data provided.

b) Save the file using a suitable name.

Open the file called ‘Holidays’.
a) Use absolute referencing to fill in the ‘Hours Left column.

b) For any employees with 7.5 or more hours left make the word “Yes’
appear in the ‘Days Left’ column. For others, make ‘No’ appear.

c) Produce a printout of the finished spreadsheet with the formulas showing.

e S

d)  Save the file using a suitable name.

Section Five
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1) You can sort data so it's in ascending or descending order.
2) Ascending means numbers go smallest to largest or words go alphabetically A-Z.

3) Descending means numbers go largest to smallest or words go alphabetically Z-A.

Exal‘l‘_lple AutaSum 'A?] — & Fi
1) Select the data you want to sort, LS ) s O";utton' et
but not any title or header cells. Lolear - [Fitter» select '

ﬁl Saort Smallestto Lar-geit@%ﬁ_ Ascendin :
2) Click the ‘Sort & Filter’ button inthe &1 sert targesto smates ?

£ ' * o1 Custem Sert.. | =
Home' tab and select how to sort it. m \ | Diaseonifing.

& Eilter
A pop-up box will appear: «. i
3) Apop-up PP = L Custom Sort
e (see below).
. [ ; 19 = |
Click here to expand Sot Warning ? =
the selection to % e Ty S Yt Click here to only
include the data n Nmsldavoummmdn? s “sort the cells you
10 Expand the saisction T
other columns too. o B BN AT had selected.
[ ot || cancal 1
Sales Team Performance Sales Team Performance
First Mame LastName  Number of Cars Sold iMoney [Made First Mame Last Mame  Humber of Cars Sold Money Made
Deepak Gupta ] £49 000 Jimmy Kawalski 4 £39.000
Eliza Henry 7 £36.200 Eliza Henry 7 £36.200
Ewan Souter 9 £44 500 Deepak Gupta ] £49 000
Jimmy Kowalski 10 £39.000 Monika Kowalski 10 £62 500
Monika Kowalski 12 £52 500 Ewan Souter 12 £44 900
Jessie Goldman 14 £53 600 Jessie Goldman 141 £53 600
The Names and Money Made data has moved The Name and Money
too, so all the data is still correct. This is the Made data hasn't moved so
option you'll need to choose most of the time. the data isn't right anymore.

4) Sometimes you'll need to sort data on more than one level.
For example, by name and by age.

5) Select all the data on the spreadsheet this time, including headers but not titles.

6) Click ‘Sort & Filter’ and then ‘Custom Sort'.

Click this to add levels. Click to change the order it's sorted in.
Sons e " Sales Team Performance
2, ) l TR | e |A i ——— Humber of

[Pusies IXE*"‘*""‘f'h"Q%?‘ffff'__!l‘J ? LQ““‘T;E ARy n ts s FirstMeme LastMame  Cars Sold  Money Made

| ok Sert oy T e i Jessie Goldman 14 £53 600 |

SOTLY  astlame =] vakes =] Awz = Deepak Gupta & £48 000 ]

oty o] e Bl 5od &l "fﬁa@ Eliza Henry 7 £36.200 _

T = = = = i . Jimmy Kowaleki 10 £39.000 !

| || Click OK. Honiks ~ Kowaleki 2 280

| B ! Ewan Souter 9 £44 900 i

Click to change how to sort it. ; %

T TTETTT o TR gl | =
g ‘ L Gt ] The data has been arranged by last |

ik hereg?to change name A-Z, then by first name A-Z. n

which header to sort by.
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You can add filters so only data that matches certain criteria (rules) can be seen.

Filter the data so only people who've made £45,000 or more are shown.

1) Select the data you want to filter, including headers.

This drop-down
2) In the ‘Home’ tab, click Add filter criteria menu shows the

‘Sort & Filter’ and then ‘Filter’. (rules) by clicking here, criteria options,

3) An arrow will appear in the header
box of the data you selected.

4) Click on this arrow to bring up this. sessmm.
S) Either untick the data you don't want

6) ...Or choose ‘Greater Than

Or Equal To..." as your criteria. (o) (ame] o
7) In the box that appears, Unticking data means that it
enter or select a value here. won't show on the spreadsheet

once you've clicked OK,

Custom Autofiker

Shoi rows whare;
£32,000

Change

- isgrea:_e_r!i-u@wqu_a!m B 45000

the criteria el 6umd o . First N\ame Last Name Cars Sold
: e &l ; = - Deepak Gupta
here if you - D . Wonika Kowalski 12
Use ? to represent any single character C!!Ck OK

want to.

Use " 16 represent any series of characters

) Open the file called ‘Sales’.

a) Sort the data in column B so that the sales team members
are displayed in the order of highest sales to lowest sales.

b) Filter the data so that only sales team members with
sales of £80,000 or more are shown on the spreadsheet.

C) Print out a copy of the sorted and filtered data on the spreadsheet.

d) Save the file using a suitable name.

' Open the file called ‘Interview’.

a) Sort the data in ascending order of ‘Written Test Score’
within ascending order of “Years of Experience’.

b) Save the file using a suitable name.

" Sales Team Performance
Number of

Jessie Goldman 14

Money Mai-T
£49.000
£52.500
£53.600

i
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80 Section Six — Charts and Graphs
~ TypesofChartand Graph

1) Charts and graphs are a good way of showing information visually.

2) They can be made in most spreadsheet programs using the data in them.
Here we've used Microsoft®Excel®.

3) The different kinds of charts are useful for slightly different kinds of information.

1) On a bar chart you plot data using two lines called axes
(if you're talking about just one then it’s called an axis).

2) They're used to plot discrete data — that's data that can only have a specific value.

3) For example, the number of visitors to a museum
each day or the number of items sold each month.

A Chart to Show the Number of Appointments Each Day
in One Week

This is the vertical \
axis or y-axis. Smumg

== Charts should always
have titles saying
what they show.

The axes should
have labels to
show what they S

Number of Appointmentshfi

(g This is the horizontal
axis or x-axis.

o m A~ @ o ¢
B mmmamm|

Tuesday Wednesday  Thursday Friday

L ) - s Day of the Week

represent.

1) Line graphs are similar to bar charts, but a line is used to show the data.
2) They're used to plot continuous data — data that can have any value in a range.

3) For example, weight loss each month or temperature on different dates.

A Graph to Show the Average Temperature per Month in 2013 J\
20

T
L |
| © P j Line graphs can have
1 g ) P A I markers showing each data
| ® ! — ! point or can just have a line.
i [}
| & 3 |
£ 1
ﬁ 20 T T T T T T T ; ! T —1 i
| P
{ \’b(‘ Qé) & "b\é\ QQQ é\,b'-\ \QQQ' \o\-\ V—Ooo ;,JQ;Q &£ S ()Q'o 1
1 Month !
L = |

4) Line graphs are good for comparing two sets of data or for larger data seis.
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1) These are good for showing the relationship
between two sets of continuous data.

2)

3)

1)
2)

3)

1)
2)
3)

4)

9)

full stops.

A Graph to Show Temperature
Change Over One Day

Use these when all the data you

need to plot is in number form. £ fm‘“w\_
g« -
For example, how temperature varies over time | £ : s ey

or how house prices change over the years. U . A S
Time (24 hour clock)

Scattergraphs can have just markers showing & ‘
each data point or can have markers and a line.

A Chart to Show Dessert Orders
They show the relative sizes of each piece of data.

& Banoffe Pie
B Cheese Cake

They’re used when you want to show
what the data total is made up of.

& Chocolate Cake
& Key Lime Pie
& Carrot Cake

For example, to show what a budget is spent on.

= Apple Pie

In a pie chart, you need a legend (key) to
explain what each slice means (see e B2Y.

You'll usually add and edit these after you've made your chart.

To add a title, click on your chart, then ‘Layout’ in the ‘Chart Tools’ tab.

C“Ck the lChart Title, button! and then 'F"'-"?“V’"':::;r, ormulas Data Revigw View ! Design 2;;‘;‘:; Format l
choose where you want the title to go. ] 4] _l ﬂ} n ﬂ‘ M ™
Chart  Axis Llegend Data  Data Axes  Gridiings Plot chit

A text box for the title W”I appear JEr— Title » Tities = . ;,i, Labels ~ Table ~ - £ - Area ':i"
—click in it to edit the text. = NG

A Chart to Show the Annual Profits for the

To add axis labels click ‘Axis Titles’ on the Happy Hotel Chain Hotels in 2012
‘Layout’ tab. Then choose the ones you ges o
want and where they should go. g £s0000 1
& £40,000 -
Atext box will appear — click in it to edit the text. 2o T

Seaside  Grand Third Park The Rose The Moon

The axis titles are usually the column ln Hotel  Hotel  Hotel In
titles from the data in the spreadsheet. Hetek b

Each should describe what that axis shows If you need to move titles or
and should have units if required. labels, click on them and drag.

Titles need to describe what the whole chart shows — be specific, especially if
years or dates are involved, and make sure to use capitals where sensible but not
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r A Chart to Show the Annual Profits for the Happy Hotel
Chain Hotels in 2012 and 2013

£120000 1) Sometimes you'll plot more than
i : one set of data on a single chart.

£80,000 -
£60,000 1
£40,000

Profit

e prfitinz012 Ll 2) The legend (key) shows how the

o+l — 18 B erorein 2003 different sets of data are represented.
Seaside Grand  Third TheRcse, The
e e B ol RO 3) If a chart has only one set of data, a

i e o legend isn’t needed, so remove it.

4) To remove a legend, click on the ‘Legend’ button on the ‘Layout’
tab then click ‘None’. Or click on its box and press delete.

5) The legend labels come from cells in the spreadsheet.
So to edit them, change the text in the correct cell.

1) To print a chart on its own, click on the chart and then click ‘Print’ in the ‘File’ tab.

2) With the chart unselected, click ‘Print’ in the ‘File’ tab to see
where the graph would appear if you printed the spreadsheet.

3) To move the chart, click the ‘Home’ tab, then
click on the chart and drag it to a new place.

4) To change the area of the spreadsheet being printed, look at page 82.

5) Use the ‘Copy’ and ‘Paste’ buttons to add the chart
into a new document (like a word processing file).

6) To change the size of your chart, hover over one corner until a double-arrow

symbol appears — a bit like thisz_,};f{’!. Then click and drag to the size you want.

1) Open the file called ‘Farms’.

a) Add the title ‘Grain Produced by Local Farms' to the chart.

b) Add suitable axis labels.

c) Save the file with a suitable name.

B

- 2) Open the file called ‘Theme_Park’.

a) Format the chart so it's clear and easy to read. (Hint: Think title, labels and legend.)

b) Print out the chart and the spreadsheet data on one page.
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Bar or Column Charts |

_ How to Make a Column Chart

1) Abar or column chart is a simple way of showing information.
2) Make sure you understand what data you need to plot before you start.

3) You might even need to sort your data before you plot it (see p 78).

Create a chart showing the profits for

e Happy Hotel chain hotels in 2012. 14 .I-io-te.ul l;daﬁe = !troﬁ;:?l:a-]‘iz Proﬁtﬁzmsi
1) Select the data you want to plot. Here %—gf::;dﬁ;{'; §§§g e |
you need the names of the hotels and the JzThlrd ParkHotel £ 47,000 [£ 38000
2012 data. Include the column titles. i i’;‘;ﬁf;&“ﬂ‘” 2 o
2) Click the ‘Insert’ tab and the ‘Column’ button. =)
. ML ELY
3) Click on the first option in ‘2-D Columns’ Coum| tne  Fe o s s
called ‘Clustered Column’. == 20 Cotamn

~ 4) Format the chart so it has a suitable title, labels ~ L Iaj (a8 AR
and the legend is removed (see p. 81-82). L

\fn| 93/ 93 33
i i e
A Chart to Show the Annual Profits for the | Sibde
Happy Hotel Chain Hotels in 2012 | TEeag Bt
eonso i 1] 1R8] 8
£80,000 o
£ £60,000 T T —
= | !
& £40,000 - J, A 1&,& J_é@_ iié{,é
£20,000 ]-— Pyramid
£0 T f M1 I
Seaside  Grand Third Park The Rose The Moon J_‘é’l ]M Jéﬁ 'M
Inn Hotel Hotel Hotel Inn .r - ‘é i ‘j— = & | -
Hotel Name '@ AN Chart Types...
[Example 2.

Create a chart showing the profits for the five Happy Hotel chain hotels in 2013.
1) Select the data you want to plot.

2) This time it's names of the hotels and the 2013 data. So select the
names first then hold ‘CtrI’ and select the 2013 data (plus column titles).

3) Click the ‘Insert’ tab and follow the same instructions as in Example 1.

: A Chart to Show the Annual Profits for the
| A : ; B i e : Happy Hotel Chain Hotels in 2013
1 |HoteIName Profit in 2012 [Profit in 2013 £120,000
_2 [Seasidelmn £ 25000 £ 29,000 Raen
.3 GrandHotel £ 93,000 £ 102,000 Z 60,000 =
_4 |Third Park Hotel £ 47,000 £ 38,000 £20000 1 5{_ _T_
——‘—5 The R.OSG HO:E' £‘ 60'000 ‘£ 52'000 5 Seaside  Grand ‘Th dParkTh Ro Th M
6 [TheMoonlnn ~ £ 19,000 £ 21,000 n Rt Howl Bt o
Hotel Name
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You might need to plot more than one data set on a single chart.

|

Create a chart to show the profits for the five
Happy Hotel chain hotels in 2012 and 2013.

1) Select the names, 2012 and 2013 data. Include the column titles.
2) Click the ‘Insert’ tab and follow the instructions from Example 1 on page 83.

3) Don’t remove the legend this time though — you need one
when you have more than one data set on a chart.

e |
A Chart to Show the Annual Profits for the Happy Hotel
[ A | B | [¢ Chain Hotels in 2012 and 2013
1 [Hotel Name Profit in 2012 Profit in 2013 £120,000 5
2 |Seaside Inn £ 25000 £ 29,000 iy
3 |Grand Hotel £ 093000 £ 102,000 £ o000 |
4 |Third Park Hotel £ 47,000 £ 38,000 & £40,000 - e = orofitin 2012
5 |The Rose Hotel £ 60,000 £ 52,000 £000 T TS .@.ﬁ-g & Profit in 2013
S | eo 1 ihm BRI a8 88
6 The T\ADDH Inn E 19'000 £ 21‘000 Seaside Grand Third TheRose The
Inn Hotel Park Hotel  Moon
. ’ = Hotel Inn
This type of chart is good for == L Hotel Name J

comparing two sets of data.

1) Open the file called ‘Sales’.

a) Create a column chart to show the sales figures for each member of the team in May.

b) Give the chart the title ‘A Chart to Show the Sales Figures for the Team in May’,
the y-axis label ‘Number of Sales’ and the x-axis label ‘Sales Team Member’.

c) Remove the legend.

d) Insertthe chartinto a word processing document.

Save the word processing file using a suitable name.

Open the file called ‘Shop’.

a) Create a column chart to show the total amount of money made from each item.
b) Format the chart so it's clear and easy to read.

c) Print out the charton its own separate sheet.
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Line Graphs and Scattergraphs
.

How to IV_I'éke a Lme Graph

85

Line graphs are made in a similar way to column charts — select the data, click on your
chart option then format it so it has good titles, labels and a legend if needed.

Create a chart showing the sales at the Bristo T a =7 5"

R )
_A7[  Month | Bristo Square | Causewayside Grindlay Street.

Square coffee stall from January to July. 12 iy £2500  £2000 £2,350
By eps)  eie £2,200

March £2100] £2,100 £2,000

1) Select the data you want tO plot. an’l e c2080|  £1800  £1,850
6 May . etge0| T El7s0 £1,900

Include the column titles. Tlwme et00] T 1500 £1,800

8 lduly = < ~ £1,6800] £1,200 £1,500

2) Click the ‘Insert’ tab and the ‘Line’ button.

e =

Line. Pie Bar

3) Click on the first option in ‘2-D Line’ called ‘Line’.

L

Area

4) Format the chart so that it has a suitable title, 2D Lne

labels and the legend is removed (see p. 81-82).

Create a chart showing the sales at the Bristo Square
and Grindlay Street coffee stalls from January to July.

1) Select the data you want to plot.

2) This time it's the months, the Bristo Square data and the Grindlay Street

A Graph to Show Sales at Bristo Square Coffee Stall from I _Hg ) [
January to July E{i‘bi i :“Z’
£3,000 D Line
D Li |
£2,500 \ |
g \
8 | e
B £1500 [ a1 chat Types...
£1,000
£ If you want the data points
£0 T T 'z T T T d
January February March  April May June July ;tO. have. markers’ C](}OOSE_ thE
Month Line with Markers' option.
Example 2

data. So select the months and the Bristo Square data first then hold ‘Ctrl’

and select the Grindlay Street data. Include the column titles.

3) Click the ‘Insert’ tab and follow the same instructions
as in Example 1. Don’t remove the legend this time though.

A Graph to Show Sales at Bristo Square and Grindlay
- Street Coffee Stalls from January to July

A I B i i ] 3000
1 - Month = anto Square Causewaysu:ie Gnndlay Street Ez'm ]
2 [January £2500  £2,000, £2,350 e e
_3 Febuary £2,250 £, 9707‘: L £2,200 3 1500 .
ﬁcLMarch : £2100  £2100 - £2,000 A )
5 April £2060  £1,800 £1,950 ce00 === Bristo Square
6 May - . £1800 £_1,_750_} £1,900 o o e —Grindlay Streat

7 June - £1,700  e1,500. £1800 & M om m av e
Delwy . #1800 #1200 . 18500 L& RS

Month
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1) Scattergraphs are like a special line graph.

2) Use these when you need to plot all number data.

Example

. S _rjflAge of Ch;?d {years) !Height of ghild (em) i

Create a chart showing how the height = : .
of a child changes with age. o : 02
1) Select the data you want to plot. — _zi 2 %E
Include the column titles. Kl 9 130

10| 10 136

. 1 143

2) Click the ‘Insert’ tab and the ‘Scatter’ button. “1_%* é e
3) You can choose ‘Scatter with only Markers’ % 1% igé
or ‘Scatter with Smooth Lines and Markers'. L 17 175

18 18 177l

4) Format the chart so that it has a suitable title,i%f-'-"_'
labels and the legend is removed (see p.81-82). %,

l16) ==

;Scaﬁerﬁ Other Lline ¢
| h

I A Graph to Show the Height of a Child at Different Ages

R AA

I . Hover over the
1 E w0 | buttons to see
0 . what they mean.

- ; ; -
o 5 10 15 20 | -
1 Age of Child (years) i il 0 Chart Types..

1) Open the file called ‘Wash'.

a) Create a line graph to show the sales for Washo-tron 3000 and Das Wash for all months.

b) Give the graph the title ‘A Graph to Show the Sales Performance
of Dishwashers in 2013 and add x-axis and y-axis labels.

c¢) Insertthe graph into a word processing document.

d) Save the word processing file using a suitable name.

- 2) Open the file called ‘Factory’.

a) Create a scattergraph (X-Y chart) to show the number
of units produced by the different number of employees.

b) Format the chart so it’s clear and easy {o read.

c) Print out the chart on its own.

TSR - o = = N — L i .
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Pie Charts

How to Make a P:e Chart

Pie charts are quite different to column and

line charts but they're still made in a very similar way.

Create a chart showing the different costs for a business.

1)

2)
3)

4)

Select the data you want to plot.
Include the column titles.

Click the ‘Insert’ tab and the ‘Pie’ button.

Click on the first option in :
‘2-D Pie’ called ‘Pie’. ™=

Format the chart so it has a suitable title,
labels and legend (see next page).

A Chart to Show the Different Costs of a
Business (thousands £)

2512

150

i Staff

E Materials
40 E Overheads
& Advertising
100 E Equipment
& Utilities

E Insurance

400

Create a chart showing the different costs for a business as percentages. .
1) Select the data you want to plot. Include the column titles.

2) This time it's the category and the percentage of the total. So select
the category first then hold ‘Ctrl’ and select the percentage data.

3) Click the ‘Insert’ tab and follow the same instructions as in Example 1.

T

Pxe Bar Area  Scatter

: iZDPle e

s e o

—

{ ¥DPie

Hesapete

:Eﬁ gIlChartTypEi RS

15 Business Costs :
2 Category Cost (thousands £) %
SsEEEE sy 177
_4 |Materials 400|472
.5 |Overheads . 100] 118
.6 |Advertising 40| 47
BT Equipn’ient;-'i'_“'_ 1200 142
18 |utilities - = o 30
9 |insurance _12 1.4

Make sure all the categorles are shown
in the legend. If not, click and drag the
bottom edge of the graph to make it bigger.

B i o
Business Costs

2 Category Cost (thousands £) % |

.<f‘,i AT

Staff e 1500 7.7
i‘ Materials = ) 400; - 472

5 Ovetheads. 100 11 8
5 .6 Advertising 40 47
7 Equipment 120 142
8 Utilitles = o 25; 3.0
_{lnsurance S 12 e

Choose ‘Exploded Pie' (the 2nd

choice from the 'Pie' menu) to get

M 472

A Chart to Show the Different Costs of a
Business (%)

3.01.4
17.7
B Staff
E Materials

B Overheads

B Advertising
& Equipment
& Utilities

EInsurance

a chart which looks like this.
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1) Titles and labels can be added and edited as on page 81.

2) You might need to move the title
though so it doesn't block the chart.

3) You might also want to add data labels.

4) These will show the actual data for each slice.
Add them by clicking the ‘Data Labels’
button on the ‘Layout’ tab in ‘Chart Tools’.

A Chart to Show the Different Costs of a
Business (thousands £)

3512

& Staff
® Materials
& Overheads

E Advertising

E Equipment

& Utilities

1

5) Click to choose where you want them to go. For example, ‘Outlside End' like this chart.

1) Alegend is needed in a pie chart to show what the different slices mean.

2) You can change the colours of
the slices to make the chart clearer.

3) To do this, click on the pie itself, then
click again to select one slice.

4) Then use the ‘Fill Color’ button

(looks like a paint bucket) on the =s======3%

‘Home’ tab to choose a colour.

A Chart to Show the Different Costs of a
Business (thousands £)

2512

= 150

2 & Staff
Materials
40 f B Overheads
£ Advertising
100 & = Equipment
& Utilities

W Insurance

400

5) If you're printing in black and white choose your colours carefully.

1) Open the file called ‘Electronics’.

a) Create a pie chart to show what proportion each of the
products sold is of the total number of products sold.

b) Give the chart a title and add ‘Inside End’ data labels to the chart.

Save the file using a suitable name.

.

- 2) Open the file called ‘Population’.

a) Create a pie chart to show what percentage of the population live in each area.
b) Format the chart so it's clear and easy to read.
c) Insert the chart into a word processing document.

d) Save the word processing document file using a suitable name.

Section Six — Charts and Graphs
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Section Seven — Presentations 89

1) Presentation software is used when you give talks.

2) For example, you could use it when giving a talk on the sales forecast for a company.

3) Presentation software lets you create slides. A slide is like g page you can add text,
images, videos, sound and animations to. You can use as many slides as you need.

4) During a presentation you move through the slides, showing them
one at a time. This is called g slide show.

5) Here’s an example of some slides created in Microsoft® PowerPointe®:

Intraduction Total Szles

Sales Forecast

e * This presentation will show the Sales Forecast for the
financial year 2015,

¢ Here is a chart showing previous years' forecasts and
sales figures.

* This chart shows sales figures from each sector,
globally,

Sals milfion £)

4 il 2 @
Presentations usually begin with a Adding charts or other images can help
title slide. This lets the audience the audience follow what's being said and
know what the presentation is about. make the presentation more interesting,

1) Presentation software lets you show the audience information.
This can make a talk easier to understand.

2) You can use the slides to make the key points stand out to the audience.

3) The slides can help you remember all the things you were planning to say in the talk.

=2
a) Name two things you can add to a slide in presentation software.

b) Give one reason that presentation software is useful when giving a talk. “

[ T e T A —_—
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The presentation software used in this section is called Microsoft® PowerPoint®.
Here's what you'll see when you open up a PowerPoint® document:

The slide pane will show e T e
you a list of all the slides in e B

your presentation and let

you move between them. sm==

The slide selected in the slide
pane will be shown here, in
the slide area. You can add
text and images to the slide. *

Chick 1o add subutle i

G eem

Bl RS T srenEE ]

1) To add a new slide click the ‘New Slide’ = -
button on the ‘Home’ tab. Click the drop down B et T 4

When you first open a
, presentation document,
Click to add title s the title slide may be
the only one there.

menu to choose from different slide layouts. T

2) The new slide will appear after the

one that’s shown on the slide area.

3) You can delete slides by right clicking on them

in the slide pane and clicking ‘Delete Slide’. P i |

Titie Snty

The names of the different slide

layouts are shown underneath. wemsss=™ Fa

1) When a new slide is created, it will usually have text boxes on it.

2) For example, this one has two — one is for

the slide’s title, the other is for the main text. = rm=mm Click to add it

- Click to add text
3) If you want to add another text box, click on the ‘Insert’ tab '
and choose ‘Text Box’_. Then draw the text box on the slide.

Revitws

Ted  Header
Box & Feoter

Tabies Imdges igstrations Lk

4) Either type straight into the text boxes or paste text in from another document.

5) You can resize text boxes by clicking on them and dragging the boxes that

appear on their edges. You can also move them to different places on the slide.

Section Seven — Presentations
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tab.
, Blda-g-
TO add an Image that's Saved (3 . Home Ingert Dezzign Transitions Enimatipes it YOLI tan draw Shapes on the
on your computer, click on wsmmgg T ag ; @ —?i m slides. For example, arrows,
‘Picture’, find the file you want = OO @ e YV g ﬂ‘ stars and flowchart symbols.
A : . Tabile Picture -'__hp Screenshot ‘Phc-to Shapes Smartart Chart
to add, then click ‘Insert. - At T Abum- -

fabieg

Tmaa

lustrations

To find a clip art image:.click on clip art, type what you'd
like a picture of into the search bar and click 'Go'. Click
on the picture you want to add from the results,

3) You can also copy images from other documents and paste them onto a slide.

4) You may want to resize graphics by clicking
on them and dragging the corners.

1) You can move slides to different positions in the presentation.

2) Inthe slides pane, left click on the slide you
want to move and drag it to a new position.

1) Afooter is a box which appears at the bottom of 3 slide.
You can put your own text, the slide number, or the date in the footer,

2) Click on the ‘Header & Footer’ button on the ‘Insert tab and this box will appear:

Haader 2nd Footar
Click Apply to All if you want
== your footer to appear on every
slide, or Apply' to just have it on
the slide you're currently on.

Choose whether you want to I
add the date and time, slide == 1

number or a text footer. (You —

can add them all if you want.)

m=mss [he 'Preview' box shows
you where the footer will

If you' ' text, ,
f you're adding your own text B——T

type what you want in here.

%
Click this box if you don't want the
footer to appear on the title slide.

e e e
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1) When you're giving a presentation, the slide show option
shows your slides, in the right order, on the full screen.

2) To begin a slide show, click on the ‘Slide Show’ tab and
select ‘From Beginning’ .=

3) When the S“de ShOW begins’ = ) Insart Design  Transitions Znimstions Shdz Show Review Mg
- ¢ ¥ s = 1 w2y S P T jeoe N /i Play Harrations
left click or press ‘Return WY 8 F g ] gy W e
to move on 10 the Next Slide.  seiiming curemsige Sice Show side Srowr= s e S mearse RELOSHE 51 v taedi Contrls

22t Lip

i begin the slide show from the slide you're
on, click the 'From Current Slide' button.

4) During a slide show, there are small forward and back arrows on the bottom left-hand
side of the slides. You can click on these to move forward or back a slide.

1) Use ‘Save’ and ‘Save As’ on the ‘File’ tab to save presentations.

© Bl 22w
2) You may want to print out your slides

and give them to the audience as handouts. _ a
3) Click on the ‘File’ tab and select ‘Print’. =,

Ty BHSALcps o0 DHPLELSY
Seart.

4) You can choose to print all g
the slides or just some. o

. Settings

. Print 20 Slides
Bri enties prezentat

5) There are different options for how B
you want the handouts to look here, ===

6) To print two slides on each page, select the
‘2 Slides’ option from the drop-down menu.

1) Open the file called ‘Motors'.

a) Move the title slide from slide 3 to slide 1.
b) Add a new slide to the presentation at the end.

c) Make the title of this slide ‘This Year’s Aim’.
In the main text write “To sell more cars than last year’.

d) Watch the presentation by playing the slide show.

e) Print a handout of the slides with two slides per page.

Section Seven — Presentations
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'~ 2) Open the file called ‘Holiday’

3)

L2

a) Insert a new slide after slide 3 with a ‘Two Content’ layout.

b) Open the file ‘Holiday_Content’. Copy the title from ‘Holiday_Content’
and paste it into the new slide.

c) Copy ‘Text 1’ from ‘Holiday_Content’ and paste it into the
left-hand text box in the new slide.

d) Copy ‘Text 2’ from ‘Holiday_Content’ ang paste it into the
right-hand text box in the new slide. |

e) Copy the two images from ‘Holiday_Content ang paste them
onto the slides. Place them below the correct text.

f)  Add a text footer which says ‘CGP Holidays’ to every slide in the f
presentation apart from the title slide.

Open a new, blank presentation document.
You're going to make g presentation about yourself,

a) Setupthe presentation so that it has four slides.
*  The title slide should have your name on it and an image.

. Slide 2 should have four pieces of information about you on it. For example, your j
date of birth, where you live, your job, any qualifications you have. |

*  Slide 3 should have some information about the town or city you live in.

. Slide 4 should say what your interests are. |
b) Add a footer to every slide with your name on jt. i i
c) Make sure each slide has an appropriate heading.
d) Play the slide show through.

e) Print a handout of the presentation with two slides per page.

e e ._g,.._..m.A,..,_._._..,,-m_._q_._,._u.__._,‘__...._,_,._LH,....u_.‘.,.._..,..,,_...._..mﬂ_._._M..W.__.,_.“,,._ﬂ..._k,.._-.,... 4

I [ ]



1) It's useful to use text of different size, font and colour in presentations.
It can help highlight a point and make the slides more attractive.

2) Use the options in the ‘Font’ and ‘Paragraph’ sections of the ‘Home' tab to format text.

Click and choose from the list Click here to change Use these buttons to change
to change the font (style of the text) the Size of the text. “how the text is aligned.

N E -
T ™ S : 1 e Holiday - I
@ Hame Insert Dezign Transitions n ions de Show Review Format
"'T"j i -1 Ellayout - Calibri fHeadings + 44 - A" AT AL = - 1= 4 t=- 11} Text Direction -
- 8 52 *jRezet =] Align Test +
Pa-,ta J Format Painter 5::;\;. jSectien v b i i 3 5 ?_?;memte Smartart ~
Chpbaard - Shides = % Paragraph
%
Use these buttons to make the Click and choose from the list
text bold, italic or underlined. to change the colour of the text.

1) In presentations, it's a good idea to break up text into
smaller chunks by using bullet points or numbered lists.

2) Just highlight the text, then click the ‘Bullets’
or ‘Numbering’ buttons on the ‘Home' tab.

FEde o= et Holiday - h

Inzert Dzzign Transitians Zpimations Slide Shaw REG=w Ry ERY Foimat

i I Layout - Calibri (Headings < 44 = AT A7

e JLit Text Durection -
o) Resat -

] Aligni Tea -
22 Convert to Smartart -

= Hew AV AL
F Format Painter SI,EQ, ~jSectian v B 7 U S ae %- A

Thpboard x Shigdes Font

Use the dro:p;-down menus to see different options.

3) Remove the bullets or numbers by highlighting the text and clicking the buttons again.

1) You can make a presentation more colourful
by changing the background of slides.

2) Click on ‘Background Styles’ in the ‘Design’ tab then
select ‘Format Background'. You'll see this boX: su, P

3) Choose a fill style and a background colour.

4) Clicking ‘Close’ will add the background to the selected _‘
slide. ‘Apply to All' adds the background to all slides. s s

[ =TT
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1) Open the file alled ‘Olympics’.
a) Format the main text on slide 2 so that it's in bullet points.
b) Change the font size of the main text to 24 pt.
c) Change the background colour of all the slides to light blue.

d) Save the file using a suitable name.

2) Open the file called ‘Pyramids’.

a) Change the font of the titles on both slides to ‘Verdana'.

b) Underline the titles on both slides.

¢) Change the font of the main text on slide 2 to ‘Calibri’,

d) Change the background colour of all the slides to light brown.

e) Bold these words on slide 2 — ‘Pharaohs’, “100 000 workers’, ‘Giza’
and ‘The Pyramid of Khufy’.

f)  Save the file using a suitable name.

3) Open the file ‘Technology’.
a) Format the main text on slides 2 and 3 so that they’re in numbered lists.
b) Change the font size of the titles in slides 2 and 3 to 36 pt.
c) Change the font size of the main text on slides 2 and 3 to 22 pt.
d) Change the background colour of gl the slides to light yellow.
e) Make all the text on slide 1 dark blue. Make the titles on slides 2 and 3 dark blue.

f)  Bold the words before the hyphens in slides 2 and 3.
For example, Television’, ‘Computers’, ‘Antibiotics’.

g) Save the file using a suitable name.

gQr‘tﬁnn Qavian M ~ ~ ot _ar
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[ - i
Table

1) Click the ‘Insert’ tab and then the ‘Table’ button. e

2) Choose the size of your table by moving your mouse over the boxes to
highlight them and clicking when the right number of boxes are red.

Preseatstion] - icrosoft PewerPoint

4 red boxes by 5
red boxes gives a __
table with 4 columns | f
and 5 rows. }
3) To add text to a table, just click in a box and start typing. i
|
I
4) You can use the ‘Design’ and ‘Layout’ tabs to make changes to a table. '
For example, you could change the colour or the border of a table, 4
or change how the text is lined up.
= B R Presentationl - Microsoft PowerPoint | CaRpleT (R |
m Home Insart Design TI!nsili:m_ Znimations Slide Show Review View Dzzian Layout
gl S = G Ml e
7! Banded Rows | Banded Columns *  Eieds - S?}\;:‘l_ Lo 2 Penrols ?:;r: Eraser
1) You can add a video clip or a piece of audio (sound) to your slides.
2) Click on either the ‘Video’ or ‘Audio’ button from the ‘Insert’ tab. =
Bl = 20 = : : Z = Presentationl - Microsoft P aint

@ Home inzert Design Transitions Znimations Slide Show Review View

EREE e - W=

Tzble Picture Clip Screemshot Photo  Shapes Smartirt Chart

134 HDe9 T OB

Text Header Wordirt Dste  Slide Object Equation S.obol lViuec; Audio

Art % Album ~ = Box & Footer = & Time Humber I
_E:\-IES Imzgss ) Huctrations Text Symbaols  Video from Eile..
1 Hi

3) Choose the option ‘Video from File’ or ‘Audio from File’.

4) Then select the video or audio clip saved on your computer that you want to add.

Section Seven — Presentations
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1) Transitions are effects that change how each new slide appears in a slide show.

2) For example, a new slide could swipe in from the left, or you could have
a '‘page turning’ effect.

3) Choose a transition for a slide by clicking on it in the slide pane, then
clicking on the ‘Transitions’ tab and choosing from the options there.

Use 'Preview' s= 3= 7 Presentation - Microsoft PowerPoint
t h th i 2 Insert Design Transitians Animations Slide Show: Review Wiz
RARCE! Me € T = = | — P & Sound [l Sound] -
transitions you've ;i . :‘i : o S 122 z | # D Durstion: 0200 3
Y Mone cut Fade “Push wipe Split Revesl  RendomBars - _© -

sk £pply To AN
SEIeCtEd look. . Transition to This Stide ming

- Click 'None' to remove transitions.

4) You can choose a different transition for each slide or have
the same one for each by clicking t

he ‘Apply To All' button. ==

1) You can add animations to text and graphics.

2) For example, you could make an image appear
from the left or a text box spin onto the screen.

3) Select the object you want to add an animation to, then click on the ‘Animations’ tab.
Choose an animation from the options here. &=

3= ationl - Microsoft PowerPoint
CIICI’( \PI’EViEWJ to see “1  Home Insert Design Transition% Lrimations Slide Show Review
how the animations [ % | e _; oy .
{ ; | i R [ is -
youve S€|9Ct€d |00k' F"e‘fﬂ" ! E"'.’f,,,f Lppear Fade FlyIn Fleat In Split
Preview Animation

4) If you have more than one animated object on a slide, they'll appear in the order that the
animations were added in. Numbered boxes beside each object show this order.

5) You can change the order of the animations or make them appear
all at once using the ‘Animation Pane’ on the ‘Animations’ tab.

you'll usually have to left click to start each
animation when you're playing the slide show.

6) To change the order of animations, i @ L=l
. iy o &

select one and drag it to a new position... O e e e e g

. E‘f 71"@’9’9’!"_"““- & Duration: 0050 = & Llgve Earlier
7) To make all the animations appear at once, iy i Dl

click the drop down menu beside each = = ~ [ nimaion Pans “x
animation and select ‘Start With Previous’. | o
1 [ = ] 1 ¥ SmieyFaces  [] !
, , . . || 2roaes O :
It you've not selected 'Start With Previous', S ! i;} :mi 0 ;

fL Y stan on Click

¥ Stam With Previeus i

—i | 2 Stant After Previcus i
i i
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1) A master slide is a template.

2) Each type of slide layout has it's own master slide. For example, there’s a master slide
for the ‘Title and Content’ layout and a different master slide for the ‘Title Slide’ layout.

3) Changing the master slide changes all of the slides with that layout in the presentation.

4) To change a master slide, click on the ‘View’ tab and select_‘SIide Master’.

5

PllEad9-s's _
@ Home Insert Design Transitions r- __.'-r-"—*;-'r Slide Show Revigw Vigw
BT T B ) et O F (@
i i£l = M :‘J &5 7 Gudiines R ‘—‘-'_!'3 == Grayscale
Normali Slide Motes Reading  Slide Handout Motes Zoom Fitte ey .
| isorter Page View  Master Master Master L Guides Window mm Black and White
Praszntztion Views fiaster Views Show ¥ Zoom Color/Grayscale
5) You are now in the ‘Master View'.
Select the master slide Make any changes to the When you've finished, click 'Close Master
you want to change master slide in the slide area. View' The changes will automatically be
from the master slide Edit the slide the same way as applied to the slides that have the same
pane. To see the names you would a normal slide. layouts as the master slide you changed.
of different slide layouts, % 4

hover over the sllde.r{%_ Ewene

You can move text boxes - r Click to edit Master title style
around and change the S _
font, size or colour of text. e | . * Click to edit Master text styles
P = —Second level
You can also add images, « Third level

which will appear on every — i ™ Fourth level
i . e » Fifth level
slide with that layout. ’

1) Open a new, blank presentation document. You only need one slide.

a) Add a table with two columns and five rows to the presentation.

b) Write ‘Country’ in the top cell of the left-hand column and
‘Capital City' in the top cell of the right-hand column.

c) Complete the table with the following information ‘USA - Washington DC’,
‘UK - London’, ‘Japan - Tokyo’, ‘Sweden - Stockholm’.
Save the file using a suitable name.

Paseee o e - e e
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Ope

a)
b)

c)

Ope

a)

b)

n the file called ‘Rome’.
Give each slide a different transition effect.
Give each graphic in the presentation a different animation effect.

Play the slide show through.

n the file called ‘Safari’.

Change the background colour of al| the slides to green using the master slides.

Slide 2 has the layout type Title and Content’. Make these changes to its master slide:
Change the heading font to ‘Lucida Calligraphy’.
Change the main text to ‘Arial’.

Copy the picture from the title page and paste it into the master slide.
Place it in the top right corner of the slide. Resize the image and
make the heading text box shorter to make room.

Slide 3 has the layout type ‘Comparison’. Make the same
changes to its master slide as you made for slide 2.

Add the audio file ‘Lion’ to the title page. If your computer is not set
up to play sound, you may
Play the slide show through. not be able to do part d),

Open the file called ‘Circus’.

Give each slide a transition effect.
Add an animation to the text on slide 2.
Give each graphic on slide 2 different animation.

Order the animations so that the text appears first and the pictures appear in the order
they’re written in the text.

Play the slide show through.

Section Seven — Presentations
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1) You should keep the layout of slides simple.

2) Make sure your slides are consistent.
This means the layout for all the slides should be quite similar.

3) Make sure you divide the presentation up sensibly onto the slides.
It's often a good idea to have one slide for each topic you want to talk about.

4) The layout should be balanced. Each slide should have a similar amount of material.

1) Don't put too much text on your slides — the audience will find it difficult to read.

2) You want enough text to get your point across and no more. (You can always go into
more detail when you're giving the presentation.)

3) Bullet points and numbered lists are a good way to cut down on text.
4) Use the same font and font size for the main text on each slide.
5) Most slides will have a title. Make sure it fits with what's on the slide.

6) Titles should have larger font size and possibly a different font than the main text.
Make sure all the titles have the same font and font size as each other.

7) Pick a font that is easy to read and make the font size large enough for people to see.

8) Bolding, italicising or underlining text can help make the important points
stand out but don’t use them too much.

1) Some images are there to show information, like charts or graphs.
2) Others are there to make the slides look more interesting.

3) Images should be linked to your presentation. For example, if a presentation is about
London, a picture of Big Ben would be suitable. A picture of the White House wouldn'’t be.

4) When you're choosing images, think about what the point of each one is.

5) Think about the kind of images your audience will expect — some presentations
are quite serious, in others you can use images that are a bit more fun.

6) Images should be big enough to be seen clearly but they shouldn’t take over the slide.
7) Don't use too many images. It can be distracting for the audience.

Qanrtinn Seven — Presentations
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1) Afew animations can make a slide show more interesting.

2) Don't use too many though — having text and graphics whizzing
all over the screen could be distracting to the audience.

3) For a serious presentation, it's better to pick less flashy
slide transitions. For example, the ‘Fade’ or ‘Push’ options.

Always make sure you check your presentation before you finish.
1) Have a look at the layout of the slides and make sure no graphics overlap text.

2) Check the spelling and grammar. Use the spellcheck
by clicking on the ‘Review’ tab and selecting ‘Spelling’. s

3) Always run the slide show before giving the presentation Spelling
to make sure everything works as you want it to.

a) Make the titles of slides 2 and 3 a suitable size.
b) Check the layout of the slides and correct any errors.

c) Find and correct any spelling mistakes.

Open the file called ‘Coffee’. Edit the format and layout of the slides so that they are suitable
for a professional presentation. Think about the font types and sizes that are used and the
layout of the slides. Check the spelling of the text and run the slide show through.

Make a presentation for a Recruitment Open Day at Huntersfield Nuclear Power Station.

The presentation must have 4 slides, including a title slide. Make sure the layout is
consistent, is clear and easy to read and has no mistakes.

The presentation should include:
* All the text from the file ‘Recruitment_Text’.

= Some suitable images from the file ‘Recruitment_Images’.
=  Suitable formatting.

Section Seven — Presentations
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Section Eight — Databases

1) Adatabase is an organised collection of data (information), held in records.

2) Each record has data arranged into fields (categories),
like names, addresses and phone numbers.

3) Records can hold different types of data, such as text, numbers, dates and currency.

4) So that no two records are exactly the same, they have a unique identifier.
This is a field containing data that is different for each record, like an ID number.

Example

e 1 Employees *

_H’IIS Is the ;’33"5’; 5 - iD | FirstName - Sumame - loh Title E ?;ia-r;,f_l_:-lf)_m-—'ﬂcf}éméc?: :
unique identiﬁer. “Tabies U 4mands Gilbar Wansger 23000
Humphrey  |Manager - 23000
darsh Store Assisiznt 18000 |
This is a record, pez=== Hartley Store Assistant 19000
Harriz Cles 18500
o . Wright Area Manager 27000
ThlS Is a ﬁeld Wltl'l hompse Accountant 26000
tl’le ﬁeld Haie \Job Deag [Financial Advisor 26000 -

Rzeord W 4 14 of

Title',

PrnmiEhes ity T humless @E S e

1) Databases are similar to spreadsheets, but they're better for certain tasks.
2) Databases have better tools for searching and displaying data.
3) You can search for data in databases using queries.

4) You can create reports from databases which show only the data you want to display.

If you're asked for a ‘report’ or ‘query’, use a database, not a spreadsheet.

1) To create a database, use a program like Microsoft® Access®,
We have used Access® throughout this section.

2) Click ‘New’ from the ‘File’ tab. Select ‘Blank database’, type a name, and click ‘Create’.
3) Once set up, all changes to data in the database will save automatically.

4) Data is stored in tables. Most programs will create a table for you when you create
the database.

5) You can add more tables to the same database.




1)
2)
3)

4)
9)
6)

7)

8)

9)

1)
2)

4)
5)
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Before you enter any data, you need to set up some fields for your table.

This is done in ‘Design View'. Click this icon on the ‘Home' tab, e

One field needs to be the unique identifier or primary key. -
Microsoft® Access® wil| create an ID field for you automatically,
but in other programs you may have to set one up yourself,

Type in titles for each of your fields in the ‘Field Name’ column.
For each field choose 1 ‘Data Type’ for the data that will go in the field.
For example, names should be ‘Text’' and money should be ‘Currency’.

" = Books
Field Name

- ) !  DataType
T!’us o the unique e AutoNumber Click here to change
identifier, called | BookTitle Text 5 the data e
the primary key. S:Z:m % = '

L Stock I Text
Click in a box to e S {Memo
enter a field name. j”“"’be_r I
|Date/Time

Format
Input Mask

You can set rules to limit what data goes in a field.

This is done to prevent mistakes when entering data. Sapiion

For example, if a date should always be after 1/1/2000,
you could set a ‘Validation Rule’ to only allow later dates in
When you've set up your fields, click on the

In your table, each row is a different record, and each colu

. . {2 Tabler ",
To enter data, click in | Backmitle ~huther o
a box and start typing. =

1 Doz Tales Russ Crow £3.99
P Ely A

i

You can change the width of the field column. To do this, hover over the edge of the

Price x

Default Value
Validation Rule
Validation Text

that field. &

>=01/01/2000¢

View’ button again to go back to the table.

mn is a different field.

- Ciekto dag <

column heading, and click and drag when you see the <P icon.

To edit the data, just click in the box and make the change.

To delete a record, click on the bar to the left of it then press the ‘Delete’ key.

Then click ‘Yes’ to delete the selection.

] Tabler ] Microsoft Accass
‘ T sackTile T TAuthor - P o
1 Doz Tales Russ Crow £3.99
2 Fly Away Jeremy Hall £5.93
3 Thz Queen of the Mountain  Louise Harper £6.99
% 4 Time Out lan Smith £6.99 wEEEE

Be careful when deleting records. It can't be undone.

B 5T




2) To do this, use the ‘External Data’ tab.™

3) Choose the type of document the
data is stored in, such as a ‘Text File’
or an ‘Excel® spreadsheet.

Lecess  ODEC
Database 3 Mare ~

4) You'll then be asked to browse for the file. Select it, then click ‘Open’.

5) You can create a new table for the data, or add it to a table you've already made.

When you've chosen, click ‘OK’, then follow the instructions.

Etzrna! Data Datalyaze Toals
S {Text File

4 EML File

Saved
Exports

6) If importing from a text file, choose what separates the data (usually a comma or tab).

7) If the field names are the first row in your data, check the ‘First Row Contains Field

Names’ box.

1) Create a new database. Save your database and table as ‘Orders’.

a) Add the following field names to your table, together with the correct data types:

ID, First Name, Surname, Amount Due, Order Date.

b) Add the fdllowing records to your table.
Make sure the field columns are wide enough to display all the information.

First Name Surname Amount Due |Order Date
John Wilkins £95.50 26/02/2014
Nigel Walker £14.97 12/03/2014
Samantha Makinson-Smith £24.95 25/03/2014
Joel Bough £17.99 02/04/2014

c) Mr. Wilkins has called to cancel his order. Delete his record.

2) Import the records from the text file called ‘MoreOrders’ into a new table.

a) Give the fields the correct data types. Save the new table as ‘MoreOrders’.

b) Add a new field to store information about whether they have paid or not.

Give it an appropriate name and data type.

c) Only Sam Jackson and Dawn Jones have paid so far.
Enter this data into the new field.

Section Eight — Databases




1) Sorting can make it much e
them into a particular order.

2) A common way to sort nam
This can be done two ways

asier to find the records that you want, by rearranging

esis alphabetically.
— "Ascending’ (A-Z) and ‘Descending’ (Z-A).

3) Numbers can also be sorted in two ways —
‘Ascending’ (small to large), and ‘Descending’ (large to small).

4) Sorting dates in ascending order puts the records from oldest to newest,

and descending order gives you the reverse.

1) You want to sort g table of employees’ information
alphabetically by surname.

2) Click on the field name you want to sort the records with.

In this case it's ‘Surname’.

3) From the ‘Home’ tab, click ‘Ascending’.

n Hew E a8 2%,
=] = ?}
= B @ =-

Refresh Find
ter | ane X Delete - 23~ G-
Bacora Fin

Click to
undo the ®
sorting.

v FirstNeme -/ Job Title = Salary (£)
| Tables 2 i 11 Patricia {Amold | Cleaner 18500 F

= emproyees || 8 Ross 1 Deacon Financial Advisor 26000 M

1 Amands |Gilbert Manager 23000 F

| It 5 Jessica {Hamis' . Cloaner 18500 F
| 4 Claire [Hartley Store Assistant 15000 F

2 James {Humphrey : Manager 23000 M

| 10 Hitesh [Hussan | Store Assistant 19500 M
| 3 Harry {Marsh ‘Store Assistant 13000
13 Patrick |McGinney | Security Guard 19500 1

9 Esra [Patell -Store Assistant 19500 F

7 Kayleigh |Thompson  Accountant 26000 £

{ 12 Dennis {Topper Security Guard 19500 M

I & Arthur [wright

_Area Manager 27000 m
HE H

Feed i el R TR

4) To sort in a different way, click ‘Remove Sort’, then choose 3 new field

and select ‘Ascending’ or ‘Descending’.

| Employeesindg

5) You might want to
sort the employees
by salary, largest
to smallest.

~ Sumame - Job Title

*| Gender -

Clickto Add -

 nbos B2 A 2 B

: Area Manager I 27000 M
= - 8 Ross Deacan Financlal Advisor | 26000 M
3 7 = 7 Kayleigh Thompson  Accountant | 26000 F
6) Se,ect the Safary o5 W 2 James Humphrey  Mansger | 23000 1
>l 1 Amanda Gilbart Manager | - 23000F
. g & 13 Patrick MeGinney  Security Guard 19500
fleld y then CI|Ck 5 1 5 12 Dennis Topper Securlty Guard ; 19500 1
; = : &5 ] e 10 Hitesh Hussan Store Assistant i 12500 M
Descendlng 3 1 5 9 Esra Patell Store Assistant i 19500 F
5 4 Claire Hartley Store Assistant 15000 F
] = 3 Hamy Marsh Stare Assistant | 19000'M
] = 11 Patricia Aenold Cleaner J’ 18500 F

i S Jessica Harris Cleansr |

F etard:
Dtashast View

i S
Gender - Clck toAdd -

QAambimem F2_ 1y

R —— F——
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Filtering allows you to find records that contain certain bits

Example

of data.

1) You want to filter the employees’ information to just display the female

employees.

2) Click on the ‘Gender’ field name, and select ‘Filter’ on the 'Home’ tab.

¢ 1 Employess
D

T - salaryg)
23000
23000
13000

«  First Name -

1 Amanda

2 James

18500
27000
26000

" Gender - Clickto Adé -

18000 -

F
il s
|

“
iCetedt A
iBlanksi

28000

Hussan

Arnold

12 Dennis

Topper Security Guard

13 Patrick KMeGinney Security Guard

loll3 LI Search

3) You'll be given some check boxes to choose from.
Uncheck all of them except ‘F’, then click ‘OK’.

4) You can use a filter to check for mistakes too. For example, selecting
‘(Blanks)’ will show you the records which haven't got any data in the
‘Gender’ field.

5) Click ‘Clear filter from Gender’ on the filter menu to get the full list back.

Open the file called ‘Stocks’, and the table ‘Stocks’.

1)
a) Sort the records alphabetically (A-Z) by author surname.
Save a screen shot of your results with an appropriate file name.
b) Sort the records from most to least expensive.
Save a screen shot of your results with an appropriate file name.
c) Filter the records to show books with only 1 in stock.

Save a screen shot of your results with an appropriate file name.

Section Eight — Databases



You want to use a query to show male employees in alphabetical order.

1) On the ‘Create’ tab, click '‘Query Design’; &

==

Query
Desi

2) Select the table you want to use. =
Your screen will look like this:

‘r@d qraErE : Gk uiol| Employeesindd TR E _E?
___':ugne Creasle  ExemaiData ﬁngums_em:smjﬁf n i I 5k B I
IJE ] =' s{};e #Updste (O Union ‘:'Lfl S lnsert Powis ‘5 Iigert Columns ;;lilPaﬁmettrs
| e P;“ =7 r:r: ApN;d ;m!sish ?Pﬂi—'ﬂlwu—g.i\ s;“-‘ f\r.[ iDglrl:Eo‘ru.m"s o s 5 Property Sheet

- 77 Tavle “Deliete 7 Data Definition | Typra N Builder A3 Return: ANl H

The Employees .’ - B e

table has been || e -

selected for the | I, =
ue : : Fuest Mame =
Y i S o | -

{ ‘ Salary () I

L = -
| ¥ =
|
| o
| e/ B3 Il |
{

3) Double-click the fields you want to sort, filter or display.
Here you need ‘Surname’, ‘First Name’ and ‘Gender’.

4) All the men in the database have an ‘M’ T |aeme__ fitnane .
y 0 ' £ LT Y LB o .
in the Qe_nder field, so‘type M" into st |l —p— S I ——
the ‘Criteria’ box under ‘Gender’: ey e s

on

When searching for a word or letter, type it inside double quofes.

5) You only need to show the names. Uncheck the ‘Show’ box in ‘Gender".

Field: | Surname _ FistName  Gender
Table: |Employees  Employees  |Employses =
Sort: | Ascending

iy S 0/ M S ;M R
Criteria: | N W
or:

6) To sort the men into alphabetical order, click on the ‘Sort’ box under
‘Surname’, then select ‘Ascending’. = Emoioress Y

' Surname - First Name

7) Press the ‘Run’ button on the ‘Query Tools’ tab __Deacon  Ross
to bring up the results in a new table. % ' . Humphrey __lames

: ; " Run __Marsh  Harry
8) To edit your query again, L McGinney  Patrick
click the ‘View’ button on the ‘Home’ tab. L pels
Wright Arthur

v p-Hussan  Hitesh

Section Eight — Databases
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Field: £55|5F}" [E4]

1) To find all the records with data that is equal to a certain value, Table: Employees
use ‘= in the ‘Criteria’ box. Sk | }
For example, finding employees that earn exactly £19 500. (.

Critegiac | =19500

2) Tofind all values less than (but not equal to) a certain value, use the ‘<’ sign.

3) To find all values bigger than (but not equal to) a certain value, use the >’ sign.

4) To find all values that are not equal to a certain value, Lt ot
use the ‘<’ and >’ together like this ‘<>’ Sl

w P,
~ > 23000

For example, finding employees that don’t earn exactly £23 0007 ciene

or:

1) To find all values less than or equal to a certain value, use ‘<’ and ‘=’ together
like this ‘<="in the ‘Criteria’ box.

Field:

. ) Salary [£]
2) To find all values greater than or equal to a certain value, Table:

Emplayees

use ">’ and ‘=’ together like this >='. o -‘,'
3) For example, finding employees that earn £19 000 or less, , Criteri=: |=15000

iy

<2

1) When searching text data, you can use a wildcard to replace letters and symbols.

2) You can use *’ to stand for any number of letters or symbols.
For example, if you searched for ‘A™, you would get records
containing words like ‘A, ‘arm’, ‘Arnold’, and ‘antelope’.

3) You can use “?’ to stand for a single letter or symbol. For example, if you searched
for 'b?t’, you would get results like ‘bit’, ‘bat’, ‘bet’ and ‘but’.

Example

A company wants to view all employees whose surname begins with H.

1) In the criteria for ‘Surname’, type “H*".

The database program Field: Surnams First Mame Salary [£)
Table: |Employies Employees Employees
may add the word Sort:
'Like, as it recognises Shows: R 2 e

Criteria: | Like "H*"
or

this kind of query.

2) Click ‘Run’. You'll get all of the results e ¢ REENamE v Saleyin)

% z Humphrey, lzmes 23000
that begin with H, regardless of how i Loon0
many letters are in the name. === B> iarris Jessica 18500

Hussan Hitesh 19500

Section Eight — Databases
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_And’ Not’and ‘Or’ are called Logical Operators

1) You can use special words like ‘And’, ‘Not’, 'Or’ and ‘Between’ in the ‘Criteria’ box to U
make more complicated queries,

2) Typing ‘Not "cheese" would find all records which are not ‘cheese’.

3) Typing ‘Between 6 And 9’ would find all records with numbers between 6 and 9
(including 6 and 9) in that field.

4) Typing “M" Or "F" in the ‘Gender’ criteria box would find al| the males and females. '

1) Database tables and queries can’t be formatted properly.

_Reports let you Format your Query

2) Instead you can create a report, which can be formatted.

|

1) Select the table or query you want to format, =
and click the ‘Report’ button on the ‘Create’ tab.M

'Repart| i

2) This will automatically create a report for you to format:

md T 2 Module

& Ciass Module

e
g N
& Homlock | SofE e

These broken lines show the printing area.
Resize the boxes so the data fits inside these lines or it won't print,

3) To rearrange boxes, click on them and drag them around.
4) To sort fields, click in the field then use the sort buttons in ‘Home’.

5) To resize a box, click on it then hover over the edge
until the <> symbol appears, then click and drag.

6) To edit the contents of a box, click on it then start typing.
You can't edit the data from the query or table on the report screen.

7) Boxes can be removed by selecting them, then pressing ‘Delete’.
8) To change fonts and colours, use the ‘Format' tap.

9) The ‘Page Setup’ tab allows you to change things like margins,
orientation and paper size ready for printing.
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1) Open the file called ‘Laptops’. Use the table called ‘Laptops’ in the following tasks.

A customer wants a laptop made by Ultrawebb. Create a query to find all of the
Ultrawebb laptops, showing the processor, storage, RAM and price only.

Save the query with an appropriate file name.

A customer is looking for a laptop with more than 700 GB of storage.
Create a query to find all the suitable laptops, showing the manufacturer,
processor, storage, RAM and price.

Save the query with an appropriate file name.

A customer would like a laptop with an i5 processor. Create a query to find
all the suitable laptops, listed in price order (lowest to highest).
Show the manufacturer, storage, RAM and price only.

Save the query with an appropriate file name.

Create a report for each of the queries you made in parts a), c), and e),
then print them off.

2) TellTale Books have asked you to help out with their databases.
Open the file called ‘Books’. Using the table called ‘Books’, do the following:

a)

b)

A customer wants to buy a book as a gift. They want to spend at least £5.99.
Create a query to find a suitable book, showing only the book title, author name,
and price. Order the books by price — lowest to highest.

Save the query with an appropriate file name.

The manager wants a list of all the books released in January 2014.
Create a query to find these books, showing only the book title, author name,
price and release date.

Save the query with an appropriate file name.

A customer is trying to buy a book for their daughter that was released after
January 2014. They can't remember the author’s first name, but think the
surname begins with P. Create a query to find the book they want, showing only
the book title and author name.

Save the query with an appropriate file name.

Create a report for each of the queries you made in parts a), ¢) and e),
then print them off.

Section Eight — Databases




Test-style Tasks -

1) Read any introduction notes and the questions themselves carefully.

2) Make sure you understand:
* what information you need to write on the paper (like your name),
* what files you need to use, where they are and where they should be saved,
* what you need to print out and what the printouts should have on them, and
* any other specific instructions you need to follow.

3) Read the test quickly again at the end to double-check you've done everything.

1) The test is usually made up of a number of tasks based around one main theme.
For example, you might be planning a party. This might involve using the internet,
working on a spreadsheet and producing an invitation in a word processing program.

2) Each task will usually be broken down into steps or questions.
3) Read each task carefully before you start, then go through each step one at a time.
4) Have a go at everything — even just opening a file might help jog your memory.

5) If you really can’t do one step, move on to the next one in that task.
Don’t just skip ahead to the next task — you might miss out on easy marks.

1) Keep an eye on the time — if you're stuck and time is moving on,
move on to the next thing.

2) You can always go back to what you've missed if there’s time at the end.

3) Usually, the greater the number of marks,
the more time you need to spend on that task.

4) So don't spend ages on something that's only worth a couple of marks.

Test-style Tasks




1) In the test you might have to decide what program to complete the tasks in.
2) There is some guidance to help you on page 10.

3) You should also ask your tutor as there might be particular programs your
exam board won't allow you to use.

4) For example, you might be asked to make a poster using a program of your
choice. A word processing or presentation program is suitable,
but your exam board might not accept a file made with a presentation program.

1) It's important to keep saving your work regularly.
2) This means you won’t lose anything if something goes wrong or there's a power cut.
3) Look back at page 18 for more on saving and naming files.

4) Look carefully at where you're told to save files to — if the test doesn’t say where,
then choose somewhere sensible where your tutor will be able to find them easily.

1) Checking your work helps you to spot mistakes or parts of the test you've missed.
2) You should also check that your work looks neat and is appropriate for the task.

3) Check for spelling errors — these could lose you marks.
You can use a spellchecker in some programs (see p. 44 and p. 48).

4) Don't forget to re-save your document if you've made any changes.

Make sure you check any printouts carefully before you hand them in.

« Do they contain all the details needed? For example, you might need to add your
name to every printout otherwise they might not be marked.

« Can everything be read clearly? For example, make sure your search engine
criteria (keywords) can be read. You might need to resize your work so it's larger.

. Does any formatting work? Does it look neat and professional? For example,
if you've used a black and white printer, any colours chosen might not work.

Test-style Tasks
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A friend has asked you to help her organise a charity raffle.
There are three tasks to complete. You will need to:

* work out the cost of the prizes,

* design a poster to advertise the raffle, and

* write an email to Susan about the raffle.

Task A — Work out the cost of the prizes

2. (a)

(b)

3. (a)

Make sure you are sitting comfortably.
Start your computer system.

Open the file called ‘Raffle_Prizes’.

(3 marks)
The cost of the chocolates has increased.
Change the cost of the box of chocolates to £17.
(1 mark)
In cell B11, enter a formula to calculate the total cost of the prizes
in cells B4 to B10.
(1 mark)
Use formatting to make the name of the most expensive prize stand out.
(1 mark)
Use formatting to display the costs of the prizes as currency.
(2 marks)
Save the spreadsheet.
(1 mark)

Total for Task A = 9 marks

Test-style Tasks
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Task B — Design a poster to advertise the raffle

1. (@)  Open the file called ‘Raffle_Info’.
(1 mark)

(b) Use the information given in ‘Raffle_Info’ to make a poster advertising the raffle.
Include the following in the poster:
+ The cost of a raffle ticket.
« The date the raffle is being drawn.
* The prizes that can be won.

»  Where raffle tickets are on sale.

(4 marks)
2 Open the file named ‘Logo_Password’.
Use the password in this file to open the file named ‘Hospice _Logo’.
Insert the logo into a suitable place in the poster.
(4 marks)
20 Use the Internet to find an photo of a garden bench.
Insert the photo into the poster in a suitable place.
(3 marks)
4. (a) Format the layout of the poster to make it look good.
You could use the following:
« font sizes .
+ alignment
. i
ot e +  bullet points
»  bolding, underlining, italics and colour
* page borders (4 marks)
(b) Check the poster is suitable for purpose and contains no spelling errors.
(2 marks)
3. Save the poster.
Print the poster.
(2 marks)

Total for Task B = 20 marks

Test-style Tasks



Task C — Send an email message

i Open the file called ‘Email’.

Read the email in the file.

2. Write a new email replying to Susan’s email.

115

(1 mark)

You worked out the total cost of raffle prizes in your spreadsheet.

Put the total cost of raffle prizes into the email.

Answer the other questions in your reply.

By Check your reply for mistakes.

Print out your reply. (You do not need to send the email.)

4, Shut down your computer system correctly.

End of Entry Level 3 Tasks

(7 marks)

(2 marks)

(1 mark)

Total for Task C = 11 marks

Test-atvla Tacke

e ——
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Task 4 — Poster to advertise the party

Create an A4 portrait poster to advertise the Christmas party to the staff.
(a)  The poster needs to include:

«  Details of the party from the file ‘Party_Details’.

« The address of Eccle Riggs Hall (which you found in Part A, Task 1).

«  Two appropriate graphics from the file ‘Party_Graphics'.

« The logo from the file ‘CGP_Logo'.

The poster must be clear, easy to read and contain no errors.
(13 marks)

(b) Save the poster with a suitable name.

Print out your poster in A4 portrait orientation.
(2 marks)

Evidence

A printout of your completed poster in A4 portrait orientation.

Total for Task 4 = 15 marks

Task 5 — Presentation to senior managers

Create a presentation to show the different food options to the senior managers.
(a) The presentation needs to include:

- Aftitle slide with the title ‘Christmas Party’ and an image from ‘Party_Graphics'.

«  The company logo from the file ‘CGP_Logo’ on every slide.

« A slide with details about the food each supplier would provide from the file
‘Food_Details’.

« Aslide containing the chart you made in Part B, Task 3.

The presentation must contain no errors and have a consistent format.
(12 marks)

(b) Save the presentation with a suitable name.

Print a copy of the presentation slides with two slides on each page.
(2 marks)

Evidence

A printout of your completed presentation with two slides on each page.

Total for Task 5 = 14 marks

Test-style Tasks
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Task 6 — Transport arrangements

Transport to and from the party will be provided for staff who need it.

(a) Open the file ‘Transport’ to see information about the transport for the party.
Matthew Scott no longer needs transport. Edit his record to show this.
Becky Potter can't go to the party. Delete her record from the table.

John Williams has just started working for CGP and needs transport from Broughton.
Add his details to the table.

Take a screen shot of the table.

Insert the screen shot into ‘Evidence_Doc_L1’ and save the document.
(4 marks)

(b) Create a query within ‘Transport’ to find the records of the staff who need transport,
sorted alphabetically by town name.

Show only the names of the staff and the town name.

Create and print a sorted report of the query on a single sheet of A4.
(4 marks)

Evidence
A screen shot of the edited table pasted into the file ‘Evidence_Doc L1’.

A printout of the report on a sheet of A4,

Total for Task 6 = 8 marks

Task 7 — Email your poster

You need to send your poster file to the Production Department for printing.
Tom Woods is the Head of Production.

Write an email to Tom and ask him if the poster looks suitable.

Attach the poster file to the email.

Tom’s email address is tom@cgpbooks.co.uk

Take a screen shot of the email you write. (You do not need to send the email.)

Insert the screen shot into ‘Evidence_Doc_L1' and save the document.
(6 marks)

Evidence

A screen shot of the prepared email pasted into the file ‘Evidence Doc L1’

Total for Task 7 = 6 marks

Test-style Tasks
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Task 8 — Organise your work

You need to organise the files that you've created so they're easy to find.
Create some folders with suitable names and place your files into them.
Take a screen shot to show the folders you've created.

Insert the screen shot into the file ‘Evidence Doc L1'.
(3 marks)

Evidence

A screen shot of the folders created pasted into the file ‘Evidence_Doc_L1'.

Total for Task 8 = 3 marks

Task 9 — Questions

Write the answers to these questions on the dotted line underneath each question.

(a) State one way that a file containing information about the costs of the Christmas party
could be kept private.

(1 mark)
(b) Which of the following is a website address (URL)?
chris@cgpbooks.co.uk
santa.jpeg
www.bbc.co.uk/news
cgpbooks.html
............................................................................................................................. (1mark)

Total for Task 9 = 2 marks

End of Level 1 Tasks

Test-style Tasks
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Wholesome Drinks is a Bristol based company that produce a range of healthy drinks.
They are planning to attend a national food and drink trade show held in Birmingham.
You are going to help organise their trip to the show.

You'll need to access the following files:

* Evidence_Doc L2 * Letter * Costs_And Orders
* Amanda_Harrop * Logo * Schedule_And_Aims
* Buyer_Data * Buyer_Details * Meetings

At the end of the tasks make sure you have printed out all the evidence required, 5
including your completed ‘Evidence_Doc_L2’ file. ?

Make sure your name is clearly written or printed on every printout produced. .

Part A— You can use the internet for this part only.

Task 1 — Travelling to the show

The food and drink show is going to be held at the NEC in Birmingham, UK.

Using the internet, find a train ticket website. Use the website to find the price for
one person to travel tomorrow at any time from Bristol Temple Meads to Birmingham
International, returning at any time on the next day.

Bookmark the web page where you found the ticket price.
Put the following evidence into the file ‘Evidence_Doc L2’
* Ascreen shot(s) showing your search and results.

* The URL where you found the ticket price.

* Ascreen shot showing the bookmarked page.
(6 marks)

Evidence . ?

The correct evidence from your internet research pasted
into the file ‘Evidence_Doc_L2’ — screen shots and URL.

Total for Task 1 = 6 marks

Tt okl T B
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Task 2 — Email about train tickets

Write an email to Amanda Harrop with the details about the train tickets from Task 1.
Add Amanda to your email contacts list using the details from the file about her.
Let Amanda know that you've found the cost of the train.

Give the price for one person to travel to and from the show by
train and the URL of the web page where you found it.

Take a screen shot of the email contacts list entry for Amanda.
Take a screen shot of the email you write. (You do not need to send the email.)

Insert the screen shots into the file ‘Evidence_Doc L2'.
(7 marks)

Evidence

A screen shot of the prepared contacts list entry and
email for Amanda pasted into the file ‘Evidence_Doc_L2'.

Total for Task 2 =7 marks

Part B — You must not use the internet for this part.

Task 3 — Meeting buyers at the show
Wholesome Drinks wants to invite some buyers to meet them at the show.
They only want to invite buyers who have ordered £25 000 or more in the last year.

(a) You have been asked to edit a spreadsheet to calculate the total value of orders for the
buyers in the last year. You have been given a file containing the data required.

Make sure the data is clear and formatted correctly.
(6 marks)

(b) Use a function to automatically show ‘Invite’ if the total value of orders for last year is
greater than or equal to £25 000. “Don’t invite” should show next to all other buyers.

Print out your finished spreadsheet.

Print out a version showing the formulas used.
(8 marks)

Evidence
A data printout of the spreadsheet.

A formula printout of the spreadsheet.

Total for Task 3 = 14 marks

Test-style Tasks
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Task 4 — Invitation to buyers

You need to use mail merge to create letters for the buyers selected in Task 3, which
will invite them to a meeting at the show.

You have been given a file with contact details for each buyer.
You also have a file that contains a template for the letter that you need to prepare.

Each letter must include the Wholesome Drinks logo and the date.
The letter must be easy to read and contain no errors.
Print out a copy of the unmerged letter showing the merge fields.

Print out copies of the merged letters to the ‘Invite’ buyers from Task 3 only.
(12 marks)

Evidence

A printout of the completed unmerged letter showing the merge fields.

Printouts of all of the merged letters sent out to the invited buyers only.

Total for Task 4 = 12 marks

Task 5 — Costs and benefits of attending the show

Wholesome Drinks have been to the food and drink show for the past 5 years.

Create a chart to show the cost of attending the show
and the value of orders taken at each of the shows.

You have been given a file that contains details of these cost and orders.
Make sure the chart is clearly labelled and easy to read.

Print out your chart on a separate sheet.
(7 marks)

Evidence

A printout of your completed chart on a separate sheet.

Total for Task 5 = 7 marks

Test-style Tasks
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Task 6 — Presentation for the sales team

Create a presentation about the show for your manager to present to the sales team.
(@)  The presentation needs to include:

« Atitle slide containing the company logo and a suitable heading.

* Aslide containing the schedule for the day that you have been given.

* Aslide containing the aims for the day that you have been given. Add the total
value of orders generated at the show in Year 5 (2013) to aim number 5.

« The chart you created in Task 5.

« The company name in a footer and the company logo in the top right
of all slides (except the title slide).

* Aslide transition.
The presentation must contain no errors and have a consistent format.
Take a screen shot to show the slide transition. Insert this into ‘Evidence_Doc_L2’.

Print handouts of your presentation with two slides on each page.
(18 marks)

(b) You need to organise the files used to create the presentation so they're easy for your
manager to find.

Create a folder and place all the files you've used and created into it.
Take a screen shot to show the contents of the folder you've created.
Compress (zip) the folder and take a screen shot to show this.

Insert your screen shots into the file ‘Evidence_Doc_L2’.
(5 marks)

Evidence

A screen shot showing the slide transition pasted into ‘Evidence_Doc L2’

A printout of your handouts with two slides on each page.

A screen shot showing the contents of your folder pasted into ‘Evidence Doc L2’

A screen shot showing the compressed folder pasted into ‘Evidence_Doc_L2’.

Total for Task 6 = 23 marks

Test-style Tasks
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Task 7 — Organising meetings

You need to organise meetings with buyers who have confirmed they will be there.

You have been given a file containing the names of these companies, contact names,
and the date and time they're available to meet.

Import the data from the file into a new database table, making sure that each record
has a unique identifier.

Take screen shots to show both the table and the data types assigned to each field.
Insert the screen shots into ‘Evidence_Doc L2’

(6 marks)

Create a query to find the companies available for lunchtime or afternoon meetings
on the 2" of September 2014. Show the companies and meeting slots only.

Take a screen shot of your query criteria and insert it into ‘Evidence Doc L2

Create and print a report of the query on a single sheet of A4.

(6 marks)

Evidence

Screen shots pasted into the file ‘Evidence_Doc_L2' to show:
the imported table, the data types and the query criteria.

A printout of the report on a sheet of A4.

Total for Task 7 = 11 marks

Task 8 — Questions

(a)

(b)

Write the answers tjo these questions on the dotted line underneath each question.

State one keyboard shortcut and describe what it is used for.

(2 marks)

Describe why you might put files into a compressed folder before attaching them to an
email instead of attaching them all separately.

Total for Task 8 = 3 marks
End of Level 2 Tasks

Test-stvle Tacke




Section One — The Basics

Page 6

Q1 Successfully start up and shut
down your computer using the
information on page 4.

It's important to shut down a
computer properly so that you
don't lose or damage data.

Print screen or ‘PrtSen’.

E.g

Input devices: keyboard / mouse
/ scanner / digital camera
microphone.

Output devices: printer / monitor /
speakers / projector.

Both input and output devices: a
touchscreen / a headset.

Q2

Q3
Q4

Page 8

Q1 Enaj2675Boo
This is good because it contains a
mixture of letters and numbers, and
it doesn't contain anything that's
easy to guess.

Q2 Tangerine

Q3 Any one of, e.g: use and run
up-to-date antivirus software /
regularly scan your computer for
viruses / don’t open any files/
email attachments/ or download
anything that might not be safe.

Page 10

Q1 Spreadsheet software.

Q2 Producing slide shows or
handouts for a talk.

Q3 E.g. word processor.
As the document contains text and
graphics word processor is suitable,
but desktop publishing software or
presentation software could be used.

Page 13

Qi 135

Q2 The red and white X' button.

Q3 Jellyfish, Koala and Penguins.
The pictures on your computer
might not be the same as these
— it'll depend on which operating
system you have.

Answers — Practice Tasks

Page 16

Q1 Please see the file called
Section_One.

Q2 Please see the file called
Office_Task_Answer.
A sensible name is one that
describes what is in the document.
For example it might be 'Office Task

Answer' or 'Recycle bin icon'.
Y

Page 17

Q1 Click the ‘Safely Remove
Hardware and Eject Media’ icon,
then click ‘Eject’ for the device
you want to remove.

Page 20

Q1 You should have a document
with a sensible name saved in a
folder called ‘Reading’.
An example of a sensible name for
this document is 'Favourite authors’

Q2 Please see the file called
Bread_Answers.

Page 21
Q1 a) E.g. increase the size of text
[ increase the size of icons /
change the contrast settings.
Any sensible answer as long as it
makes things easier to see.
b) E.g. reduce the speed at which
you need to double-click.
Any sensible answer as long as it
makes the mouse easier to use.

Page 22

Q1 b) E.g. make sure there's plenty
of light where you are working
/ make sure there is no glare
on the screen / change
the monitor’s contrast and
brightness settings.

Page 24
Q1 Please see the file called
Evidence_Answers.

The document should have been
printed in landscape and saved with
a sensible name.

Section Two — The Internet

Page 27

Q1 E.g. car insurance comparison.
You need to include comparison
or a similar word. Only using car
insurance will give you companies
who sell insurance but not
comparison websites.

Q2 a) Kew, Richmond, Surrey

TW9 4DU
You should have carried out a

search with keywords like ‘National

Archives Address.

b) 01299 402114

You should have carried out a
search with keywords like "West
Midlands Safari Park phone

number’

E.g. When on the website, click
the ‘favourites’ or ‘bookmark’
button on the browser tool bar.
He might also need to click
‘Add to favourites’ too.

Q3

Page 29
Q1 a) Any suitable picture of the
mountain with a suitable file
name, e.g. OldMan.jpg.
You should have used keywords
like ‘Old Man of Coniston’. Then
clicked on the images button on the
results page.
b) Any suitable print out of
a screen shot of a search
engine results page showing
keywords (search criteria) and
a map of Lake Windermere.
Please see the file called
Windermere_ Answer.

You should have carried out a
search with keywords like ‘Lake
Windermere map'. Or 'Lake
Windermere' and clicked on the
maps button on the results page.
Make sure you can see the
keywords on your screen shot.
c) 9:30 am till 5:00 pm,

7 days a week.
You should have carried out a
search using keywords like pencil
museum Keswick'. Then found a
page on the website showing the
opening times.




Q2 Please see the file called
Vauxhall_Answer,
Using the OR function means
websites with either or both 'Astra’
and 'Corsa’ will be in the results.
Make sure you can see the
keywords on your screen shot.

Page 32

Q1 Only the box next to “Your
secure banking website’
should be ticked.

Q2 E.g. The UK government
website would be more reliable
because it is likely to be an
official site with up to date
information that you can trust.

Q3 Picture C. It's in the public
domain. The other two have
a watermark and a copyright
notice so you would have
to ask for permission.

Section Three — Email

Page 36

Your answers might look different to the

ones we provide if you are using different

email software.

Q1 Please see the file called
Jane_Email_Answer.

Q2 Please see the file called
IT_Email_Answer.

Q3 Please see the file called
Susan_Email_Answer.

Make sure your email has the wet paint

sign file attached to it.

Page 40

Q1 Please see the file called
Plumber_Email_Answer.

Q2 Please see the file called
Staff_Email_Answer.

In this email you need to have used

three different email addresses: one that

the email is addressed to, one that the

email is Cc'd to and one that the email

is Bec'd to.

Q3 Please see the file called
Contact_Details_Answer.

Your screen shots might look very

different if you're not using Outlook®

email software but you should still have

the same information shown.

Q4 Please see the file called
Joshua_Temple_Answer.

Page 42
Q1 Ascreen shot showing a search

of your inbox for ‘functional skills’.

Q2 a) The emails in your inbox
should be grouped by who
they were sent from.

b) The emails at the top of
your inbox should be from
the sender who is last
alphabetically.

Q3 Please see the file called

Archive1_Answer.

A sensible name for the folder would be

a name involving the year 2012 — this

describes the contents of the folder.

Page 45

Q1 Please see the file called
Email_Security_Answer.

Q2 The email should be addressed
to one of your contacts or
susan@cgpbooks.co.uk. The
greeting at the start of the email
should match with who your sent
the email to. Please see the file
called Sports_Club_Answer.

Q3 Please see the file called
Hotel_Booking_Answer.

The wording of the subject and email

message might be slightly different to

the answer file. This is fine as long

as the subject is sensible (mentions a

booking) and the correct dates (in bold)

are in the message. Your email should
end with "Yours sincerely’ because you're
emailing a named person.

Q4 Please see the file called
Washing_Machine_Answer.

The wording of the subject and email

message might be slightly different to

the answer file. This is fine as long as
the subject is sensible and the correct

part number (in bold) is in the message.

The email should be addressed to 'Sir/
Madam'. Your email should end with
Yours faithfully’ because you're not
emailing a named person.

Section Four — Word
Processing

Page 49

Q1 Please see the file called
Typing_Answers.

Q2 Please see the file called
Amazon_Answers.

Q3 Please see the file called
Invitation1_Answers.
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Page 51

Q1 Please see the file called
Invitation2_Answers.
Your print outs should have two
invitations side by side per page.

Page 52

Q1 Please see the file called
Gym_Answers.
Your header boxes can be
any colour.

Page 54

Q1 Please see the file called
Internet_Answers.
Your print outs should look like
these pages.

Q2 Please see the file called
Invoice_Answers.
You should only have printed
inveices for Mrs Jones, Mrs Strauss
and Mr Butson.

Page 59

Q1 Please see the file called
Gym_Leaflet_ Answers.
Your page doesn't have to look
exactly like this, but it should
contain these three images as they
are the most suitable ones.

Q2 Please see the file called
Diet_Answers.

Q3 Please see the file called
Bike_Answers.
The two most suitable images are
the bike and castle. You should
have cropped the left-hand side out
of the bike photo and rotated it so
it sits nicely. The castle should be
rotated 180° or flipped vertically.
You should have only printed page
two — the voucher.

Q4 Please see the file called
Logo_Answer.
Your logo doesn't need to look
exactly like this, but it should look
very similar to the sketch.

Answers — Practice Tasks
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Page 63

Q1 Please see the file called
Poster_Answers.
Your poster doesn't need to look
exactly like this, but it should:

+  contain all the text from the
file 'Poster’,

. fit neat!y onto one page,
+  have a title that stands out,

*+ contain the 'sofa’ graphic in a
suitable place.

You should also have used some of
the formatting techniques
mentioned in part c).

Q2 Please see the file called
Swimming_Answers.
Your poster doesn't need to look
exactly like this, but it should:

*  be A4 landscape,

+  have all of the features in the
correct places as shown by the
plan,

*  use the text and map from
the file 'Swimming),

*  have a suitable image inserted
in the correct place — this
shouldn't be watermarked and
should have a credit if needed,

*  use formatting features
such as different font sizes
and styles, colour, bolding,
underlining or italics, bullet
points, text alignment, etc.

You should also have corrected the

spelling mistake of 'reely’ in the text.
Q3 Please see the file called

Pub_Answers.

Your leaflet doesn't need to look

exactly like this, but it should:

+ contain all of the text from
page one of the file 'Pub’, with
any spelling mistakes
corrected,

*  use the first and third
graphics from page two as
these are the most suitable
ones, placed in a suitable
position,

+  use one block of text from
section two of page two,
(see next column for more)

Answers — Practice Tasks

*  use the house photo from
the third section of page two
as this is the most suitable,
placed in a suitable position,

+  use formatting features such
as different font sizes and
styles, colour, bolding,
underlining or italics, bullet
points or numbered lists,
borders, text alignment, etc,

*  have a nice balance of text,
graphics and white space.

Section Five — Spreadsheets

Page 67
Q1 See the file called
Gino_ Answers.
Q2 See the file called
Luxury_ Answers.
Q3 See the file called
Letting_Answers.
Make sure you adjust the column
widths to make all the data easy to read.

Page 70

Q1 See the file called
Bridgeshire_Answers.

Q2 See the file called
Leekton_Answers.

The title doesn't have to look exactly

like this, but it does need to have some

formatting used to make it stand out,

e.g. bolding, italics, coloured text or

coloured background.

Page 73

Q1 See the file called
Wash_Answers.

b) and ¢)

A suitable formula for cell D2
would be =B2*C2. Then copied
into cells D2 to D8.

d) A suitable formula for cell D9
would be =SUM(D2:D8).

Q2 See the file called Loan_Answers
and Loan_Formula_Answers.

a) A suitable formula for cell D2
would be =B2-C2. Then copied
into cells D2 to D10.

b) A suitable formula for cell B11
would be =SUM(B2:B10). Then
copied into cells B11 to D11.

Abbey Little's name doesn't have to be

exactly like this, but it does need to have

some formatting used to make it stand
out, e.g. bolding, italics, coloured text or
coloured background.

Page 77

Q1 See the file called
Phones_Answers.

A suitable formula for cell B16 would be

=MIN(B2:B14). A suitable formula for

cell B17 would be =MAX(B2:B14). A

suitable formula for cell B18 would be

=AVERAGE(B2:B14).

Q2 See the file called
Holidays_Answers and
Holidays_Formula_Answers.

a) A suitable formula for cell C4
would be =$C%$2-B4. Then copied
into cells C4 to C13.

b) A suitable formula for cell D4
would be =IF(C4>=75"Yes""No").
Then copied into cells D4 to D13.

Page 79

Q1 See the file called
Sales_Answers.

Q2 See the file called
Interview_Answers.

Section Six — Charts
and Graphs

Page 82

Q1 Please see the file called
Farms_Answers.

Your labels should describe what the

axes show. If's sensible to use any

column titles already given. Units are

needed here (tonnes).

Q2 Please see the file called

Theme_Park_Answers.

Your chart may look different to this.

The title and labels should describe what

the chart and axes show. It's sensible

to use any column titles already given.

Units are needed here (thousands). You

will have needed to move your chart so

the data and chart could both be seen

on the print out.

Page 84

Q1 Please see the file called
Sales_Answers1 for the answers
to a) - c) and Sales_Answers2 for
the answers to d) and €).

Q2 Please see the file called
Shop_Answers.

Your chart may look different to this.

The title and labels should describe what

the chart and axes show.



Page 86
Q1 Please see the file called
Wash_ Answers1 for a) and b)
and Wash_Answers2 for c)
and d).
Your chart may look different to this.
Any labels should describe what the data
and axes show.
Q2 Please see the file called
Factory_Answers.
Your chart may look different to this.
The title and labels should describe what
the chart and axes show.

Page 88
Q1 Please see the file called
Electronics_Answers.
Your chart may look different to this.
The title should describe what the chart
shows. Make sure all the categories
show in the legend.
Q2 Please see the file called
Population_Answers1 for
the answers to a) and b) and
Population_Answers2 for the
answers to ¢) and d).
Your chart may look different to this.
The title and labels should describe what
the chart shows.

Section Seven —
Presentations

Page 89

Q1 a) Any two from, for example:
text / images / video / sound /
animations.

b) For example, showing the

audience the information
can make the talk easier to
understand / it can help to
make the key points stand out /
it can help you remember what
to say.

Pages 92-93

Q1 Please see the file called
Motors_Answers.

Your print out should have two
slides on each page.

Q2 Please see the file called
Holiday_Answers.

Q3 Please see the file called
Yourself_Answers for an
example.

Your presentation doesn't have to
look exactly like this, but it should:

* have four slides,

* have your name and an image
on the title slide,

* have four facts about you and
a suitable header on slide 2,

* have info. about where you
live and a header on slide 3,

*  say what your interests are
and have a header on slide 4,

* have your name in a footer on
every slide, and

*  your print out should have
two slides per page.

Page 95

Q1 Please see the file called
Olympics_Answers.

Q2 Please see the file called
Pyramids_Answers.

Q3 Please see the file called
Technology_Answers.

Pages 98-99

Q1 Please see the file called
Capitals_Answers.

Q2 Please see the file called
Rome_Answers for an example.

You may have used different animations

and transitions to the ones in the answer

document.

Q3 Please see the file called
Safari_Answers.

Q4 Please see the file called
Circus_Answers for an example,

You may have used different animations

and transitions to the ones in the answer

document,
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Page 101
Q1 Please see the file called
Profit_Answers.

Your presentation doesn't need to
look exactly like this, but you should
have:

*  increased the size of the titles
on slide 2 and 3,

* moved the chart on slide 2 <o
it didn't overlap the text,

' corrected the spelling mistakes
of tagret' and pmofit’
Q2 Please see the file called
Coffee_Answers.
Your presentation doesn't need to
look exactly like this, but you should
have:

* used formatting features such
as different font sizes and
styles,

*  moved or re-sized graphics so
they were appropriate and not
overlapping any text,

' corrected any spelling
mistakes.
Q3 Please see the file called
Recruitment_Answers.
Your presentation doesn't have to
look exactly like this, but it should:

* have four slides, including a
title slide,

*include all the text from the
file 'Recruitment_Text' in
appropriate places,

* include some suitable Images
from the file
Recruitment_Images' in
appropriate places,

* use formatting features such
as different font sizes and
styles, colour, bolding,
underﬁning or italics, bullet
points, etc.

Anaware __ Deantima Teal._
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Section Eight — Databases
Page 104

Q1

Q2

Please see the file called
Orders, and the table Orders.
The data types you should have

are: ID AutoNumber
First Name Text
Surname Text
Amount Due  Currency
Order Date Date/Time

Please see the file called Orders,
and the table MoreOrders.

The data types you should have

are: ID AutoNumber
First Name Text
Surname Text
Amount Due  Currency
Order Date Date/Time
Paid? Yes/No

The field 'Paid?’ could have the
data type of text, but Yes/No is far
more accurate and easier to use. It
sometimes appears as a tick box.

Page 106

Q1

Please see the file called
Stocks_Answers.

Page 110

Q1

Please see the file called

Laptops_Answers.

a) See the query Ultrawebb.
You should have used the
criteria “Ultrawebb” in the
‘Manufacturer’ field.

c) See the query
More than 700 GB.

You should have used the
criteria =700 in the ‘Storage’
field.

e) See the query i5.

You should have used the
criteria “i5” in the 'Processor’
field, and set the sort to
‘Ascending’ in the ‘Price’ field.

g) See the reports on
Laptops_Answers.

Make sure the fields are resized to

fit neatly onto one page and that

the reports are clear and easy to
read. Totals should be removed
from the price column as they aren't
useful in these reports.

Answers — Practice Tasks

Q2 Please see the file called

Books_Answers.

a) See the query At least £5 99.
You should have used the
criteria >=5.99 and the sort
‘Ascending’ in the 'Price’ field.

c) See the query
January Releases.

You should have used the
criteria Between 01/01/2014
And 31/01/2014 in the
‘Release Date'’ field.

Your database program may

automatically change this to

Between #01/01/2014# And

#31/01/2014#, but this is still

correct.

e) See the query Surname P.
You should have used
the criteria “P*” in the
‘Author Surname’ field, and
>=01/02/2014 in the
‘Release Date’ field.

Your database program may

automatically change "P*" to

Like "P*", but this is still correct.

The date may automatically change

to #01/02/2014#. Also accept

>31/01/2014 as the criteria.

g) See the reports on
Books_Answers.

Make sure the fields are resized to

fit neatly onto one page and that

the reports are clear and easy to
read. Totals should be removed
from the price column as they aren't
useful in these reports.




Entry Level 3 Tasks (Pages 113-115)
Task A — Work out the cost of the prizes

Please see the file called Raffle_Prizes Answers.

1 Work area checked and adjusted as required.
E.g. change the height or position of chair (1 mark).
Computer system started correctly (1 mark).
‘Raffle_Prizes' file opened correctly (1 mark).

2 a) Chocolate cost changed to 17 (1 mark).
b) Formula added into cell B11. Either =SUM(B4:B10)

or =B4+B5+B6+B7+B8+B9+B10 (1 mark).

Here you need to use a formula that works out the total

cost of all the raffle prizes, so using Autosum is sensible.

3 a) Formatting of cell A6 (2 night hotel stay) changed
so that it stands out (1 mark). Examples
of acceptable formatting — bolding, italics,
underlining, coloured text or box background.

b) Cells B4:B11 formatted to currency (Maximum of 2
marks. 1 mark if not all the cells are formatted
correctly or the £ symbol has been missed or
two decimal places are not used.)

4 Spreadsheet saved using a suitable name (1 mark).

A suitable name describes what the file contains, for

example, ‘Raffle Spreadsheet' or 'Raffle Prizes Altered’

Task B — Design a poster to advertise
the raffle

Please see the file called Raffle_Poster_Answers for
an example poster.
1 a) ‘Raffle_Info’ file opened correctly (1 mark).
b) A poster has been created that contains: the cost of
a raffle ticket, the date the raffle is being drawn, the
prizes that can be won and where raffle tickets are
on sale (Maximum of 4 marks, lose 1 mark for
each piece of information missed out).
2 ‘'Logo_Password' file opened correctly (1 mark).
‘Hospice_Logo' file opened correctly (1 mark).
Logo inserted into the poster (1 mark) in a sensible
position (1 mark).
The logo mustn't block any text or overlap the edge of the j
page, and it should be fully visible when printed.

3 Aphoto of a garden bench has been found using a
simple internet search (1 mark). Photo inserted into
the poster (1 mark) in a sensible position (1 mark).
Any photo of a garden bench is suitable. The photo
mustn't block any text or overlap the edge of the page,
and it should be fully visible when printed.

4 a) The poster has been formatted using features such
as: font sizes, font styles, colour, underlining, bold
or italics, alignment, bullet points, page borders,

(1 mark for each different feature up to 4 marks)
b) The poster should contain accurate information that

matches that in the file ‘Raffle_Info’ (1 mark).

A spell check should have been run to identify and

correct any spelling errors (1 mark).

| 5 The poster has been saved using a suitable name
(1 mark) and printed out (1 mark).

A suitable name describes what the file contains, for
example, 'Raffle Poster’

Task C — Send an email message

Please see the file called Email_Answers for
example emails.
‘Email’ file opened correctly (1 mark).
2 The email is addressed to
susan@cgpbooks.co.uk (1 mark). A sensible
subject line is used (7 mark). The email starts and
ends appropriately (1 mark).
Question 1 answer: £654 (1 mark).
If you got the total cost of the raffle prizes wrong in
Task A and used that cost here youlll still get the mark.

Question 2 answer: Any two sensible answers from
information listed on page 22. For example, adjust
the height of your chair so that you're at the correct
height for using the keyboard comfortably OR adjust
your chair so your feet are resting on the floor OR
adjust your seating arrangements so you don't have
to stretch for things like the mouse OR adjust your
screen to a comfortable height (1 mark for each
suggestion up to 2 marks).
Question 3 answer: E.g. to stop viruses from
damaging your computer OR to stop viruses from
slowing your computer down OR to stop viruses from
stealing information from your computer (1 mark for
any sensible suggestion).

3 Email checked for errors (e.g. by running a spell
check) (1 mark). Email printed out (1 mark).

4 Computer system shutdown correctly (1 mark).

=5

Level 1 Tasks (Pages 116-120)
Part A
Task 1 — Eccle Riggs Hall

Please see the file called
Evidence _Doc L1_Answers.

In the file 'Evidence Doc L1’ you should have:

A screen shot of the search and results (1 mark).
Keywords must be visible and include Eccle Riggs
and address (1 mark).

The address: Eccle Riggs Hall, Broughton-in-
Furness, Cumbria, LA20 6BN (1 mark).

URL given for the website where the address was
found (1 mark).

Its really important that your screen shot is large
enough for the assessor to read your keywords.

Part B
Task 2 — Costs of the party

Please see the files called Party_Costs_Answers

and Party_Costs_Formulas_Answers.

a) ‘Party_Costs’ file opened correctly (1 mark).
Formula to work out total cost of drinks added into
cell D4: =B4*C4 (1 mark).

Answers — Test-style Tasks
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Formula to work out total cost of transport added
into cell D5: =B5*C5 (1 mark).
Here the formulas needed to multiply the cost per person
by the number of people to give the total cost.

Formula for total cost of party added into cell D11.
Either =SUM(D4:D9) or =D4+D5+D6+D7+D8+D9
(1 mark).

b) All of the costs in column D formatted to currency
with a £ symbol and two decimal places (1 mark).
Widths of all columns adjusted to see all the data in
them (1 mark). Formatting of the spreadsheet in at
least one way, for example borders added, column
headings highlighted somehow, total cost of the
party highlighted somehow (1 mark).

When you're asked to format a spreadsheet think

currency, width and highlighting (e.g. bold and colour).

c) Spreadsheet printed with formulas shown (1 mark).

Task 3 — Party food

Please see the file called Food_Suppliers_Answers.

a) ‘Food_Suppliers’ file opened correctly (1 mark).
Data altered to ascending order by numbers in
column D (1 mark). Data in columns Aand D
(Supplier and Total) used to make a column (bar)
chart (1 mark).

A line graph is OK but it's not the most sensible one

here. A pie chart or scatter graph isn't suitable.

The chart must have a suitable title mentioning
‘suppliers’ and ‘total cost’ or ‘quote’ (1 mark).
X-axis must have a suitable label (1 mark).
Y-axis must have a suitable label (1 mark).
Chart legend deleted (1 mark).
The legend is made automatically, but it isn't needed when
there's only one set of data like here.

The chart makes sense and there are no
unnecessary data or spelling mistakes (1 mark).
The chart is printed on a separate sheet in
landscape orientation (1 mark).

Please see the files called Task 3 chart and

Evidence _Doc L1_Answers.

b) A word processing file called ‘Task 3 chart’ should
be saved somewhere sensible (1 mark).
The file called 'Task 3 chart’ should contain a copy
of the chart created in part a) (1 mark).
In the file ‘Evidence_Doc_L 1" you should have a
screen shot to show that the file ‘Task 3 chart'is a
read-only file (1 mark).

Task 4 — Poster to advertise the party

Please see the file called Party_Poster_Answer for an

example poster.

a) Suitable program used to create poster. For
example, Microsoft®Word® or Publisher® (1 mark).
Details of the party from the file ‘Party_Details’
included in the poster (1 mark). Address from Part
ATask 1 included (1 mark).

If you got the address wrong in Task 1, but used that

address here you'll still get the mark here.

Answers — Test-style Tasks

Two suitable graphics from 'Party_Graphics’
inserted into the poster (not the lily or stone
heads) (7 mark), in a suitable position and size
(1 mark). Logo has been inserted into the poster
(1 mark) in a sensible position (1 mark).
The logo and graphics mustn't block any text or overlap
the edge of the page, and they should be large enough
to print nicely.
Poster fits onto one A4 page (1 mark).
Font size and style appropriate for a poster
(e.g. point 16 at least) (1 mark).
Formatting used to attract attention, for example:
title in large font, different font sizes and styles
used, colour, underlining, bold or italics, different
alignments, bullet points, page borders (1 mark
for each different feature used, up to 3 marks).
A spell check should have been run to identify and
correct any spelling errors (1 mark).
b) The poster should have been saved with a
suitable name (1 mark).
The poster printed out A4 portrait (1 mark).

Task 5 — Presentation to senior managers

Please see the file called

Food_Presentation_Answer for an

example presentation.

a) Suitable program used to create the presentation
For example, Microsoft®PowerPoint® (1 mark).
The presentation contains three slides (as
described in the task) (1 mark).

The first slide (title slide) contains the title
Christmas Party (1 mark) and a suitable image
from the file ‘Party_Graphics’ (not the lily or stone
heads). (1 mark).

Logo has been inserted into each slide (1 mark).
Logo and graphic are inserted in a sensible
position (1 mark).

The logo and graphic mustn't block any text or overlap

the edge of the slides and they should be a suitable size.
One slide contains the chart from Task 3 (71 mark).
One slide contains information from ‘Food_Details’
(1 mark).

A suitable font style and size used for title slide

(1 mark). Non-title slides should have suitable
titles that describe the content (1 mark).

A spell check should have been run to identify and
correct any spelling errors (1 mark).

The presentation has a consistent format
throughout (1 mark).

This means the same fonts, similar font sizes, same

backgrounds (if any have been used) and there's a

consistent look throughout the presentation.

b) The presentation should have been saved with a
suitable name (1 mark).

For example, 'Christmas Party Presentation’

The slides should have been printed out with two
slides per page (1 mark).



Task 6 — Transport Arrangements

Please see the file called
Evidence_Doc_L1_Answers.
a) A screen shot shows all records and:
Check-box in the ‘Need Transport?’ field unchecked
in Matthew Scott's record (1 mark).
Becky Potter's record (ID 15) deleted (1 mark).
New record added with correct data in the following

fields:  First Name John
Surname Williams
Town Broughton
Need Transport? Checked

(2 marks for all correct, 1 mark for 3 correct. )
b) Printed report fits onto one A4 page (1 mark).
Report shows ‘First Name’, ‘Surname’ and
‘Town’ only (1 mark). Report only contains the 14
records with a check in the ‘Need Transport?’ field
(1 mark). Records sorted alphabetically by town
(1 mark).
Task 7 — Email your poster
Please see the file called
Evidence_Doc_L1_Answers.
Email addressed to tom@cgpbooks.co.uk (1 mark).
A sensible subject line is used (including the word
‘poster’) (1 mark). The poster file is attached to
the email (1 mark). The email message contains a
question asking if the poster is suitable (1 mark).
The email starts and ends appropriately and has a
suitable business tone (7 mark).
A suitably-sized screen shot of the email has been
added to the file ‘Evidence_Doc_ L1’ (1 mark).

Task 8 — Organise your work
Please see the file called
Evidence_Doc_L1_Answers.

Different folders created to store work files (1 mark)
with suitable names (1 mark).

Suitable names should describe the contents of the folder,
for example, "Party Poster Files' or ‘Task 4_Party Poster.

A suitably-sized screen shot of the folders has been
added to the file ‘Evidence_Doc_ L1’ (1 mark).

Task 9 — Questions
a) The file could be password-protected (1 mark).
b) www.bbc.co.uk/news (1 mark).
Web addresses (URLs) start with www or http or https.
Email addresses usually have an @ in them. Jpeg and
html are file extensions for a graphic and a web page.

Level 2 Tasks (Pages 121-125)
Part A
Task 1 — Travelling to the show

Please see the file called
Evidence_Doc_L2_Answers.

In the file ‘Evidence_Doc L2’ you should have:

A screen shot of the internet search engine keywords
and results (1 mark) and screen shot(s) of a page
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showing the price of the return ticket (1 mark).
Suitable keywords used (1 mark) including
advanced search notation (*, *, OR or AND)

(1 mark).

URL given for the website where the ticket price was
found (7 mark). A screen shot of the bookmarked
page showing the ticket price (1 mark).

Task 2 — Email about train tickets

Please see the file called

Evidence_Doc_L2_ Answers.

Email addressed to a.harrop@gmx.co.uk (1 marky).
A sensible subject line is used (e.g. uses the words
train tickets, prices, show) (1 mark). The URL of the
ticket web page and a price is in the email (1 mark).
The URL doesn't need to be 2 link, and the price can be
different to the one given here.

The email starts and ends appropriately and has a
suitable business tone (1 mark).

Emails should always have a suitable subject line and
start and end with greetings like Dear and Best wishes.

A suitably sized screen shot of the email has been
added to the file ‘Evidence_Doc_L2' (1 mark).

A suitably sized screen shot of the contact details
given for Amanda added to the file ‘Evidence Doc_
L2' (1 mark). The contact details match those given
in the file ‘Amanda_Harrop’ sowing the file has been
opened correctly (1 mark).

Part B
Task 3 — Meeting buyers at the show

Please see the files called Buyer_Data_Answers and

Buyer_Data_Formula_Answers.

a) '‘Buyer_Data’ file opened correctly (1 mark).
Formula for total value added into cell H2. Either
=SUM(B2:G2) or =B2+C2+D2+E2+F2+G2
(1 mark). Correct formula also in cells H3 to H8
(1 mark).

All of the values in column B-H formatted to
currency with a £ symbol and two decimal places
(1 mark). Widths of all columns adjusted to see
all the data in them (1 mark). Formatting of the
spreadsheet in at least one way, for example
borders added, column headings highlighted
somehow, buyers to invite highlighted somehow
(1 mark).

When you're asked to format a spreadsheet think

currency, width and highlighting (e.g. bold and colour).

b) IF formula entered in cells 12 to 18
=IF(H2>=25000,"Invite","Don’t Invite") (1 mark).
Correct cell selected in IF function (total order
amount — H2) (1 mark). Correct use of greater
than or equals symbol (1 mark). Correct value
of 25000 (1 mark). Correct words appearing
when IF function is true and false (1 mark).

Invite showing in column | for Samuels, Drinks
Wholesale, United Drinks Distribution and
Cheesemans (1 mark). Spreadsheet printed with
all data clearly showing (1 mark). Spreadsheet
printed with all formulas clearly showing (7 mark).

Answers — Test-style Tasks
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Task 4 — Invitation to buyers

Please see the files called Letter_Field_Answers
and Letter_Final_Answers.

‘Letter’ file opened correctly (1 mark). ‘Logo’ file
opened correctly (1 mark) and logo inserted into
a suitable position in the letter (1 mark). The date
added to the letter in a suitable position (1 mark).
A spell check should have been run to identify and
correct any spelling errors (1 mark).

File ‘Buyer_Details’ opened correctly and used to
supply data for mail merge (1 mark).

Correct merge fields added to letter in the correct
places (3 marks for all correct, 2 mark for 8
correct, 1 mark for 5 correct).

Letter printed showing merged field names

(1 mark).

Letters correctly merged and printed out to buyers
that are being invited to the show only — Samuels,
Drinks Wholesale, United Drinks Distribution and
Cheesemans (2 marks for all correct letters, 1
mark if 2 correct. Allow follow through of any
incorrect buyers from Task 3).

Task 5 — Costs and benefits of attending
the show

Please see the file called
Costs_And_Orders_Answers.

‘Costs_And_Orders’ file opened correctly (1 mark).
Bar/column chart or line graph produced with two
bars (or two lines) for each year (1 mark).

All data given used in the chart (1 mark).
Appropriate title for chart that contains mention of
costs and orders and that it shows data for 5 years
(1 mark). Appropriate axis labels used (1 mark).
Legend is used (1 mark) and labels are correctly
spelt (1 mark).

Task 6 — Presentation for the sales team
Please see the files called Evidence_Doc_L2
and Show_Presentation_Answer for an example
presentation.

a) Suitable program used to create the presentation
For example, Microsoft®PowerPoint® (1 mark).
The presentation contains a title slide with a
suitable header (1 mark) and company logo
(1 mark).

A suitable header could mention the following: 'Food

and Drink Show', 'Birmingham' or ‘NEC.

A slide containing accurate schedule information
from the file ‘Schedule_ And_Aims’ (1 mark).

A slide containing accurate aims for the day
imported from the file ‘Schedule_And_Aims’

(1 mark). Aim 5 should have had figure of

£9 900 added into brackets (from Task 5)

(1 mark). A slide containing the chart from Task
5 correctly inserted in a sensible place (1 mark).
Graphics used are in suitable locations on all the
slides (e.g. not in way of other text) (1 mark).

All slides (except title slide) have the company
logo present at a suitable size in the top right of
the slide (1 mark).

Answers — Test-style Tasks

The logo on title slide should be larger than the logos on
each of the other slides in the presentation.

All slides (except title slide) have a footer (1 mark)
that says ‘Wholesome Drinks' (1 mark).
There is evidence of a slide transition set being
used (1 mark). A suitable font style and size used
for title slide (1 mark). Non-title slides should have
suitable titles that describe the content (1 mark).
A spell check should have been run to identify
and correct any spelling errors (1 mark). The
presentation has a consistent format (1 mark).
This means the same fonts, similar font sizes, same
backgrounds (if any have been used) and there's a
consistent look throughout the presentation.

In the file ‘Evidence_Doc_L2’' you should have a
screen shot showing a slide transition (1 mark).
The slides should have been printed out with two
slides per page (1 mark).

b) A folder created (1 mark) and sensibly named to
describe what is in it including the presentation
(1 mark). A compressed (zipped) folder also
created (1 mark). In the file ‘Evidence_Doc_L2’
you should have a screen shot showing the
contents of the folder (1 mark) and a compressed
folder with a similar name (1 mark).

Task 7 — Organising meetings

Please see the file called

Evidence_Doc_L2_Answers.

a) A screen shot shows field names imported into
table with no errors (1 mark).
The screen shot shows data imported into table
with no errors (1 mark).
A screen shot shows a unique identifier (ID) has
been assigned (1 mark).
The screen shot shows that the ‘Date’ field has
been set to ‘Date/Time' (1 mark) and all other
imported fields set to ‘Text' (1 mark).

b) A screen shot shows #02/09/2014# as the criteria
for ‘Date’ (1 mark).
The screen shot shows either “Lunchtime” Or
“Afternoon”, or Not “Morning”, as the criteria for
‘Meeting Slot' (2 marks for criteria met correctly,
1 mark if criteria returns only one of either
“| unchtime” or “Afternoon”).
The printed report fits onto one page, and is easy to
read (1 mark).
The printed report shows ‘Company’ and ‘Meeting
Slot' fields only (1 mark).
The printed report shows the correct 7 records,
for the following companies: Samuels, Drinks
Wholesale, Slurpers, Great British Drink Co.,
HWPD, Sapor and Juice Distributors (1 mark).

Task 8 — Questions

a) Any keyboard shortcut (1 mark) and correct
explanation (1 mark). See page 16 for sensible
suggestions.

b) To reduce the size of the email / to reduce the time
it takes to send the email (1 mark).



_ Glossary.

Address bar

The bar in a browser window where you enter
web addresses or URLs.

Alignment

A way of formatting text so it lies to the
left-hand side of a page, to the right-hand side,
is justified or is centred in the middle of a page.

Antivirus software
A program used to protect a computer from
viruses.

Application software

The programs on a computer, like word
processors, email and database programs.

Attachment

A file that is sent with an email. For example,
graphics can be sent as email attachments.

Axis
A line along the bottom and up the left-hand
side of most graphs and charts.

Bar chart

A chart which shows information using bars of
different heights.

Bcc

A way of sending a copy of an email to
someone privately. Only the sender of the
email can see who an email has been Bcc'd to.

Blog

A website where people can write their opinions
for others to read. Blog is short for ‘web log'.

Bold text
Text with thick lines, like this: bold.

Bookmark

Alink to a website, stored on your computer for
easy access.

Border

The outline given to something, like a cell or
document, to make it stand out.

Browser

Software used to access web pages and the
internet.

Cc

A way of sending a copy of an email to
someone. Everyone that receives the email
can see who the email has been Cc'd to.

Cell

Arectangular box in a spreadsheet where one
piece of data can be stored.

Cell reference

A letter and number which describes where a
cell is in a spreadsheet. The letter describes
the column, the number describes the row.

Click

In this book, this means click on something with
the left mouse button.

Clip art

A ready-made image gallery found in some
programs, like Word®, or on the internet.

Column chart
See ‘Bar chart'.

Compressed file or folder

Afile or folder that has been compressed
(zipped) to reduce its size.

Control panel

An area of your computer where you can
change settings like screen resolution and icon
size.

Cropping
Cutting the edges off a graphic.

Cursor

A flashing black bar showing where text will be
entered.

Glossary
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Social media

Websites which allow people to stay in touch
with lots of other people.

Software
See ‘Application software’.

Sorting data

Arranging data into a certain order.
For example, alphabetically (A-Z).

Spam
Emails that you receive that aren’t from people
you know and that you haven’t asked for.

Spreadsheet software

Software which stores data in cells that are
organised in rows and columns. Spreadsheet
programs can also carry out calculations with
the data.

Start button

Used to open the Start Menu. Often found in
the bottom left of a desktop.

Tab (on a toolbar)

A type of button found at the top of some
software screens that opens different toolbars
when clicked.

Taskbar

The row of buttons usually found at the bottom
of the desktop.

Text wrapping

The way text is organised around a graphic or
shape in some documents.

Toolbar

A row of useful buttons found at the top of
some software windows.

Transition

An effect you can add to slides in
presentations. Transitions are how new slides
appear during the slide show. For example,
flying in, or fading in.

Troll

Someone who uses the internet to upset or
harass others.

Glossary

Unique ldentifier

Afield in a database which is different for every
record, such as an |ID number.

URL

The address of a web page or website.
Also called a web address.

Validation rule

A rule that stops certain data from being
entered into a database table. Often used to
prevent mistakes. For example, allowing only
‘yes’ or 'no’ in a field.

Virus

A harmful program made to infect computers.
They can make things stop working, make the

computer run slower or steal information from
the computer.

Web browser

See ‘Browser'.

Web page

A document located on the internet.

Website
Lots of web pages linked together.

Wildcard

A symbol used in searches that can stand for
any character or characters.

Word processor

Software that lets you edit and format text

and graphics. It can be used to create letters,
posters, leaflets, articles, newsletters, invoices,
etc.

Zipped (compressed) file or folder
See ‘Compressed file or folder’.
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absolute cell references 75
animations 97

antivirus software 8
application software 9
attachments 35

AutoSum 72

axes 80

B

bar charts 83
Bcec 38
bookmarking 25
browsers 25
bullet points 48

C

Cc 38

charts 80

click 5

column charts 83

compressed (zipped) files
and folders 20

contacts lists 37
control panel 21
copy 15
copyright 30

creating files and folders
20, 21

creating folders for emails 42
cropping graphics 56
cursor 5

cut 15

D

databases 102

deleting files and folders 20
desktop 11

double-clicking 5

drawing graphics 58

email addresses 33

email attachments 35
emails 33

forwarding 34

inbox 33

replying 34

sending 34

writing 44

evidence (of your work) 23

F

fields (in databases) 102
file extensions 18
filtering data

in databases 106

in spreadsheets 79
folders 19
formatting

in presentations 94

in spreadsheets 68, 69

in word processing 46
formulas 71
forwarding emails 34
functions 74

G

graphics (in word processing)
55

graphs (charts) 80
group distribution lists 39

H

hardware 4

icons 11

IF function 76
importing data

into databases 104
into spreadsheets 65
input devices 6
internet 25

K

keyboards 5
keywords 26

L

labels (for graphics) 57

laptops 3

leaflets (creating) 62

legends (on charts and
graphs) 82

letters (creating) 62

line graphs 85

line spacing 48

logging on and off 4

logical operators 109

M

mail merge 53
margins 50
master slides 98
memory sticks 17
merging cells 68
mouse 5

N

naming files 18
netbooks 3

notebooks 3

numerical formatting 69

Index
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O

Office® 2010 1

Office® features 14
operating systems 9
operators

in databases 108

in spreadsheets 76, 77
internet use 29
orientation 50

output devices 6

P

page borders 51

page numbers 50
passwords 7, 18
paste 15

PCs 3

pen drives 17

pie charts 87

pointers 5
presentations 89
primary keys 103
printing 15

charts and graphs 82
databases 109
presentations 92
spreadsheets 70
word processing files 51
programs (software) 9

Q

queries 107

Index

R

read-only files and folders 18
records 102
relative cell references 17

removable storage devices
17

reports 109
resizing graphics 55
right-clicking 5
rotating graphics 55

S

safely removing devices 17
save as 18

saving files 18
scattergraphs 86

screen shots (screen dumps,
prints or captures) 24

search engines 26
searching

databases 107

for emails 41

on your computer 12

using the Find feature 14
settings (changing them) 21
shortcuts 16
shutting down a computer 4

sitting properly at a computer
22

slides 90

slide shows 92
slide transitions 97
smartphones 3
software (programs) 9
sorting

in databases 105
emails 41

in spreadsheets 78
spellchecking 48
spreadsheets 64
start menu 4
starting up 4

-

tabs 13
tables
in databases 102
in presentations 96
in word processing files 52
tablets 3
taskbar 11
text alignment 47
text wrapping 56
toolbars 13
transitions 97

U

undo 15

unique identifiers 102
USB memory sticks 17
user interfaces 11

\'

validation rules 103
viruses 43

W

web pages (websites) 25
wildcards 29, 72, 108
windows 11-13
Windows® 7 1

word processing 46

V4

zipped (compressed) files
and folders 20
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